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8 SHAPE Help

1 Introduction
It may be helpful to read these topics before using SHAPE

1.1 Capabilities

SHAPE is aprogram to calculate and display the morphology and symmetry of single
crystals, twins and epitaxial and other intergrowths. Some of the basic mathematical
aspects of the program were described in a paper in The American Mineralogist (1980,
V.65, p.465). However, many important improvements have been made since then in the
capabilities and speed of the program.

Todraw an individua crystal, it is necessary to enter only the crystal class, the unit cell
parameters, and the indices and central distance for one face of each form. The crystal
drawing can be rotated, translated and rescaled, and crystal axes can be added at will.

The central distances, which determine the prominence (area) of each form, may be
derived from the unit cell and space group, using the Donnay-Harker morphol ogical
"law".

The crystal can be displayed in an orthographic projection rotated in a standard way
(virtually identical to clinographic projection), or in a"straight-on" orthographic
projection, and the view of the crystal can be combined with a stereonet showing the
polesto the faces and the crystal axes. The mouse cursor can be used to index any of the
visible faces. Any of the faces can be filled in with color (if acolor display is used) or
dot shading patterns. The entire crystal can be shaded, in color or black-and-white.
Stereopairs of the image may be drawn, either as separate images or as superimposed
anaglyphs (two-color).

The 3D Drawing Modes, which use OpenGL or Direct3D system software, allow a
number of special effects, such as transparent faces. In these modes, the symmetry
elements (rotation axes and mirror planes) may be shown.

Stereo output through quad-buffered OpenGL (or Direct3D on Windows) is available for
appropriate hardware (suitable graphics cards, monitors, projectors and/or eyewear).

The central distance, and therefore the size, of each face may be adjusted on-screen by
clicking with the mouse.

After having generated asingle crystal, and even after having rotated it, the crystal may
be twinned in any of severa ways. Almost any kind of twin is possible, including many
kinds of multi-crystal aggregates. Also, epitaxia intergrowths may be drawn, again
including multi-crystal aggregates. All inter-crystal edges and corners may be drawn, and
al unwanted lines may be removed from these plots, producing an absolutely perfect
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final version.

Sections of crystals may be drawn for any orientation and at any level. Growth zoning
may be modeled in section, using non-linear growth rates and/or different start and end
times for multiple crystals. Also, non-crystallographic symmetry can be used to draw
guasi-crystals.

Hard copies of the drawings can be made in several ways. The screen image can be
reproduced with dot-matrix or laser printers - actually, with the high-resolution modes of
these printers, the resolution of the image is much improved over the screen. Plots can
also be made with most pen plotters. Finally, if neither a pen plotter nor a suitable dot-
matrix printer is available, the coordinates of the corners and other information can be
listed and the drawing can be made by hand.

Running the program is not difficult — the input is interactive and usually simple.
However, aknowledge of elementary crystallography is assumed. Some examples, the
first onein the form of atutorial, are given after the instructions.

1.2 Starting Up

When you double-click on the SHAPE application icon, the Startup Window appears.
Usually you will choose one of the buttons or select the File menu, both of which give
the choice of starting anew file, opening an old file or importing data.

When you double-click on a SHAPE datafile (.shp file) thefileisread in and you see an
message box giving you the choice of calculating the crystal or cancelling (see below).

The first time you run SHAPE you may want to check the dialogs in the Settings menu,
especially the Preferences dialog. If you intend to use a pen plotter, you should select the
Pen Plotter Settings command, and verify or change the settings as needed. Likewise,
you many need to change or verify the PostScript Settings.

Opening an old crystal file. Y ou can read in one of the samplefiles (in the \SAMPLES
sub-directory), using the Open button or the command in the File menu. Alternatively,

when SHAPE is not active, you can double click on one of the SHAPE datafiles (.shp

files). Note that SHAPE for Windows cannot directly read files from SHAPE for DOS
V4.1 or earlier - such files must be converted using the utility program FILEUP.

Entering a new crystal. Y ou can enter anew crystal with the NEWFILE item in the File
menu. Thiswill step automatically through the Title/Axes, Symmetry, and Forms
dialogs from the I nput1 menu.

After an old SHAPE data set has been read in or a new data set entered, you are asked if
you want to "..calculate now". If you reply Yes, the crystal is calculated and should
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10 SHAPE Help

appear in the Graphics Window after ashort time. If you reply No, the Graphics window
is blank when it opens; you can then modify the data for the crystal or the display
parameters using the menus and dialogs, as described in Chapter [11. When corrections
or additions have been made, use the Calculate command in the File menu.

Importing data from a crystallographic file. The Import sub-menu in the File menu
allows importation of unit cell, crystal class and space group from many types of
crystalographicfiles.

The Calculate command in the File menu and the Replot command in the Display menu
(both are dso in the Dialog Bar - Left) are two of the most important and frequently-used
in SHAPE. Calculate reproduces crystal faces by symmetry, locates corners and
identifies edges, and then plots the crystal in the Graphics window. Y ou must use this
command if you change anything which affects the number and location of corners or
edges. Thisincludes many parameters in the dialogs of the I nput1 menu, although there
are are al'so some parameters, mostly colors, whose changes do not require recalculation.
Replot simply redraws the crystal without changing the configuration of faces, corners
and edges. Changesin any of the parametersin the dialogs of the Input2 menu can be
put into effect with Replot.

1.3 Description of the Calculations

From the crystal class or point group, the program determines what symmetry operators
to usein the calculations, and generates all the faces belonging to each form.

In order to find the crystal shape, the program solves for all intersections of three faces,
which are the possible corners. However, if the crystal possesses mirror planes, it isonly
necessary to solve for afraction of all the possible corners, and then reproduce the others
by symmetry. For example, in class m3m, it is only necessary to find the cornersin
1/48th of the crystal as awhole. This means that the calculations for crystals with mirror
planes are faster than those for crystals without mirror planes; in class 432, it takes
almost 8 times as long to cal culate the general form (which contains 24 faces) asit does
to calculate the general form in m3m (which contains 48 faces). After finding corners,
each possible pair must be tested as defining an edge. For individual (non-twinned)
crystals, thisisthe end of the calculation, although the crystal may be rotated to any
orientation and rescaled as desired. Some simple tests distinguish between edges which
are visible and those which are not, and no further processing of the image is required.

For contact twins, acomposition plane (or planes) is added, and the superfluous portion
of the crystal isremoved. Then the crystal is reproduced according to the specified twin
operation(s). For interpenetration twins, the individual is reproduced according to the
twin operations, and then the intertwin corners and edges are located and drawn.

For epitaxial intergrowths, after generation of the two crystalsthey are rotated and
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translated so that they are in contact on the specified face, with specified vectorsin each
crystal being parallel. The intergrowths can also be drawn in interpenetration geometry,
like twins.

For most interpenetration and some contact twins and many epitaxial intergrowths there
will be some edges of one individual which are partialy or entirely behind and hidden by
another individual (this problem does not arisein single crystals). Preliminary drawings
of multi-crystal aggregates may thus have some extra or false lines. In order to produce
an absolutely perfect final drawing, an additional procedure breaks each edge into
segments defined by the intersections (in projection) with other edges, then determines
whether each segment is hidden by any face. This can also eliminate edges lying within
faces, which occur in penetration twins with parallel, overlapping faces.

For drawing sections of crystals, it is necessary to locate the intersection of crystal edges
with the section plane, which is taken to be parallel to the screen or paper; these
intersections are the corners of the section. For modeling linear growth zoning in single
crystals or concentric twins, it isonly necessary to rescale the crystal corners before
solving for the section in each zone. For epitaxial crystals and non-linear zoning, it is
necessary to repeat the entire calculation for each zone.

In 3D Drawing modes, the drawing procedure is somewhat different from the above.
These modes use a depth buffer which contains the depth of the foremost object at each
pixel, so that it is not necessary to solve explicitly for the intersections or front-back
relationships of objects such asinterpenetrating crystals. It also alows surfaces, such as
crystal faces or mirror planes, to be translucent.

2 Types of Windows

SHAPE uses three types of windows besides dialogs and alerts. the Startup window; the
main Graphics window; and . Each type of window has its own menu bar (in the window
itself in Windows, and at the top of the screen in the Macintosh). The Help system also
has its own windows and menus.

Note that under the Windows operating system the SHAPE windows are not confined to
reside within aframework window, asin pre-V6.0 SHAPE.

All the current windows are listed in the Windows menu, and this menu can be used to
switch between windows if some are not visible. When starting up SHAPE, the menus
displayed in the Startup window include only a File menu, a Settings menu and aHelp
menu. Use the commands in the File menu to start a new SHAPE data set, read an old

one from afile, or import datafrom afile with an external format.

After you have entered or read in the data for a SHAPE file, the main Graphics window
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opens and the Startup window disappears; if you have elected not to Calculate, the
Graphics window may be blank, otherwise it will show the current SHAPE drawing.
Only one data set at atimeisalowed in SHAPE, and there is only one main Graphics
window. When thiswindow is active, thereis a File menu and various other specialized
menus such as |nput1for datainput and modification and graphics outpuit.

The List Results command in the File menu lists the relevant data to a Text window, as
does the Section Data command (see the Sections or Growth Zones dialog (I nputl
menu). Each window actually displays the contents of afile, called respectively
RESULTS.SHD, and SECTOUT.SHD. Thesefiles are written over again for each new
SHAPE dataset, soif they are to be preserved they should be saved with the Save As
command in the File menu, using adifferent name.

Text windows are "children" of the main Graphics window, since their contents pertain
only to the current structure, and they are destroyed if the Graphics window is closed.

2.1 Startup Window

See also Startup Window Menu Bar for all the menu commands available.

Y ou should see this window only when there is no SHAPE data set in memory. To load
adata set, use the New, |mport or Open commands in the file menu, or the buttons with
the same names.

2.2 Graphics Window

See also Graphics Window Menu Bar for all the menu commands available.

See the separate topics Dialog Bar - Left, Dialog Bar - Right and Dialog Bar - Epitaxial
for help on the controls on the left and right-hand sides of the Graphics window. This
window shows the structure drawing. The drawing may be rotated with the mouse or
with controlsin the Dialog Bar - Left and rescaled with those in the Dialog Bar - Right.
Other types of rotation, rescaling, etc. are available with commands in the menus,
especialy Input2 and Display.

To switch to other windows (see Types of Windows), click on the other window if it is
visible, or use the Window menu or an option in the Display menu.

2.3 Text Windows

This type of window hasits own menu bar, with commands pertaining only to the
modification, printing, saving etc. of the text file which is being edited. In Windows the
menu bar isin the Window itself, and on the Macintosh it isin the standard position. On
the Macintosh, to see the menu bar which alows modification of the SHAPE data set
itself, return to the Graphics window by clicking oniitif itisvisible, or by using the
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Windows menu.

The List Results command in the File menu lists the relevant datato a Text window, as
does the Section Data command (see the Sections or Growth Zones dialog (Inputl
menu). Each window actually displays the contents of afile, called respectively
RESULTS.SHD, and SECTOUT.SHD. Thesefiles are written over again for each new
SHAPE dataset, soif they are to be preserved they should be saved with the Save As
command in the File menu, using adifferent name.

3 Menus and Dialogs

Startup Window - Thiswindow appears when starting SHAPE, or when the Graphics
window has been closed.

Graphics Window - Thisisthe main window for entry, ateration and display of crystal
data sets.

Text Windows - These windows are used for the List Results and Section Data (see
Sections and Growth Zones dialog in the Inputl Menu) commands in the File menu of
the Graphicswindow. Itisamore-or-lessstandard text edit window.

3.1 Startup Window Menu Bar

File menu - Use the commands in this menu to start anew SHAPE data set or open afile
for an old data set.

Settings menu - Use the commands in this menu to set operating parameters which are
likely to remain constant for normal operation.

Help Menu - Onscreen help.

3.1.1 File Menu (Startup Window)
To start up SHAPE, you must select either New to enter an all-new data set, Open to

open a previously-saved SHAPE datafile or Import to read data from a crystallographic
file.

New - Step-by-step input of a new SHAPE data set.

Open - Open an old SHAPE datafile.

Import File - Import datafrom external crystallographic file types.

Print Setup - Select the printer and set its parameters.
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Exit - Quit SHAPE.

3.1.1.1 New (Startup Window)
New Command [ File menu]

If there is adata set in memory which has been modified, you are asked if you want to
save the changes - see the Close command.

SHAPE steps through the three dialogs in the Inputl menu which provide the minimum
data necessary for aproblem; Title/Axes, Symmetry and Forms. You may need to select
other commandsin the Inputl, Input2 and Display menus to provide information for
more complex problems or to set display parameters.

3.1.1.2 Open (Startup Window)
Open command [File menu (Graphics Window) or File menu (Startup Window)]

If there is adata set in memory which has been modified, you are asked if you want to
save the changes - see the Close command.

Use this command to open an existing SHAPE datafile. After thefile hasbeenreadin,
you are asked if you want to calculate immediately. If you click on OK, the crystal will
be plotted in the Graphics window. If you decline to calculate immediately, you can
modify the crystal or display parameters. When finished, use the Calculate command in
the File menu.

Y ou can create a new SHAPE data set with the New command, and import data from
various crystallographic file formats with the Import File command.

Files written with SHAPE for DOS V4.1 and earlier cannot be read directly by SHAPE
for Windows or Macintosh. Y ou must use the DOS program FILEUP to convert these
filesto the newer "exchange" format.

3.1.1.3 Import File (Startup Window)

Dialog Box: Import File [File menu (Graphics Window) or File menu (Startup
Window)]

If there is adata set in memory which has been modified, you are asked if you want to
save the changes - see the Close command. Also, you have the option of importing the
new data as an epitaxial crystal. If you select the epitaxial option, you will be routed to
the Epitaxial Relations dialog after the file has been read.

SHAPE obtains only the title, the unit-cell parameters, the crystal class or point group
and the space group from most import files - however the forms can also be obtained
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from Free-Form (.inp) Files. The space group symmetry isonly used in the Donnay-
Harker Morphology option (Inputl menu).

If there is more than one data set or phase in the file, the Data Sets...in Import File
dialog will present you with alist. The name of the SHAPE data file will be taken from
the name of thefile, and thetitle (Title/Axes dialog in the Inputl Menu) will be taken
from the data set or phase. The extension .SHP will be appended to the structurefile,
replacing the original extension.

Read default display parameters . If thisbox is checked, the display parameterslast
saved (Settings menu) will be read for the new data set.

File Extension . The three-letter extension (.xxx) which identifies the file type may be
specified here - only files of that type will be shown in the Open File dialog. To show all
files, enter ".* "

Sour ce of symmetry (some formats lack thisoption). Space-group symmetry in the
import filesis given in one or both of two basic ways; as a space-group symbol or
number, or in the form of matrices.

Symbol. If you select this option, the Hall symbol, the Hermann-Maughin symbol, and
then the International Tables number will be used in that order if present (CIF files are
the only type which islikely to contain the Hall symboal).

Use positionsas xyz . If matrices are given, they are most often in the "xyz" form, in
which symmetry operators are given as positions in the general equipoint asin the
International Tables for X-ray Crystallography. This option also appliesto casesin
which the matrices are given in all-numerical format, such as ORTEP and RIETAN files
- currently in all such cases thereis no choice of symmetry format. SHAPE will try to
identify the space-group from the matrices - for thisto be successful, the space group
must be in one of the standard settings used in Sginfo. The allowed settings are listed in
thefile HALL.DAT. SHAPE does not store the matrices, only the valid space-group
symbols.

If the information for the symmetry option selected is not present, the other option will
usually betried. However, if identification of space-group symmetry fails, it may
sometimes be necessary to re-import the file, with the other option selected. Whether the
symbol or matrices are used to obtain the space group, it must be in one of the standard
settings listed in the HALL.DAT file. If the setting in the file is not one of the standard
ones, it may be necessary to select the space group manually in the Donnay-

Harker Morphology dialog (Inputl dialog). The choice of origin in the space group is
not used by SHAPE; however, the orientation may be important as SHAPE only uses
certain orientations, in particular the unique axis must be b for monoclinic crystals and ¢
in other cases (except for trigonal rhombohedral). Also, sometrigonal, tetragonal and
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hexagonal point groups may have alternate orientations of the symmetry elements with
respect to the crystallographic a -axes - see Symmetry. It may be necessary to change
the point group or crystal class to agree with the space-group setting.

Currently the following types of files are supported:

CCDC FDAT filesfrom the Cambridge Crystallographic Data Centre.

SHEL X .INS filesfrom the program system of Prof. G. Sheldrick.

CIF - Crystallographic Information Files.

DBWS/LHPM Rietveld input files.

ICSD Inorganic Crystal Structure Database files. Threetypesof ICSD file are
supported, classified according to source: 1) Filesfrom the current CD-ROM database,
accessed by the program RETRIEVE. The RETRIEVE files must be written from the
DATA window using the PRINT option, not as export files (if there is sufficient demand,
export files may be supported). That is, the file should be a copy of what is shown on the
screen in the RETRIEVE program. 2) Filesfrom the Canadian Scientific Numeric
Database System (CAN/SND). This service may no longer be available. Thefilesare
referred to as CRY STIN. 3) Filesfrom the Netherlands CAOS information system.
Thesefiles are also referred to as CRY STIN.

ORTEP Oirigina or ORTEP Il atom information.

XTLVIEW Drawing program.

VIBRAT (.VBR) Graphic datafilesfrom VIBRAT or VIBRATZ (Shape Software).
ATOMS Structure drawing program (Shape Software).

RIETAN Rietveld program files.

GSAS Datafiles (.EXP) filesfrom the Los Alamos Lab system.

AM MINERAL Datafilesfromthe American Mineralogist structure database. Thisis
currently available on the Internet at www.geo.arizona.edu/xtal-cgi.test.

FULLPROF . All-purpose refinement program.

RAVEL ATOMS This program is not the same as ATOMS by Shape Software, but is for
EXAFSAnalysis.
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WIEN2K The program package WIEN2k performs electronic structure cal culations of
solids using density functional theory (DFT). CRY SCON will read the .struct input files,
but will only recognize file extensions with three characters, so it may be necessary to
rename the files, search manually in the File Open dialog (enter *.struct) or use the "all
files" option.

| ZA (zeolites). Filesfrom the International Zeolite Association database.

FREE-FORM (.INP). Filesof thistype are read and written by ATOMS and CRY SCON
(Shape Software). Atomic-coordinate information isignored. All information needed
for a SHAPE calculation can be entered with these files, and they should be easy to write
with other software.

3.1.1.3.1 Import IZA file
Import | ZA (International Zeolite Association) File [File menu]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

The IZA has an extensive database of natural and synthetic zeolites available on the WWWeb,
but does not seem to have an option for export of the data - it will be necessary to cut-and-paste
the information into a text file.

Go to the Web page for the Database:
http://www.iza-structure.org/databases/

and select "Collection of Simulated XRD Powder Patternsfor Zeolites". Thisshould
show amatrix of structure types by three-letter code - select one of these. Y ou can also
access structures in other ways, but you need to end up on a page showing options for X-
ray powder diffraction together with the structure data. There should be linesfor
"Material name" ..."Composition:" ... "Crystal Data:" and others, with the fractional
coordinates for the atomsin atable.

Mark the top right part of the page with your mouse, starting with the three-letter code
centered at the top, and going below the atomic-coordinates table. Do not include the
"Reset" and " Submit" buttons and material below thisline. Do not include the column of
options on the left of the page. Copy the marked information into the clipboard in the
standard way.

Now, in aword processor, open a new text (ascii) file. Paste the clipboard contents into
thefile. Savethefile, givingita".iza" extension if possible. Hereisasample (or look
inthe ZEOLITES subfolder for sample .izafiles):
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LAU

Material name: Launontite

Conposition: | Ca4(H20) 18| [Si 16A 8I48]

Refined conposition: |Ca4(H20) 18| [Si 16A 8(48]
Crystal data: Space group: Cl2/nl (# 12)
a= 14.8538 A b = 13.1695 A ¢ = 7.5421 A
al pha = 90° beta 110.323° gamma = 90°

X-ray Rietveld refinenment, Rwp=0.115, Rp=0.090, RF2=0.046
Coment: unique axis b, cell choice 1
Reference: Artioli, G and Stahl, K
Zeolites, 17, 249-255, (1993)

At omi ¢ coordi nates Atom na
CA Ca 0.2601 0.5 0.737 1.0
SI1 Si 0.2368 0.3838 0.156

me Formfactor x y z PP B(iso)
3
1

SI2 Si 0.0763 0.3834 0.325 1
1
.7
.0
.0

ocoooh~T

.8
.1
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P Wwo

AL1 Al 0.1315 0.3080 0.737
260 0.5 0.219 1.0 0
2084 0.3744 0.919 1.0 1.
1384 0.3838 0.552 1.0 O.
146 0.3454 0.203 1.0 2.9
3205 0.3185 0.248 1.0 O.
043 0.5 0.267 1.0 0.71
013 0.3083 0.743 1.0
-(H20 0.029 0.171 0
0
5

1
2
2
9
66
55
2
7

9

3

.45
-(H20 0.401 0.5 0. .92
-(H20 0.5 0.467 0. 6
-(

H2O) 0.1426 0.129 0.332 1.0 4.03

2.

.0

26
0.
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.0
3.
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3.1.1.4 Page Setup
Page Setup command [ File menu]

This allows setting of the paper type or size, the standard orientation (portrait or
landscape) and the paper margins (except Macintosh). Marginswill only be used in
Text Windows.

---Macintosh only ------

Use the Page Marqgins dialog to set margins.

3.1.2 Settings Menu (Startup Window)
Preferences - Sets parameters for modes of operation.

PostScript Settings - Hardware settings for direct PostScript output.

Pen Plotter Settings - Hardware settings for the pen plotter or pen-plotter files.
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Palette - Modify, save or read the RGB values for the 16-color palette.

Save Defaults - Thissaves default display parameters, mostly those in the Input?2
menu, for use when inputting a new crystal with the New command in the File menu.

3.1.2.1 Preferences
Dialog Box: Preferences [ Settings Menu]

Scaling units. This sets either inches or centimeters as the units for overall usein
SHAPE. Thischoice may belocally overridden for printing or other output (File menu)
by the Units setting in some of the dialogs involved.

On-screen rotation increment (degrees) . Thisisthe amount by which the imageis
rotated in the Dialog Bar - Left . Thisisthe value whichisin the dialog when it isfirst
called; this value and not the latest value in the dialog itself is saved on quitting SHAPE.

On-screen rescaling factor (%) . Thisisthe default amount by which the drawing i<
rescaled with the Scale button in the Dialog Bar - Right. Thisisthe value which isin the
dialog when it isfirst called; this value and not the latest value in the dialog itself is
saved on quitting SHAPE.

Stereopair rotation angle. Thisisused in the Stereopair and Anaglyph modes set in
the Drawing Modes sub-menu of the M odes menu or in the Dialog Bar - Left. Each
view isrotated by this amount; about 3 degreesis normal. The value can also be set in
the Dialog Bar - Right.

On-screen resizing factor. Thisisthe factor by which the central distance of the
selected form isincreased by a click with the |eft button when in the Resizing

Cursor Mode. Clicking on the right button decreases the central distance by the inverse
of thisfactor.

Radius of stereonet symbols. Thisisthe size, ininches or centimeters, of the symbols
for crystal axes and face poles in the stereonet mode, selected in the M odes menu.

Sounds . Thisturnson or off the sounds emitted by SHAPE, for example at the
beginning and end of calculation and/or plotting (some system sounds are unaffected).

Edgesin faces. When different crystalsin intergrowths have parallel and coincident
faces, the edges lying in this common surface may or may not be realistic or meaningful,
and you can elect to draw them or not. Usually the drawing is simpler and more
satisfactory without them.

Always show composition-plane edges . Twins by reflection on the composition plane
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should always match exactly at the junction, and a certain short-cut in the drawing of
such twinsis often useful. When this box is not checked, if the composition planeis
forward-facing, edges with this composition plane are not drawn. This often allows
simple twins to be drawn without using the Remove Hidden Lines option in the
Display menu. However, if the twin is by reflection, the two individuals often do not
match exactly on the composition plane, and visible edges may be omitted. Generally,
for correct drawing of mismatching rotation twins this box should be checked, and aso
the Edgesin facesbox . If the Always show composition-plane edges box is checked,
the Remove Hidden Lines option in the Display menu must be selected.

Screen start-up. This sets the color/black-and-white state of the screen at start of
SHAPE. It can be changed with the Color command in the Display menu.

3.1.2.2 PostScript Settings
Dialog Box: PostScript Settings [ Direct Postscript Output Dialog] [ Settings Menu]

If you are using direct output to a printer you must select the Port ; thiswill be either
"LPTn" or "COMN". Also, if you are using a serial port for the printer, you must set or
verify the data transmission parameters, such as baud, parity, etc., evenif the port
currently shown isthe correct one. Thisisdonein the Ports item of the Windows
Control Panel (notin SHAPE).

The page size, page margins and dots per inch/centimeter should be determined by the
actual printer used for final output; if these are not correct, the drawing may not be scaled
and/or placed on the page correctly.

The Transfer Function is analogous to the PostScript function of the same name. The
linear option is standard; modify the function to get lighter or darker shadingin
PostScript print-out.

Preview Color . If you select a screen preview (TIFF bitmap sub-file) in the

Direct PostScript Output dialog, and if color output is selected, you can specify the type
of color or pixel depth used. The Screen option uses the color depth of the the current
screen display. Black-and-white PostScript output always uses a 1-hit or black-and-
white screen preview.

3.1.2.3 PostScript Transfer Function
Dialog Box: PostScript Transfer Function [ Postscript Settings dialog]

The Transfer Function isanalogous to the PostScript function of the same name. It
changes the nominal gray values (0.0-1.0 for black-white) calculated by SHAPE astrue
illumination to values actually output. (Note that the PostScript gray scale, 0.0-1.0 for
black to white, isin the opposite direction to the SHAPE gray scale, 0-15 for white-
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black; the transfer function uses the Postscript gray scale.) If your printer gives gray
shadings that are too dark (thisis common, especially for lighter shades), you can
increase the output values. Valuesin between the listed values are linearly interpol ated.
The actual gray values output to the printer or EPS file are changed; the transfer function
itself isnot part of the EPS file. Note that the gray-scale conversion also appliesto lines
of greater than single-dot width (single-dot lines are aways black).

3.1.2.4 Pen Plotter Settings
Dialog Box: Pen Plotter Settings [ Pen Plot dialog] [ Settings Menu]

Current plotter radio buttons. There are severa pre-programmed plotters; clicking on
the Get Data button reads the pen-plotter data file (PPLOT) and obtains the commands
and parameters. Even if your plotter is not listed here, you may be able to input the
commands through the Other option. In this case, click on the Commands button to set
or revise the commands and parameters.

Port . This should be either a serial or parallel port: "COMnN" or "LPTn". Even if this box
shows the correct port, if it isaserial port you should verify the baud, parity, stop bits
and data bitsin the Ports item in the Windows Control Panel . These parameters
should be set to match the settings on your pen plotter (which are usually controlled by
DIP switches).

Pen-change mode radio buttons. If you have a multiple-pen plotter, you can elect to run
in the Use single pen mode with the pen number entered in the edit field, and
conversely if you have a single-pen plotter you can draw with multiple colors, but you
will have to change the pens manually. If you choose the Change pens manually mode,
the plotter returns to the zero position after drawing all lines of each color, and a message
box appears, prompting you to change pens.

Speed number . Thisisthe parameter (see Commands) which controls velocity of the
pen - for example for the Comrex, speed number 1 is slowest and 15 is fastest. Although
some plotters, like the HP7475A, allow decimal speeds, you must use an integer here.
3.1.2.5 Pen-Plotter Commands and Parameters

Dialog Box: Pen-Plotter Commands and Parameters [Pen Plotter Settings dialog]

Thisallows you to enter or revise the pen-plotter commands and parameters, for non-
standard pen-plotter types.

It is assumed that the plotter accepts ASCII commands that follow a simple syntax of
"command, parameters, terminator”. For example, the Hewlett-Packard command for
moving the pen, raised, to the coordinates x,y is"PUx,y;". "PU" is the command, which
should be entered (without parentheses) in the text box Move - pen up : x and y are the
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parameters, which are always supplied internally by SHAPE; and the semicolon isthe
terminator required in the Terminator text box. Commas between parameters are also
supplied by SHAPE. Move - pen up means move to the new coordinates with the pen
up (not marking).

Y ou must enter or edit the commands in the text boxes on the | eft of the dialog. If more
than one command is required to perform the operation requested, give all the commands
with any intermediate parameters and terminators required, but omit the last terminator.
If your plotter does not use acommand, just |eave that field blank.

Following are comments on the plotter inputs. The type of variable required, and the
maximum number of charactersin case of acharacter variable, are given in parentheses.
View samples by clicking on the selections in the Current Plotter group in the [

Pen Plotter Settings dialog] dialog.

Commands

Move - pen up . (6 chrs) Move to the new coordinates with the pen up.

Move - pen down . (6 chrs) Move to the new coordinates with the pen down.
Raise pen . (6 chrs) Raise the pen without movement.

Pen speed . (6 chrs) Thisisthe command which causes pen speed to be set or changed;
the parameter is entered as a separate item in the Pen Plotter dialog.

Change pen . (6 chrs) Thisisrequired only for multi-pen plotters.
Start plot . (12 chrs) Initialize the plotter. May require no commands, or several.
End plot . (12 chrs) Terminate plotting. Like (12).

Terminator . (2 chrs) The character which signals the end of acommand. In most cases
the semicolon.

Parameter s

Maximum x/y . (Decimal) Maximum x and y coordinates. These values establish the
centering of the plot. Increments on the x and y axes are assumed to be equal.

xly at finish . (Decimal) The "base" coordinates, in plotter units, to which the paper or
pen will be returned at the end of the plot, or when pens are to be changed manually.
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Units/inch(or centimeter) . (Decimal) This establishes the resolution of the plotter and
isused in scaling. If your plotter instructions do not give this number, divide the
maximum X or y coordinate (item 1 above) by itslength in inches.

3.1.2.6 Palette
Dialog Box: Palette [ Settings Menu]

The primary 16-color palette is used to set up a 256-color palette for 8-bit screen display
or raster output, and also to set the primary choices for color in al cases (you can always
select other colors using different RGB values). See Colors and Pal ettes for more detail.
The default palette has the same RGB values as the "aternate” palette used in DOS
versions of SHAPE, but rearranged to a more logical order.

Y ou can read and write the RGB valuesto palette (.PAL) files. Two palettes are
provided on file: STANDARD.PAL and ALTERNATE.PAL, which are respectively the
standard IBM/DOS pal ette and the default alternate palette used in DOS versions of
SHAPE. Itiseasy towrite or modify the .PAL filesdirectly; they simply contain the
RGB values, from 0 to 255, separated by spaces (or commas).

3.1.2.7 Read/Save Defaults
Save Defaults Command [ Settings Menu]

When inputting data for a drawing with the New command in the File menu, you can
elect to use default values for display parameters, rather than set these in the dialogs of
the Input2 menu. If no data set isin memory, the default display parameters are aways
read from disk; and if there is adata set in memory, you can use the current values or
read the defaults from disk.

This option saves the current display parameters, i.e. valuesin the dialogs of the |nput2
menu, to the file, so that they will be the default values for future input with the New
command.

3.2 Graphics Window Menu Bar

File menu - Inaddition to the usual New , Open , Print etc., this menu has commands
for listing input and generated data, and for for PostScript, pen plotter, raster or bit-map
and Metafile output.

Modes menu - This setsthe Display, Operating and Cursor modes.

Inputl menu - This contains dialogs involving mostly the basic data for the crystal, such
as axes (unit cell), symmetry, forms, etc.

Input2 menu - This contains dialogs setting display parameters specific to each crystal.
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Display menu - This contains commands and dial ogs which set the overall display
attributes of SHAPE, and modeless dialogs for rapid rotation and displacement of the
crystal.

Rotation menu - This contains severa options for rotating and aligning the crystal.

Settings menu - This contains settings for hardware, palette and preferences for modes
of operation.

Window menu - This contains commands relating to the display or activation of the two
kinds of windows - the Graphics window, and Text windows (see Types of Windows).

Help menu - Help system access.

3.2.1 File Menu (Graphics Window)
New - Step-by-step input of a new SHAPE data set.

Open - Open an old SHAPE datafile.

Close - Close the current graphics window.

Save - Save aSHAPE datafile.

Save as - Save a SHAPE datafile with anew name.

Import File - Import data from external crystallographic file types.

Calculate - Reproduce faces by symmetry, locate corners and edges, and carry out twin
operations.

Print - Print out the graphicsimage; see the List Results commands below for listing
data and calculation results.

Print Setup - Select the printer and set its parameters.

List Results - List input data and calculation resultsto the file RESULTS.SHD and to a
Text window.

Output group

PostScript - Direct output to a PostScript printer (bypassing the printer driver) or to an
EPSfile.
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Pen Plot - Output to a pen plotter or HPGL file.

Raster Files - Writesraster or bit-map filesin .PNG (plus .BMP, .PCX or .TIFin
Windows) format.

Metafiles (Windows) or PICT (Macintosh) - Writesfilesto the clipboard or disk files.

Screen to Bitmap - Dumps the exact contents of the Graphics window to the clipboard or
araster file.

VRML Files - Writesfilesinthe 3D Virtual Reality Modeling Language

POV -Ray Files - Writesfilesfor the POV-Ray ray-tracing program.

Exit - Quit SHAPE.

3.2.1.1 New (Graphics Window)
[ Eile menu (Graphics Window) or File menu (Startup Window)]

If there is adata set in memory which has been modified, you are asked if you want to
save the changes - see the Close command.

SHAPE steps through the three dialogs in the Inputl menu which provide the minimum
data necessary for aproblem; Title/Axes, Symmetry and Forms. You may need to select
other commandsin the Inputl, Input2 and Display menus to provide information for
more complex problems or to set display parameters.

3.2.1.2 Open (Graphics Window)
Open command [File menu (Graphics Window) or File menu (Startup Window)]

If there is adata set in memory which has been modified, you are asked if you want to
save the changes - see the Close command.

Otherwise this command is the same as the Open command in the File menu of the
Startup Window.

3.2.1.3 Import (Graphics Window)

The Import Submenu and Import dialog in the File menu of the Graphics Window are the
same as the Import submenu and dialog box in the File menu of the Startup Window.
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3.2.1.4 Close (Graphics Window)
Close Command [ Eile menu - Graphics window]

When exiting SHAPE, closing the graphics window, reading another file or starting a
new file, SHAPE triesto determineif you have made any changes in the problem
currently in memory; if so, you are asked if you want to save thefile.

First, it checks whether the orientation has changed from the [nitial Orientation
established during calculation. If so, you can save the current orientation as initial
rotations. It also checks whether any dialog in the Inputl and Input2 menus have been
opened.

Y ou can also close adata set by using the Close icon on the Graphics window.

3.2.1.5 Save (Graphics Window)
Save command [ File menu, Graphics window]

When called from the Graphics window, this saves the active data set to its current name
and directory. If you have changed the orientation from that specified in the

Initial Orientation dialog in the File2 menu, you are asked if you want to save the
current orientation. 1f you choose to do this, the current orientation will be converted to
initial orientations on the observer x, y and z axes

When you save a data set for the first time, SHAPE displays the Save As dialog box so
you can name your data set. If you want to change the name and directory of an existing
data set before you save it, choose the Save As command.

3.2.1.6 Save As (Graphics Window)
Save Ascommand [ File menu, Graphics window]

If you have changed the orientation from that specified in the Initial Orientation dialog in
the File2 menu, you are asked if you want to save the current orientation. |f you choose
to do this, the current orientation will be converted to initial orientations on the observer
X,y and z axes

To save adata set with its existing name and directory, use the Save command.

3.2.1.7 Calculate Command
Calculate Command [ FEile menu]

This command must be used whenever an "intrinsic" or "input" parameter of the crystal,
including most itemsin the Inputl menu, ischanged. For parameters which affect
display only, such asline colors colors and other itemsin the Input2 menu, use the
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Replot command in the Display menu (shortcut Ctrl-R).

Generaly, the time for recalculation is short on current computers, and it does no harm
to use Calculate instead of Replot. One exception is when section edges have been
added to the normal view of the crystal (see the Sections and Growth Zones dialog in the
Inputl menu). In this case, the Calculate command will cause disappearance of the
section edges.

3.2.1.8 Print Graphics Image
Dialog Box: Print Graphics|Image [ File menu]

PostScript printing is standard in Linux, so for non-3D output printing is handled by the
Direct PostScript option, not by the dialog below. However, for 3D output printing is
controlled by thisdialog.

This command is for normal printer output through the printer driver (see below). If you
have a PostScript printer, you should probably use the PostScript command in the File
menu rather than this one for non-3D images; that command sends PostScript language
commands directly to the printer, bypassing the printer driver. The PostScript language
has afew capabilities which are missing from the system routines. Using

Direct PostScript output may give somewhat different, and usually more correct colors,
than using the Print option (although color inaccuracies may possibly be fixed by
changing the settings of the printer driver in the Page Setup command).

In the case of 3D images (that is printing while in the 3D Display mode), SHAPE does
not send drawing commands to the printer - rather the entire drawing (or sections
thereof) must be imaged in memory, and this raster or bitmap image is sent to the printer.

Three different Print M odes may be used, depending on the settings in this dialog and
the SHAPE Drawing mode - 1) Standard or QuickDraw, 2) Direct PostScript or 3)
Bitmap.

Option 1) sends standard QuickDraw graphics commands (the same as those used for the
screen) to a printer driver, which may be supplied by Apple or the printer manufacturer.
The printer then makes the image in its own memory. Y ou select the printer or printer
driver in the Chooser option in the Apple menu (OS 8/9) or in the Print Center (OS X).
This option sometimes results in poor quality output, with too-thick or irregular lines,
patterns at a scale of 72 dpi instead of the true printer resolution, or incorrect colors. If
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this happens try one of the other options.

If you have a PostScript printer, for non-3D output you should probably select the Dir ect
PostScript option - this causes SHAPE to send PostScript language commands to the
printer instead of the QuickDraw drawing commands, although these commands are
transmitted through the currently-selected printer driver. Some printer drivers, especially
the standard LaserWriter drivers, may not print at the maximum resolution of the printer
without this option. Note that direct PostScript printer output is only supported through
this option, not through the PostScript item in the File menu. The Pattern Series
selection isignored - patterns are determined by the Printer.

Option 3) forms the image in memory, then sends it as a bitmap to the printer. This
option isaways used for 3D Display modes. This method may be very slow, but often
gives higher quality than option 1).

If the Standard printer dialog on OK box is checked, the Print dialog supplied by the
operating system or the printer driver comes up after you click OK. Use that dialog to set
the number of copies or in some cases the resolution. The orientation (portrait or
landscape) can also be set in the Page Setup dialog in the File menu. If you have a color
printer, you may need to

make a choice between color and black-and-white printing in one of the printer dialogs
aswell as with the Color printing checkbox in this dialog. This choice may be an option
in the standard printer dialog above, or you may need to set it in the Page Setup optionin
the File menu. Background applies only to color printing; for black-and-white printing
the background is always white (although you could print on black paper).

See Frames for details of the frame and frame units.

In this print option, for non-3D images, SHAPE sends standard graphics commands to
the operating system, which passes them on to the printer driver, a piece of software
which is normally written by the printer manufacturer (but sometimes by Microsoft in the
case of Windows). For color printing, it is standard to send RGB values to specify colors
for lines and files, and for black-and-white printing, it is standard to send gray-scale
values (actually, RGB values with all three components equal). The printer driver
interprets these values in terms solid areas and/or dot patterns of ink on the paper. No
color printer can print all colors as solid areas; traditional printing uses as few as three or
four colors, most commonly cyan, magenta, yellow and black, intermixed or dithered in
dot-patternsto produce afull range of colors. Microcomputer printers may use more
colors, but the principle is the same, and dot density istypically lower than in traditional
printing, so it may be important to select colors which are as smple as possible in terms
of red, green and blue or cyan, magenta and yellow (see Colors and Palettes )
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Use SHAPE b/w patternsand Pattern series. Black-and-white printer drivers must
interpret the gray valuesfor fills as dot patterns of varying density. The patterns supplied
by the printer driver may or may not be satisfactory for the SHAPE user. Rather than
send gray-scale values for fills, SHAPE can also send its own dot patterns, which have
been carefully designed for its purposes. The Fine seriesis appropriate for small
drawings which will not be reproduced photographically. The Coarse series simulates
halftone screening and is appropriate for photographic reproduction. To be precise, at a
printer resolution of 300 dots per inch, most of the patterns have a screen density of 53
lines per inch, at 45 degrees; thisis about half the density of typical standard printing, so
areduction of about afactor of two is generallly satisfactory. Of course, different printer
resolution would dictate different reduction factors. Note that this coarse/fine setting is
the same as that in the Raster and Metafile or PICT files dialogsin the File menu.

SHAPE patterns are always used for b/w printing, but they may be rescaled or otherwise
changed by the printer driver.

Actually, different printer drivers may interpret the standard gray-scale commandsin
terms of patterns which are similar either to the fine or coarse series supplied by SHAPE.
Some may convert the SHAPE patternsto their own patterns, and some may not accept
the SHAPE patterns at all. Some may offer their own choice of pattern types or densities
(typically in the printer dialog above or the Page Setup dialog in the File menu). Thus
some experimentation may be necessary to find the best choice for patterns (i.e. printer-
driver patterns, fine SHAPE patterns; or coarse SHAPE patterns). Gray lines of greater
than one-dot width are always drawn by filling an outline with one of the SHAPE
patterns - gray-scale values are not used because many printers will not print gray lines.
Thus the coarse/fine setting is always used for wide b/w lines.

Maximum memory. Thisis used only when printing in 3D Drawing modes. Operating
system support for printing in this mode isincomplete, and SHAPE itself must therefore
draw raster or bitmap images and send these to the printer, rather than relying on the
printer driver. Memory considerations similar to those involved in Raster Files therefore
comeinto play.

Both Macintosh and Windows operating systems use virtual memory, which means that
they pretend that a hard disk can be used in place of actual hardware memory chips. For
some purposes thisis useful, but when writing raster filesit usually resultsin "disk
thrashing", or constant reading and writing of data to the hard disk.

SHAPE is capable of imaging and writing raster filesin segments or bands to avoid this
problem. This requires repeating the entire drawing process for each band, but this
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usually is much faster than the reading/writing to disk involved in using virtual memory.
To do this requires knowing how much actual chip memory is available. Unfortunately,
at present the operating systems do not provide thisinformation in a usefule way. Thus
the user may need to determine this by trial and error using the Maximum memory
parameter. Thisisthe same parameter which is set in the Raster Files dialog.

When the Maximum memory parameter is set to zero, SHAPE will simply ask the
system for a block of memory large enough to image the entire drawing at once. If this
amount of memory is greater than the amount of chip memory which is made available
by the system (and this may be considerably less than the actual amount of chip memory
in the computer), the operating system will use virtual memory, which istypically
manifested by disk thrashing. If you change the Maximum memory to some amount than
that require for the image (say half), SHAPE will only request this amount of memory
from the system, and virtual memory may not come into play. A Maximum memory
setting should be good for a given session, regardless of the size of the raster file; larger
fileswill use more bands. However, the amount of memory available may depend on
whether other applications are active.

The amount of virtual memory is determined by the available space on the hard disk. If
thisisinsufficient, SHAPE will automatically use bands, but since virtual memory is
being used, it may still be advantageous to use a Maximum memory value which will
increase the number of bands.

3.2.1.9 Page Setup
Page Setup command [ File menu]

This allows setting of the paper type or size, the standard orientation (portrait or
landscape) and the paper margins (except Macintosh). Marginswill only be used in
Text Windows.

---Macintosh only ------

Use the Page Marqgins dialog to set margins.

3.2.1.10 List Results

Dialog Box: List Results [ File Menu]

Thiswill give alisting of input data as well as results for the current problem.

If the List detailed information... box is checked, al faces, corner and edges will be
listed; otherwise only the number of faces and the orientation of the axes will be listed.
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The List angles between edgesin faces option gives angles within each face, not
interfacial angles. For interfacial angles see Face at Cursor or Interfacial Angles.

Form Areas. Thisliststhe area of each face and thetotal areafor theform. Thisisin
the arbitrary "central distance units'. Note that it may not be possible to use any arbitrary
magnitudes for central distances to match real units because of the finite tolerances used
in several stages of the calculation - these tolerances assume central distances on the
order of 1.0. Generally, problems with tolerances arise as the faces intersect at low
angles and as the number of faces intersecting at a single corner increases.

3.2.1.11 List Section Data
Thiswill list, in a Text Window, the results of the last Section/Zoning Mode calculation.

If there have been no section/zoning calculations, thisitem is not available.

3.2.1.12 Direct Postscript Output
Dialog Box: Direct Postscript Output [ File menu]

--- Linux only ---------

PostScript printing is standard in Linux, so for non-3D output, including diffraction
diagrams, printing is routed to this dialog, not the Print command in the File menu.
Output can be directly to the printer or to an EPSfile, as for Windows (below).

---- Windows only ----

This option can be used to write Encapsulated Postscript (EPS) files for transmission of
graphics to other software, aswell asfor direct output to a Postscript printer. This direct
output is generally superior to, aswell asfaster than, the output from the normal Print
command in the File menu if your printer is PostScript. The Destination option sends
output either directly to a printer or to afile in standard EPS (Encapsul ated Postscript
V3.0) format.

Screen Preview. Most word-processing and publishing software cannot display an EPS
file on the screen unless the file has a special bitmap attached, called the screen preview.
Thisis actually a sub-filein the TIFF format. The pixel depth of thisfile can be set in the
PostScript Settings dialog (Settings button). The pixel depth of the preview is set to that
of the screen, and the pattern seriesis set to fine (see Raster Files).

---- Macintosh only ----

This option can only be used to write Encapsulated Postscript (EPS) files for
transmission of graphics to other software. For direct output to a Postscript printer, use
the Print option.
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Screen Preview. Most word-processing and publishing software cannot display an EPS
file on the screen unless the file has a special attachment, called the screen preview. This
isactualy aPICT in theresource fork of thefile.

---- End Linux/Windows/Macintosh only ----

In 3D Display modes, SHAPE always writes data (or sendsit to the printer) in the form
of abitmap (or "image" in PostScript terminology). Because of the facts that PostScript
filesmust be ASCII (text), and that efficient data-compression schemes (other than the
copyrighted LZW) are not supported in PostScript level 2, PostScript files for 3D
drawings tend to be much larger than the best Raster formats, especially PNG. Thus the
PNG Raster format is generally preferable for all 3D Display mode drawings.

The M aximum memory setting limits the amount of memory used for bitmap buffers
when in the 3D Drawing Modes - see the Raster section for further details. The number
of pixels on each raster line must be divisible by four - the image width will be increased
if necessary to achieve this. Settings button (calls PostScript Settingsdialog). On or
before first using the Direct PostScript Output command, you should set or verify the
settings in this dialog, especialy the port to which the printer is attached.

See Frames for details of the frame and frame units.
3.2.1.13 Pen Plot
Dialog Box: Pen Plot [ File Menu]

On first using this command, be sure to click on the Settings button to set or verify the
characteristics of the plotter, especially the plotter port.

This option can also be used to write HPGL vector files; set the Destination to File,
and click on the Settings button and select HPGL plotter .

See Frames for details of the frame and frame units.

3.2.1.14 Raster (Bitmap) Files
Dialog Box: Raster (Bitmap) Files [ File Menu]

--Windows/Linux Only ----------
This command can write filesin four different formats (File type ): Windows device-

independent format (.BMP); PC-Paintbrush (.PCX); Tag-image-format (.TIF); and
Portable Network Graphics (.PNG) files.

If the Compress.BMP box is checked, 4- and 8-bit .BMP files are compressed; 1- and
24- bit .BMP files are never compressed. Owing to a system bug, compression of 4-bit
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.BMP files may not work when banding is used (see below). TIF files are compressed
with run-length encoding, which is one of the required formats under the TIFF 6.0
standard. However, some applications may not support this type of compression, or may
reject .TIF filesfor other reasons.

--Macintosh only---------

This command can write files in the Portable Network Graphics (.PNG) format. The
PICT Files option (File menu) can also write raster or bitmap files, in the PICT format.

--End Windows/Macintosh only----
See Selection of File Format below for information on choosing the format.

Each one of these may be either black and white or color. If black and white, the pixel
size is1-bit. For color filesthe pixel size is based on the current screen; 4-bit for
standard VGA or other 4-bit display, 8-bit for 256-color display, and 24-bit for 16- or 24-

bit display.

The images will look much the same as a screen image, except that for black-and-white
filesthereis achoice of coarse or fine dot patterns to represent gray shades, as for
printing and metafiles (see the Print dialog in the File menu). Fine patterns are
appropriate for small images which will not be reproduced photographically, or for
images which will be shown on the screen only; coarse patterns mimic halftone screens
used in printing, and generally reproduce better photographically, especialy when the
image is reduced in size. Note that this coarse/fine setting is the same as that in the Print
and Metefiles dialogsin the File menu.

See Frames for details of the frame and frame units.

Maximum memory . Windows and Macintosh use virtual memory , which means that it
pretends that a hard disk can be used in place of actual hardware memory chips. For
some applications thisis useful, but when writing raster filesit often resultsin "disk
thrashing", or constant reading and writing of data to the hard disk.

SHAPE is capable of imaging and writing raster filesin segments or bands to avoid this
problem. This requires repeating the entire drawing process for each band, but this
usually is much faster than the reading/writing to disk involved in using virtual memory.
To do this requires knowing how much actual chip memory isavailable. Unfortunately,
at present Windows does not provide this information in away that can be used for both
16- (standard Windows 3.1) and 32-bit (Windows NT) systems. Thus the user may need
to determine this by trial and error using the Maximum memory parameter.

When the Maximum memory parameter is set to zero, SHAPE will simply ask the
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system for ablock of memory large enough to image the entire drawing at once. This
amount of memory is printed out in the dialog which appears after starting the raster
imaging: "nnnn bytes required, mmmm bytes available - will require 1 bands". If this
amount of memory is greater than the amount of chip memory available, Windows will
use virtual memory, which istypically manifested by constant running of the hard disk
for long periods. If you change the Maximum memory to some amount smaller than
nnnn (say half), SHAPE will only request this amount of memory from the system, and
virtual memory may not comeinto play. A Maximum memory setting should be good
for agiven session, regardless of the size of the raster file; larger fileswill use more
bands. However, the amount of memory available may depend on whether other
applications are active.

The amount of virtual memory is determined by the available space on the hard disk. If
thisisinsufficient, SHAPE will automatically use bands, but since virtual memory is
being used, it may still be advantageous to use aM aximum memory value which will
increase the number of bands.

Testing has suggested that a Maximum memory setting of about 1 mb (1000 kb) may be
the optimum, at |least for smple drawings.

Note that from V5.0.1 SHAPE uses Windows system routines to draw bitmaps, rather
than its own assembly-language routines, which were used in DOS versions and V5.0 for
Windows. The only effect of this from the user's point of view isto remove complete
freedom in determining the pixel size of color bitmaps.

Selection of File Format. The choice of format dependsfirst of all on what formats are
supported by the target software (paint program; publishing program; etc.). Beyond this
the first choice should be PNG. For Windows the second choice should be PCX, and
then TIF or BMP depending of what is supported and how much memory or disk spaceis
available. For Macintosh, the only choice besidesPNG is PICT , which isusually not as
compact, but this may depend on the Macintosh operating system.

Asof 1997, the preferred graphicsfile typesfor the internet were GIF and JPEG.
However, GIF usesthe LZW compression scheme copyrighted by Unisys Corp., which
in principle charges alicense fee for every application using it. JPEG files are compact
but involve losses and degradation of the image and are thus not suitable for SHAPE
files.

The PNG format is intended to be a replacement for GIF, and in fact is superior to most
other formats, being lossless and giving very good compression for the type of images
generated by SHAPE (although 3D images do not compress as well as standard-mode
images). Essentially all major software vendors have subscribed to the PNG convention
and releases from 1998 onward should support it.
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Most TIF files also use LZW compression, but SHAPE does not use this type of
compression because of the copyright problem. The run-length-encoding which SHAPE
does use is supposed to be supported by all TIF readers, but in fact some do not support
it, and this algorithm does not work well for 24-bit (RGB) images.

There are dozens of raster graphics formats and it will never be possible for SHAPE to
support al of them. SHAPE users who work with raster files should consider investing
in aconversion program - there are many such programs which are not expensive.
Hijaak, by Inset Systems, handles agreat many raster, metafile and vector formats. The
PNG home page (www.cdrom.com/pub/pnp) has links to many shareware and
conventional commercia conversion packages.

3.2.1.15 Metafiles
Dialog Box: Metafiles [ File Menu]

Windows metafiles are basically vector images (but including fills) that can be rescaled
without necessarily losing resolution. They record the drawing commands that are used
for the screen or standard printer output, but the result may depend on the software or
device for which they are intended. A metafile image may either be saved in the
Clipboard, to be Pasted into another application, or written to afile.

SHAPE can write three types of metafiles. The original or standard metafile format has
proven inadequate for transmitting scaling information, and many applications do not
even accept Standard metafiles. Placeable metafiles, aformat which was originated by
Aldus Corporation, contain scaling information in an additional header. The standard
and placeable metafiles have the WMF extension. WMF or standard files are 16-bit
format, i.e. use 2-byte integers. Enhanced metafiles are 32-bit format files which also
contain scaling information. They are the preferred type of metafile for usein 32-hit
Windows systems (Windows NT or Windows 95), but cannot be used in standard 16-bit
Windows 3.10r Win32s.

Original (16-bit or WMF) metafiles can be written with either of two Scaling Modes,

| sotropic or Anisotropic. Isotropic supposedly keeps the same proportions. Generally,
Isotropic isthe best asit allows rescaling while preserving proportions. However, some
applications only accept Anisotropic files, and some ignore the scaling mode completely.
The type of image written by this option is strictly two-dimensional. It is also possible to
write files containing three-dimensional images with the VRML Files and POV-Ray
options.

When writing to afile, to prevent loss of resolution, SHAPE uses a standard scaling of
2540 dots or pixels per inch (1000/cm). However, some drawing applications may not
read the scaling correctly (assuming 72 dpi) and it may be necessary to rescale the
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drawing after importation.

When writing to the clipboard, SHAPE uses the current screen resolution, which usually
isabout 92 dpi. Thisis because most drawing applications assume screen resolution or
72 dpi. The clipboard image can be either 16-bit (.wmf) or 32-bit (.emf) according to the
setting of the Type option.

See Frames for details of the frame and frame units.

Limitations of Metafiles. Asdesigned and implemented by Microsoft, the metafile
allowsrecording of all Windows drawing commands, so that a file image can be a copy
of what is shown on the screen but rescalable. Unfortunately non-Microsoft drawing
applications (e.g. Corel Draw, Adobe Illustrator) sometimes implement metafiles
incompletely or incorrectly so that there are some limitations in metafiles written by this
option, in order to allow them to work in as many applications as possible. It many be
necessary to try many combinations of settings (Destination, Scaling mode, Type of file)
to get satisfactory results in an importing program.

1) Resolution for the clipboard is now that of the screen, typically 72-96 dots-per-inch
(dpi) - earlier versions of SHAPE used 2540 dpi. The lower resolution should not cause
problems except for very complex drawings - if adrawing looks good on the screen, it
should look good in adocument. If the clipboard is unsatisfactory use afile.

2) Bitmap patterns for black-and-white images cannot be used. Fills are transmitted as
gray shades which are interpreted by the importing application and/or printer.

3) A background is always present, to insure correct scaling. With some care, this
drawing element may be removed in importing applications.

4) Thereisno clipping of the image, although some importing applications may use the
drawing frame for clipping. For

5) Transmission of theimage in Corel Draw with the Clipboard may require use of
Edit/Paste Specia rather than a simple Paste.

6) Adobe Illustrator generally does not do well with labels - is may be necessary to use
an EPSfilefor Adobe Illustrator. Label backgrounds may not be transmitted in other
applications.

If ametafile is not satisfactory, araster file can be used. PNG raster files are often
smaller than metafiles, especially for complex drawings. Also, many drawing programs
now support import of EPS (Direct PostScript) files. EPSisusualy the preferred type of
filefor Adobe lllustrator.
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3.2.1.16 PICT Files
Dialog Box: PICT File (Clipboard) [ File menu]

Note that thistype of output may be referred to el sewhere as Metafile output. This option
can write images either to PICT files or the Clipboard, in either of two formats: (a) a
rescalable 2-dimensional Picture or metafile, or (b) araster image or bitmap.

For the 3D Drawing mode , this option writes a two-dimensional image and only bitmaps
are available, but seethe VRML Files option for files which actually contain three-
dimensional data Macintosh Pictures, as used here, are images containing lines or
vectors and fills of regions defined by lines, that can be rescaled without necessarily
losing resolution. They record the drawing commands that are used for the screen or
standard printer output, but the result may depend on the software or devicein which
they are used.

Bitmaps or raster images record every pixel, so they are not susceptible to undesirable
modification by other software. Although most "painting” software can resize bitmaps,

thisusually causes aloss of quality, so it is best to save a bitmap in exactly the desired

size. Note that you can also save bitmapsin the PNG file format (Eile menu), whichis
superior is some respectsto PICT files.

If color output is selected, you can choose either 16- or 32-bit color depth - 8-bit (256-
color) files cannot be written.

Y ou can select the nominal dots per inch/centimeter, and thisis written into the PICT
file, but note that programs which read the file may ignore this and show the image at 72
dots per inch.

Background color. If thisoption, which applies only to Picture output, is on, the color
selected in the Background Color dialog of the Input2 menu will be applied in color
output only. Background in b/w output is always white.

In the 3D drawing mode PICT (bitmap) output always has 32-bit pixel depth.

See Frames for details of the frame and frame units.
3.2.1.17 Screen to Bitmap
Dialog Box: Screen to Bitmap (.BMP) [ File Menu]

This command writes a bitmap giving exactly what is shown inside the current graphics
window, not including any overlapping windows. It will save a Device-Independent-
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Bitmap (DIB) either to the clipboard or to a.BMPfile.

Thisis appropriate for applications which will use the image on the screen. For
applications which will use a printed image, either the Raster Files or Metafiles options
will usually give better results.

Y ou can also copy the current window to the clipboard with the Print Screen key (this
isastandard Windows function). However, thisincludes the window title bar and border
and parts of overlapping windows, whereas the Screen to Bitmap command only copies
the graphics part or the client area.

3.2.1.18 VRML Files
VRML Files [ File Menu]

Virtual Reality Modeling Language files were intended for exchange of virtual reality
data on the Internet. However, they have become a de facto standard for interchange of
3D dataof al types. SHAPE currently supports V1.0 ascii files.

VRML files can be viewed with the Netscape Navigator browser for Windows, using the
Live3D plug-in or the SGI Cosmoplayer plug-in. The Microsoft Internet software for
Windows 95 can also view VRML files. Sincethefiles aretext, they can also be viewed
on any system. VRWeb for Windows 95/NT is aviewer which isindependent of
Internet browsers - it is smaller and faster than the browser plug-ins. Viewers may not
support all features, such as transparency.

For the latest information on crystallographic applications of VRML see
http://193.49.43/dif/3D_crystals.html or http://fluo.univ-
lemans.fr:800L/vrml/intvrml.html.

The images will be very similar to those in the 3D Display mode on screen.

3.2.1.19 POV-Ray Files
POV-Ray File Output [FEile menu]

POV-Ray is aprogram which draws a 3D image pixel-by-pixel, calculating all possible
light-ray paths. It allows for much more elaborate lighting effects than the OpenGL or
Direct3D software used in the 3D Drawing Modes in SHAPE. Some obvious effects are
refraction and internal reflection but there are many possibilities. Backgrounds and other
objects may be added aswell. The files are text (ASCII) and may be edited.

Since the calculation is much more elaborate than that done by OpenGL, thisisnot a
method that can be used for real-time display on the screen - POV -Ray images may take
many minutes to complete.
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The POV-Ray package, with instructions, samples, etc., may be obtained from
WWW.povray.org.

Since the primary purpose of the option istry to produce truly realistic drawings of
crystals, symmetry elements are not presently included.

See Frames for details of the frame and frame units.
3.2.1.20 EXxit/Quit

Exit/Quit command [ File menu]

Use this command to end your SHAPE session. SHAPE prompts you to save data sets
with unsaved changes.

If you have changed the orientation from that specified in the Initial Orientation dialog in
the File2 menu, you are asked if you want to save the current orientation. If you choose
to do this, the current orientation will be converted to initial orientations on the observer
X,y and z axes. If clinographic viewing isin effect at the time of saving, theinitial
clinographic viewing flag will be turned on. The initial rotations can be changed or
deleted in the Initial Orientation dialog in the File2 menu. See also

Coordinate Systems.

3.2.2 Modes Menu

This has four submenus, for selecting the M odel, Drawing, Operating and Cur sor
modes. The selectionsin the M odel, Drawing and Oper ating mode submenus are also
in the Dialog Bar - Left, turned on and off in the Display Menu. The Cursor modes are
also inthe Dialog Bar - Right.

The M odel mode determines how the crystal(s) are displayed.

In Standard mode, there is an external view, and this view occupies the center of the
viewing areaunlessit is deliberately displaced. Inthe original orientation, the view is
down a*.

In Stereonet mode, the standard drawing of the crystal occupies the left half of the
viewing area, and a standard Wulff Stereonet occupies theright half. The original
viewing orientation of the crystal is different from that in the standard mode; it is viewed
directly down the c crystallographic axis rather than the a* axis. If clinographic viewing
ison for the standard view, it isignored in the stereonet mode. Other rotations are
transferred between the two modes.
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In Section/Zoning mode, a section or successive sections of the crystal, parallel to the y-
z plane, are drawn. The many parameters for this type of view are set in the

Sections and Growth Zones dialog in the Inputl menu and its subdialogs. Thismodeis
not available in SHAPE Standard Edition.

The Drawing mode determines what method is used to draw the crystal(s). The drawing
can bein 2D (two-dimensional) mode, for more schematic drawings; or in 3D (OpenGL)
mode for more realistic representation as 3D objects. For actual stereoscopic viewing,
either 2D or 3D can be shown as separated stereopairs, the Quad Stereo mode can take
advantage of hardware which supports quad-buffered OpenGL or the Direct3D mode can
show also stereo in Windows with appropriate hardware.

The Operating mode determines whether SHAPE uses procedures for normal crystals
(Crystal or SHAPE mode) or for non-crystallographic symmetry (Cartesian, quasi-
crystal or QSHAPE mode).

Polyhedral solids with non-crystallographic symmetry such asicosahedral or pentagonal
are often referred to as quasi-crystal's (hence the name QSHAPE, formerly used for a
separate version of SHAPE). The Cartesian mode is not available in SHAPE Standard
Edition.

For normal crystallographic symmetry, SHAPE can simply permute and/or negate the
indices of input formsto find al the symmetry equivalents. The form/face indices refer
to intercepts on axes whose length and mutual inclination vary. Itisonly necessary to
select one of the 32 crystallographic point groups or crystal classes.

For quasi-crystal symmetry, face/form indices always refer to Cartesian axes, and it is
necessary to read afile containing the symmetry matrices. An auxiliary program,
SYMGRP, can write these files, although the files containing matrices for the
icosahedral and pentagonal groups are provided. Indices areintegersfor the Crystal
mode, and decimal or floating-point numbers for the Cartesian mode. Cartesian-mode
indices are always normalized automatically to alength of one.

Apart from the symmetry input and the integer/floating-point nature of indices, operation
isamost identical in the two modes.

The Cursor Mode determines what happens when you click in the graphics window.
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Inthe Index mode, when the left mouse button is clicked, the faceisidentified and
certain other information is given (see Face at Cursor). If theright button is clicked on
an edge or corner, you have the option of adding aface truncating that edge or corner -
the indices of the new face will be the sum of the indices of the faces involved in the
edge or corner.

The Resizing mode allows automatic adjustment of central distances and therefore face
sizes. In this mode, clicking the left button on aface will increase the central distance of
the form , and cause recalculation (the current orientation will be retained). Of course,
increasing the central distance generally decreases the size of the facesin the form.
Clicking the right button decreases the central distance. The amount of the increase or
decrease is set in the Preferences dialog in the Settings menu. Clicking on aface of a
twin will cause achangein al the twin individuals.

Note that the Resizing mode affects all faces of aform. If you want to change
individual faces, distorting the crystal from ideal symmetry, select the Remove
Symmetry button in the Dialog Bar - Right, or go the the Symmetry option in the
Inputl menu and select the Remove Symmetry button.

When in the Resizing mode, there is abox in the upper left of the graphics window
labelled "Resize mode off". Clicking in this box will revert to the Index mode.

In the Rotate mode, clicking and dragging in the major part of the graphics window
causes rotation on either or both of the reference axes in the plane of the screen.
Clicking and dragging near the left-hand or upper edges causes rotation on the axis
perpendicular to the screen.

Summary of mouse cursor operationsin graphicswindow. For Macintosh, "Right
button" is obtained with the option key plus the mouse button.

Index (Identification) mode:
L eft button - identifies face and form; successive clicks give interfacial angle.

Right button - identifies edges and corners; allow addition of new form truncating
face or corner.

Resizing mode:
L eft button - increases central distance of form selected - usually decreases area.
Right button - decreases central distance of form selected - usually increases area.

Rotate mode:
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L eft button - click and drag in main part of window rotates around axes in screen;
click and drag near left or upper edge rotates around axis perpendicular to screen.

3.2.2.1 Model Mode Sub-Menu
Sub-Menu - Model Mode [Display menu]

The M odel mode determines how the crystal(s) are represented.

The Standard mode is an external view, and this view occupies the center of the
viewing areaunlessit is deliberately displaced. Inthe original orientation, the view is
down a*. The crystal may be shown asasingle crystal or as a stereopair; and it may be
shown in 2D or 3D Drawing mode.

In Stereonet mode, the standard drawing of the crystal occupies the left half of the
viewing area, and a standard Wulff Stereonet occupiestheright half. The original
viewing orientation of the crystal is different from that in the standard mode; it is viewed
directly down the c crystallographic axis rather than the a* axis. If clinographic viewing
ison for the standard view, it isignored in the stereonet mode. Other rotations are
transferred between the two modes. Thisis shown in a2D Drawing mode only.

In Section/Zoning mode, a section or successive sections of the crystal, parallel to they-
z plane, are drawn. The many parameters for thistype of view are set in the

Sections and Growth Zones dialog in the Inputl menu and its subdialogs. Thisis
shown in a2D Drawing mode only.

3.2.2.2 Drawing Mode Sub-Menu
Sub-Menu - Drawing Mode [Display menu]

This sub-menu switches between 2D and 3D types of drawing, and also allows "true"
stereoscopic drawing, that is drawing with quad-buffered OpenGL with appropriate
hardware.

Graphicsin the Standard Model mode can be either 2D, which uses the standard system
software for drawing in two dimensions; or they can be 3D, which uses the system
software (OpenGL ) for drawing three-dimensional objects. The StereoNet and
Sectorsg/Zoning Model modes are 2D only.

3D. Although afully shaded drawing donein the Standar d mode may have ahighly 3-
dimensional appearance, this option, which uses special system software not available on
all machines, allows a number of extra optionsin terms of lighting and material
properties and is the only Drawing mode in which symmetry can be shown. Switching
into this mode requires loading the system software, which may take afew seconds.
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The choices in this submenu are also in the Drawing Mode drop-down in the
Diaog Bar - Left which is controlled from the Display menu.

The OpenGL system software (abbreviated OGL in some situations) is available on all
platforms - Windows, Macintosh and Linux. It can always be used to get 3D images, but
may require a specia graphics card such as the nVidia Quadro series to show non-
separated "true” stereo.

3D Quad Stereo. Thisisaspecial kind of OpenGL drawing mode, which uses quad-
buffered display hardware to draw |eft- and right-eye images, which are alternated on
screen or other viewing device at a high rate, or which may even be drawn on separate
displays. Most systems require wearing special glasses, either shutter glasses or some
type of polarizing glasses. Currently nVidia, in their Quadro line of display cards,
provides the most widely available type of quad-buffered systems, which must be used
with certain types of monitor. Quad-buffered OpenGL may also be supported by other
hardware such as projectors and using software drivers other than nVidia, such as iZ3D
and TriDef.

r.

Direct3D (Windowsonly). Thisis Microsoft's version of 3D software. The only reason
for using this mode instead of the OpenGL modesis to support stereoscopic viewing
with shutter glasses or polarizing monitors using those display cards which do not
support quad-buffered OpenGL. Thisincludes most of nVidias display cards except
Quadro cards.

Fullscreen Mode. Any of the display modes can be shown in fullscreen mode rather than
in the graphics window. Change to fullscreen with the Fullscreen option in the Display
menu or the Fullscreen button in the Dialog Bar-L eft

3.2.2.2.1 2D Drawing Modes

These drawing modes can be selected in the Drawing Mode submenu in the Display
menu, or in the Dialog Bar - Left.

This mode is actually very flexible, and supports representations ranging from very
schematic line drawingsto fully three-dimensional, but it will not show symmetry.

The alternatives to 2D modes are 3D Drawing modes, which give amore realistic
appearancein full color, but are not generally suitable for schematic drawings. See
Description of the Calculations for details on the difference between 2D and 3D Drawing
modes.

Sereopairs. Selecting 2D Stereopair causes two separate drawings to be made, which
areidentical except for the Stereopair Rotation Angle. Many people cannot view a
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stereopair directly because of the difficulty of getting the left and right eyesto focus on
separate points at a short distance. However, various devices are available for such
viewing, using lenses, mirrors or prisms.

Some people can view stereopairs by crossing their eyes, without artificial aids. For this,
the Stereopair Rotation Angle should be negative.

Stereo viewing works best when Perspective is selected.

3.2.2.2.2 OpenGL Drawing Modes

These drawing modes can be selected in the Drawing M ode submenu of the
Display menu, or the Dialog Bar - Left.

The OpenGL modes use the OpenGL system software for amore "realistic”" appearance.
Since this type of drawing automatically handles the interpenetration and intersection of
solid objects (using a depth buffer), it allows the depiction of symmetry elements, that is
rotation axes and mirror planes. See 3D Drawing modes for more details. Settings for
thismode are in the 3D Parameters dialog in the Input2 menu.

The OpenGL Stereopair mode shows two images, asin the 2D Stereopair mode, but
they are drawn using the 3D method.

Although afully-shaded SHAPE drawing in the 2D Drawing modes has an excellent 3-
dimensional appearance, the term "3D drawing" is used to denote a method of drawing
which isdifferent in several respects. SHAPE uses the OpenGL software package for
Windows, Linux and Macintosh. 3D Drawing modes give a more realistic appearance in
full color, especially on screen, but are not generally suitable for schematic drawings, as
there are no boundary lines. See below and in Description of the Calculations for details
on the difference between 2D and 3D Drawing modes.

Sereopairs. Selecting 3D Stereopair causes two separate drawings to be made, which
areidentical except for the Stereopair Rotation Angle. Many people cannot view a
stereopair directly because of the difficulty of getting the left and right eyesto focus on
separate points at a short distance. However, various devices are available for such
viewing, using lenses, mirrors or prisms.

Stereo viewing works best when Perspective is selected.

In order to show non-separated stereo views with OpenGL, you must have an appropriate
graphics card and viewing hardware, and you must select the
OpenGL Quad Stereo Drawing Mode

Some people can view stereopairs by crossing their eyes, without artificial aids. For this,
the Stereopair Rotation Angle should be negative.
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Older stereo drawing drivers from nVidia, which worked with shutter glasses but only on
Cathode-Ray-Tube monitors, not flat-screen LCD monitors, supported OpenGL without
guad-buffering. If you are using such a system, you do not need to select the SHAPE

3D Quad Stereo Mode; stereo images can be viewed in the 3D Single Drawing mode.
However, stereo will be shown only in Fullscreen display, not in awindow. The stereo
effect is turned on with ahot key or other switch for the hardware.

Difference Between 2D and 3D Drawing Modes.

In 3D drawing, the surfaces of three dimensional objects such as spheres and cylinders
are converted to an assemblage of planar polygons. Then each polygon is drawn
essentially independently. The critical difference from 2D Drawing modesisthat a depth
buffer isusedin 3D imaging. Thisisan array of integers, one for each pixel in the
display or output (or that portion which is currently being drawn). Each element,
representing a pixel, holdsthe relative x coordinate (in the SHAPE observer coordinate
system) of the foremost object or polygon. The color for this object is retained in the
color buffer, whichisasimilar array representing pixels; thisarray is actually the image
itself. Whenever apolygon is drawn, each pixel which it contains is compared against the
depth buffer; if the x coordinate of the pixel is greater, or closer to the observer than
what isin that element of the depth buffer, the color for this pixel in the new polygon
replaces the value in the color buffer. That is, the depth buffer keeps track of the front
surface of the drawing, and ensuresthat only this front surface (not any hidden surfaces)
are kept in the color buffer or image itself. It is aso possible to have transparent or
translucent objects, through which hidden surfaces may show partially, by mixing the
color of the latest object with the color which is already in the buffer.

Actualy, the "double buffer" method is normally used, the color buffer being kept in an
area of memory and then copied to the screen memory when the drawing is completed.
Thisisusually faster than drawing directly to the screen.

The 2D Drawing modes of SHAPE do not use a depth buffer. When necessary, the
intersections of objects are solved analytically and only the required portions of each are
drawn.

Using a depth buffer has the advantages that it is not necessary to solve analytically for
intersections, nor to sort the objects with respect to depth (unless some objects are
translucent). Thismay save considerable time, especially for complex drawings, since
the time for sorting tends to increase exponentially with the number of objects. Since
analytical solution of intersectionsis not necessary, it is possible to place essentially any
objects into the drawing. in any location. This overcomes the problem in SHAPE 2D
Drawing modes of sometimes-incorrect drawing of crystal edges. The 3D method allows
more complex shading and lighting effects, such as specular highlights and multiple light
sources. For acompletely 3-dimensional image, on a computer which has sufficient
memory, the 3D Drawing mode is superior to the SHAPE 2D Drawing mode.
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However, there are disadvantages to the 3D method. The depth buffer may result in
excessive memory requirements even for the screen (but some 3D accelerator cards may
have special memory for the depth buffer). Because printers have much higher
resolution than the screen, this causes even higher memory requirements, and for
reasonable sized printed drawings it is usually necessary to do the printing in bands or
segments.

3.2.2.2.3 OpenGL Quad Stereo Drawing Mode

This drawing mode can be selected in the Drawing M ode submenu of the Display menu,
or the Dialog Bar - L eft.

Thisisaspecial type of 3D Drawing mode which is available only for graphics hardware
supporting OpenGL quad-buffered stereo. In this mode, left- and right-eye images are
drawn and displayed by either of two methods:

1) Shutter glasses. The images are drawn independently and flashed alternately on the
screen at a high rate - 120 times per second in the latest computer implementations, for
exampl e those supported by the nVidia Quadro series of display cards. A special
monitor is required, and it must be viewed with special shutter glasses which blank out
the left and right eyes alternately in synch with the images on the screen.

2) Polarized monitors or projections. The monitor or projector simultaneously or
aternately (very rapidly) generates two images which are polarized at 90 degrees to each
other, or with different circular polarizations. Some "3D" (stereoscopic) televisions have
different polarizations (and different images) for alternate lines on the screen and some
projectors and TV's use a checkerboard pattern. Theater 3D systems use this method. It
does not require expensive shutter glasses, only relatively cheap polarizing glasses for
each viewer.

See the Stereoscopic Display section in Reference for general requirements and
procedures.

Two settings affect the perception of depth in stereo viewing:

1) The Stereopair Rotation Andle, set in adialog in the Input2 Men, or in the
DialogBar - Right. A value of about 1 to 3 degreesis usually appropriate (smaller when
starting out in stereo viewing).

2) The Perspective distance which isset in adialog in the Input2 Menu, or in the
DialogBar - Right. A value of about 100 Angstromsis usually appropriate, but it may be
smaller for small structures.

In viewing real life objects setting the perspective distance would fix the stereopair
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rotation angle because the human eyes are afixed distance apart. However in viewing
objects on an Angstrom scale the interocular distance is arbitrary, and thus it is possible
to set both parameters - in effect the stereopair rotation angle fixes the interocular
distance or the scale of the atomic structure relative to the viewer.

Not al stereo hardware supports OpenGL. The GeForce series of video cards from
nVidia supports stereo viewing with shutter glasses, but only through the Windows 3D
system software, Direct3D, for which a different drawing mode is available in SHAPE.
Direct3D is only available on Windows systems, not Macintosh or Linux. Although
hardware isindifferent to whether the program draws in 3D through OpenGL double-
buffered, OpenGL quad-buffered or Direct3D, the proper driver software must be
present. Polarizing monitors may or may not have drivers supporting OpenGL.

Older stereo drawing drivers from nVidia, which worked only on Cathode-Ray-Tube
monitors, not flat-screen LCD monitors, supported OpenGL without quad-buffering, as
well as Direct3D. This system worked with inexpensive shutter glasses, but if the refresh
rate of the monitor islessthan 100 hz or so the flicker tends to be excessive. If you are
using such a system, you do not need to select the SHAPE 3D Quad Stereo Mode;
stereo images can be viewed in the OpenGL Single Drawing mode. However, stereo
will be shown only in Fullscreen display. The stereo effect is turned on with ahot key or
other switch for the hardware.

Stereo viewing works best when Perspective is selected.

Certain high-end nVidia Quadro cards support quad stereo on Linux, using special
"Professional” emitters and glasses. Thismode isthus availablein Linux, although it
will not produce stereo images without this special hardware. This mode has not been
tested on Linux.

Setting up nVidia 3D Vision for quad-buffered OpenGL. Inthe nVidiacontrol panel,
select Manage 3D Settingsin 3D Settings. In the Global Settings tabe, the Global presets
option can be set to "3D OpenGL Stereo”. It may then be necessary to select the
particular setting Stereo - Display Mode and set it to " Generic active stereo (with
NVIDIA 3D Vision)".

If you have arecent VidiaQuadro card it may support 3D Vision stereo through
Direct3D aswell as OpenGL. There seemsto be no advantage to using Direct3D if
quad-buffered OpenGL isavailable, but if Direct3D is used, different settings may need
to be selected in the nVidia Control Panel. The Global preset option should probably be
"3D App - Default Global Settings'. All the nVidia settings may change and it may be
necessary to experiment to find the best combination.
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In this mode, the "separation” of the imagesis controlled with the
Stereopair Rotation Angle dialog in the Input2 Menu, or with the DialogBar - Right.

Not all stereo hardware supports OpenGL. The GeForce series of video cards from
nVidia supports stereo viewing with shutter glasses, but only through the Windows 3D
system software, Direct3D, for which a different drawing mode is available in SHAPE.
Direct3D is only available on Windows systems, not Macintosh or Linux. Although
hardware isindifferent to whether the program draws in 3D through OpenGL double-
buffered, OpenGL quad-buffered or Direct3D, the proper driver software must be
present. Polarized monitors may or may not have drivers supporting OpenGL.

Older stereo drawing drivers from nVidia, which worked only on Cathode-Ray-Tube
monitors, not flat-screen LCD monitors, supported OpenGL without quad-buffering.
This system worked with inexpensive shutter glasses, but if the refresh rate of the
monitor isless than 100 hz or so the flicker tends to be excessive. If you are using such a
system, you do not need to select the SHAPE 3D Quad Stereo Mode; stereo images can
be viewed in the 3D Single Drawing mode. However, stereo will be shown only in
Fullscreen display. The stereo effect is turned on with a hot key or other switch for the
hardware.

Stereo viewing works best when Perspective is selected.

Setting up nVidia 3D Vision for quad-buffered OpenGL. Inthe nVidiacontrol panel,
select Manage 3D Settingsin 3D Settings. In the Global Settings tabe, the Global presets
option can be set to "3D OpenGL Stereo”. It may then be necessary to select the
particular setting Stereo - Display Mode and set it to " Generic active stereo (with
NVIDIA 3D Vision)".

3.2.2.2.4 Anaglyph

In Anaglyph mode there are two views of the crystal, but instead of occupying separate
halves of the screen or paper they are drawn in two different colors such as red and blue
and superimposed in the center of the screen or paper. Thistype of drawing must be
viewed with standard colored 3-D glasses, which have ared lensfor the left eye and a
green or blue lensfor theright eye.

There are several settings for this mode, such as the background and line colors; see the
Anaglyph Settings dialog in the Display Menu

3.2.2.2.5 Direct3D Drawing Mode

Thisisa3D mode using the Microsoft Direct3D (DirectX) software, which is essentialy
equivalent to OpenGL. The main reason for selecting this mode isto display
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stereoscopically using shutter glasses or a polarizing monitor, if you have adisplay card
which supports stereo only using Direct3D, not OpenGL quad-buffering. See the
Stereoscopic Display section in Reference for the requirements and procedures.

This mode also alows anaglyph (Red/Green or Red/Blue) stereoscopic viewing with
appropriate software drivers. This requires only cheap plastic colored glasses. ThenVidia
GeForce graphics cards which support stereo viewing with shutter glasses al so support
anaglyph viewing - in the nVidia Control Panel, enable Stereoscopic 3D and select "3D
Vision Discover" in the Stereoscopic 3D display type option. Since SHAPE hasits own
Anaglyph mode there is usually no reason to use the 3D Vision Discover mode.

Other software vendors such as iZ3D and TriDef supply drivers which may support
anaglyph or various other kinds of stereoscopic viewing on your system.

In this mode, there is no face identification with the mouse; clicking and dragging with
either the left or right button rotates the structure. The shortcut keys control rotation,
scaling, etc.

Sereo Viewing with nVidia shutter glasses. The nVidia GeForce display drivers prior to
V 266 supported stereo viewing only in fullscreen mode, not in awindow. |If you have an
old driver you will have to go into fullscreen mode (Fullscreen button in the Dialog Bar -
_Left) to see stereo, but you should download the updated driver from nVidia if possible.
For smoothest operation of windowed stereo, in the nVidia Control Panel, under
Stereoscopic 3D/Set up stereoscopic 3D, in the category "Select when the display isin
3D mode:" choose "Always'. If thisisset to "Only while 3D programs run”, the entire
screen may blank out while entering and exiting Direct3D mode and entering and exiting
from fullscreen mode. If it is set to "Only while full-screen 3D programsrun”, there will
only be stereo in full screen mode, not in the SHAPE graphics window.

In the Direct3D mode, fullscreen, there is no atom identification - the only action of the
mouse isto rotate the structure. The shortcut keys have their full effect.

The nVidia settings depth and convergence are not available to the user in SHAPE,
because they are controlled by the two SHAPE settings Stereopair Rotation Angle and
Perspective Distance. Convergence affects the apparent overall distance of the object -
whether it appearsto be in front of or behind the screen. However, excessive
displacement in either direction can cause difficult in the ability of the eyes to merge the
two images (they may become excessively separated on the screen), and also increased
prominence of "ghosts" or residual weak imagesin thewrong eye. Therefore SHAPE
always sets the convergence distance equal to the perspective distance so that the center
of the structure is essentially in the screen, not in front of or behind it. The stereopair
rotation angle then sets the nVidia depth (the term "depth" does not refer to the position
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of the object front-back, but to the apparent distance between the nearest and the furthest
parts of the object).

The nVidiaKeyboard Shortcuts or hot keys for changing depth and convergence have no
effect in SHAPE, athough using the depth keys will bring up a scale showing the
relative degree of stereo effect.

3.2.2.3 FullScreen Display
Fullscreen command [ M odes menu]; Fullscreen button [Dialog Bar - L eft]

The Fullscreen option in the the Display menu or the Fullscreen button in the
Dialog Bar - Left switchesto full-screen display. One reason to do thisisto take
advantage of full-screen, full-color stereoscopic viewing using shutter glasses - the
software and hardware for some of these systemswill only work in full-screen mode.
See below and the Stereoscopic Display section in Reference for the requirements and
procedures.

Mouse buttons have the same effect as when in the I dentify Faces Cursor mode in a
window.

L eft button down isfor identifying faces, asin the normal windowed mode. If the left
mouse button is clicked when not on a crystal, a dialog offering Quit or escape from the
Fullscreen mode, plus the control options asin the shortcut keys, will appear.

Right button down and moving the mouse down causes rotation exactly asin the normal
windowed mode.

To exit from Fullscreen display, press the Escape key; or click with the mouse where
thereisno crystal.

-- KEYBOARD CONTROLSFOR FULLSCREEN MODE

With V7.3, the SHAPE shortcut keys have been revised and greatly expanded.

--IF THE KEYBOARD ISNOT FULLY ACTIVE IN FULLSCREEN MODE

On different platforms (Windows, Macintosh, Linux) or different releases or versions of
the same platform, some or al of the keys may be inactive in Fullscreen mode. Thusif
some or al of the above keyboard controls do not work, click with the mouse where
thereis no crystal, and you will be presented with a dialog giving the options explicitly,
aswell as the option to Quit or exit fullscreen mode.
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--Windows Only

Full-screen, full-color stereoscopic viewing with shutter glasses and CRT Monitors. The
following describes older technology for CRT monitors, not newer technology such as
nVidia3D Vision, which requires special shutter glasses and certain 120 Hz monitors.
That technology is supported with the 3D Quad Sterec Drawing mode (and can work in a
window, not only in Fullscreen mode) or with the Direct3D mode.

Stereo viewing works best when Perspective is selected.

Shutter glasses, with driver software for Windows operating systems, were available
from some vendors. The most complete support isfor nVidia cards, the stereo drivers
for which are available for free online (www.nvidia.com). The requirements and general
procedure for shutter-glasses viewing are as follows.

1) You must have a cathode-ray-tube (CRT) monitor. Flat-screen monitors will not
work because the refreshing mechanism is different. Stereo only worksin 3D Single
Drawing mode, not 2D modes.

2) You must install the stereo software driver for your particular graphics card onto the
computer. Y ou may also need an up-to-date driver for the card itself. For nVidia cards,
install the latest standard (non-stereo) driver for your card, and then the (separate) stereo
driver, according to the instructions at www.nvidia.com. For other cards you will need a
third-party stereo driver, which may be provided with the glasses. The driver must
support OpenGL.

3) Install the glasses (or the wireless station), typically by inserting a"dongle" where the
monitor cable plugsinto the computer (graphics card).

4) Turn on the Full-Screen mode in SHAPE, then turn on the stereo mode, usually by
using a"hot key". It may be best to turn stereo on after entering full-screen modein
SHAPE, and turn it off before exiting.

Flickering in stereo mode is caused by a monitor refresh rate that istoo slow. This
usually may be reset in the Windows Display control panel and/or in the stereo driver
software. On switching into full-screen mode, SHAPE first tries the current screen size,
bit-depth and refresh rate. If thisfails, then it tries successively smaller screen sizes. If
you get a message saying that the switch into full-screen mode has failed, you can try
changing the bit-depth (for example from 32- or 24-bit to 16-bit) or the refresh rate in the
Windows Display control panel or in the stereo driver software.

The Website www.stereo3d.com has some basic technical information about shutter-
glasses stereo, but the information on specific hardware and vendors may be out of date
because the technology and marketing are currently moving very rapidly.
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Caution: use shutter glasses or other hardware and driver software at your own risk -
stereo drivers may have atendency to crash your system. SHAPE softwareis not
responsible for any damage to your hardware or software through use of these devices.

3.2.3 Inputl Menu
Title/Axes - Titleand crystal axes or unit cell for the main crystal.

Symmetry - Symmetry of the main crystal.
Forms - Crystal forms (symmetry-equivalent faces) present on the main crystal.

Twins - This reproduces the main crystal according to specified twin operations.
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Epitaxy - This adds additional crystalsin defined orientation.

Sections/Growth Zones - This provides settings and parameters for the Section/Zoning
Display mode selected in the Modes menu.

Face/Form Fills - Thisallowsfilling of specified faces and/or forms with colors or black-
and-white patterns.

Shading - Thisturns on shading in color or black-and-white according to the angle of the
faces from the specified illumination vector.

Striations - This adds striations to specified forms.

Interfacial Angle - This computes the angle between the normals between any two
specified faces, even if they are not actually present.

Donnay-Harker Morphology - Thisderivesalist of forms sorted according to X-ray d-
spacing, or reticular area - such lists often correlate well with the forms observed.

3.2.3.1 Title/Axes
Dialog Box: Title/Axes [ Inputl Menu] [ Epitaxial Relations dialog]

Thetitle may contain up to 63 characters.

In Crystal operating mode, select the crystal system, and axis-length and angle boxes
appropriate for this system will appear. In Cartesian or QSHAPE mode, the axes must
be Cartesian.

See also Coordinate Systems.

When called from the Inputl menu, this dialog can only modify the main or host crystal
of an epitaxial intergrowth. Epitaxial guest crystals are modified from the
Epitaxial Relations dialog.

3.2.3.2 Symmetry - Point Group or Crystal Class

Dialog Box: Symmetry - Point Group or Crystal Class [ Inputl Menu] [
Epitaxial Relations dialoq]

Thisdialog lists all the 32 crystallographic point groups, or crystal classes. The
orientation is as indicated by the Herman-Maughin or International symbol. Notethat a
capital "B" preceeding an axis denotes an inversion axis, such as"bar-3". The
orientation is as given by the H-M symbol, and in some cases two orientations are
possible - see below.
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The Remove Symmetry button offers the option of converting all faces which have
been generated by symmetry to forms, and reducing the symmetry to group 1. The
crystal can then be distorted from the ideal habit by changing the central distances of
individual faces (through the Forms List dialog). Thisoption is not available unless the
crystal has been calculated.

When called from the Inputl menu, this dialog can only modify the main or host crystal
of an epitaxial intergrowth. Epitaxial guest crystals are modified from the
Epitaxial Relations dialog.

Note that space-group symmetry is needed for the Donnay-Harker Morphology option -
the point group is normally derived from the space group, and this may cause
replacement of the point group specified in this dialog, if the two are not the same.
Alternate Orientations . There aretwo listings for each of five crystal classes, for
which alternate orientations are possible. The pairsare 321 - 312, 3m1 - 31m, B3m1 -
B31m, B42m - BAm2 and B6M2 - B62m. In these symbols, the first number or letter
after the high-order axis (3, 4 or 6) indicates either a set of two-fold symmetry axes
parallel tothea crystallographic axes, or aset of mirror planes perpendicular to the a
crystallographic axes. The next letter or number indicates symmetry elements aligned on
the directions bisecting the a crystallographic axes. If thereisno symmetry inthea -
axis directions, thereisanumber 1 asaplaceholder. A fina 1isusually dropped, asin
321 =32

Versions of SHAPE prior to V6.0 allowed only the first orientation of each of these
pairs. InV6.0, it ispossibleto import crystallographic dataincluding the space group,
and it is necessary to specify the space group for the Donnay-Harker Morphology

option. Since the standard settings of space groups may have either of the orientations of
each pair (for example P321 and P312 are different space groups), it is necessary to
include both to correlate the morphology with the structure axes. It is possibleto
describe the morphology in terms of the orientation which does not correspond to that of
the space group in the International Tables, but the unit cell in this orientation is non-
primitive, the a axes are longer in relation to the ¢ axis, and the indices of actual faces
aredifferent.

Since pre-V6.0 SHAPE only allowed one orientation, it is possible that forms entered
may beincorrect. Most errors of this sort may be corrected simply by changing the
symbol in this dialog, for example from P321 to P312. It isalso possible that older
morphologica data may not correspond with the X-ray axes, which use the orientation as
giveninthe International Tables. In thiscase, if the old morpologica dataareto be
used with the X-ray axes, it is necessary to transform the indices.

3.2.3.3 Cartesian Symmetry

Dialog Box: Symmetry - Cartesian Matrices [ Inputl Menu] [
Epitaxial Relations dialog]
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<Cartesian Mode>

SHAPE in the Cartesian mode (selected with the Operate command in the Modes
menu, or by reading in a Cartesian file) requires afile containing the Cartesian symmetry
matrices. The auxiliary program SY MGRP writes files which are normally given the
suffix .SYM. If you type the name into the edit box, give the full name of the symmetry
file, including the .SY M suffix. Some such files, namely those for pentagonal (C5, S10,
D5, C5v, C5h, D5h and D5d) and icosahedral (I and Ih) point groups, have already been
provided. For other point groups, it will be necessary to run the auxilliary program
SYMGRP to generate the file before running SHAPE; see section 1V-7 of the
Instructions.

The Get Symmetry button reads the file and fills out the symbol, number of matrices
and centric/non-centric state, which are printed out below the file name. If thisbutton is
not clicked, the file will be read when exiting the dialog.

The file name as entered in the edit box is saved in the data file for the crystal. If the
complete path is not given, the Cartesian symmetry file should be in the same directory
asthedatafile. If thefile cannot be found when the Get Symmetry button is clicked or
when exiting the dialog, you will get an error message and a chance to locate the file
with astandard file dialog. The complete path name, as determined in thisway or with
the Browse button, will then be saved in the datafile.

The Cartesian matrices themselves are saved in the SHAPE data file, and the Cartesian
symmetry fileisread only in thisdialog.

The Remove Symmetry button offers the option of converting all faces which have
been generated by symmetry to forms, and reducing the symmetry to group 1. The
crystal can then be distorted from the ideal habit by changing the central distances of
individual faces (through the Forms List dialog). Thisoption is not available unless the
crystal has been calculated.

When called from the Inputl menu, this dialog can only modify the main or host crystal
of an epitaxial intergrowth. Epitaxial guest crystals are modified from the
Epitaxial Relations dialog.

In order to display the symmetry elements themselvesin the 3D display mode, the .SYM
file must give the orientation of these elements. Old files do not have this information:
the new version of SY MGRP supplied the orientation information, but in some cases it
may be necessary to modify the files manually - see Symmetry Element Display.
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3.2.3.4 Forms List
Dialog Box: FormsList [ Inputl Menu] [ Epitaxial Crystals Dialog]

Thisliststhe formsfor the current crystal - thisisthe main crystal if thisdialogis caled
from the Inputl menu, or an epitaxial crystal if called from the Epitaxial Crystals Dialog.

Multiply central distances by factor. Most calculationsin SHAPE depend on finite
tolerances to decide whether corners are not outside of any face, whether a corner
derived from onetriplet of facesis coincident with another, etc. Sometimesthere are
errors, for example extra corners, missing edges, or missing faces (in the Shading or
Face Fill options, or in 3D mode). See Precision, Tolerances... for more details. In
many cases such errors can be eliminated by changing all central distances by the same
factor, which effectively changes the relative tolerances. Anincreasein central distance
ismost likely to help, although a decrease may be required in some cases. If the
Multiply all parameters by factor box is checked, parameters which involve absolute
central distance unitswill be multiplied by the factor. Such parametersinclude fixed
scale factors (Scaling); Perspective distance; Striation spacing; fixed Displacements of
thecrystal; Crystal Axes and Labels; Growth Rate and time parameters; and sizes of
cylindrical edges and symmetry elementsin the 3D modes (3D Parameters)

Clicking onthe Add or Revise buttons calls up the Add/Revise Form dialog
(Standard or Cartesian).

When called from the Inputl menu, this dialog can only modify the main or host crystal
of an epitaxial intergrowth. Epitaxial guest crystals are modified from the
Epitaxial Relations dialog.

Imaginary faces, edges and corners . The user is responsible for specifying enough
formsto make acomplete crystal. After having generated all symmetry-equivalent faces
and computing corners and edges, SHAPE applies some simpletests to seeif a closed
shape has been defined. If a closed shape does not seem to have been defined, you have
the option of computing again to define imaginary edges and corners. Thisis done by
adding "imaginary" faces at a central distance just greater than the most distant real
corner, or about 1.5 timesthe largest central distance if no corners have been found.
These faces are those of the unit cell, except for trigonal and hexagonal crystals, which
use atrigonal or hexagonal prism. The edges which terminate the real faces against these
imaginary faces are drawn with adifferent color (see Line Colors) and in the printed
output (List Results dialog, File menu) these edges and associated corners are marked as
Imaginary. These imaginary edges are not visible from the back side of the real faces
unless Back edges are selected in the Line Attributes dialog (Input2 menu).

For the Cartesian or QSHAPE mode of operation, theimaginary facesare (100), (-100),
(010), (0-10), (001), (00-1) and all their symmetry equivalents. This may lead to avery
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large number of faces and correspondingly long calculation times.

3.2.3.4.1 Add/Revise Form
Dialog Box: Add/Revise Form [ FormsList Dialog ]

<Standard Mode - see also Add/Revise Form (Cartesian)>

The central distance is the perpendicular distance from the center of the crystal to the
faces of the form in question: the greater the distance, the smaller the area of the face
(calculated areas are printed in the List Results option in the File menu). Also, if there
are many forms, the greater the distance the less prominent the form (the smaller the area
of the faces). Decimal values may be used for the central distance, but not for the
indices. Usethe Next Form button to add aform.

Y ou can use negative central distances to define a crystal which does not lie on the
origin; seethe rutile twin example in Chapter 5 of the Instructions.

For hexagonal and trigonal crystals with hexagonal axes, four indices, (hkil), are
commmonly used, but one of the first threeis redundant. In SHAPE, you must omit the
third, or i index.

The Form letter may be used to label each face in the conventional way. Whether
numerical indices, form letters or no labels at all are shown is set in the Labels dialogin
the Display menu.

The color, b/w pattern and pen number are used primarily for sections and growth zones
and may be used for form fills.

The Rate Constants button pertains to growth zones. It brings up either the

Exponential Growth-Rate Constants dialog or the Growth Interval s dialog, depending on
the Exponential/Discontinuous setting in the Growth Zone Settings dialog. The rate
parameters can al so be set from the latter dialog.

Seethe Forms List dialog for the addition of imaginary faces, edges and cornersif the
real faces do not define a closed shape.

3.2.3.4.2 Add/Revise Form (Cartesian)
Dialog Box: Add/Revise Form (Cartesian) [ Forms List Dialog]

<Cartesian Mode - see also Add/Revise Form (standard).>

The central distance is the perpendicular distance, from the center of the crystal to the
faces of the form in question: the greater the distance, the smaller the area of the face.
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Also, if there are many forms, the greater the distance the less prominent the form (the
smaller the area of the faces). Usethe Next Form button to add aform.

The form indices and central distance are all decimal numbers. Theindiceswill be
normalized to length one after entry. Five or six significant figures are sufficient.

Y ou can use negative central distances to define a crystal which does not lie on the
origin; see therutile twin example in Chapter 5.

The color, b/w pattern and pen number are used primarily for sections and growth zones.

The Rate Constants button pertains to growth zones. It brings up either the
Exponential Growth-Rate Constants dialog or the Growth Intervals dialog, depending on
the Exponential/Discontinuous setting in the Growth Zone Settings dialog. The rate
parameters can also be set from the latter dialog.

Seethe Forms List Dialog for the addition of imaginary faces, edges and cornersif the
real faces do not define a closed shape.

3.2.3.5 Twins
Dialog Box: Twins [ Inputl Menu]

There are basically two types of twins: contact and interpenetration. Interpenetration
twins simply reproduce the main crystal according to the twin operator supplied.
Normally, interpenetration twins should be drawn with intercrystal edges; these edges are
located after the individual s are reproduced.

Clicking onthe Add or Revise button calls up the Twin Operator dialog (Standard or
Cartesian).

If you select the contact option, and supply one or more composition planes with the
Composition Planes button, the composition planes are added to the crystal, truncating it
as necessary, then the crystal is reproduced according to the twin operations supplied.
No intercrystal edges are found for contact twins.

Note that all twin individuals are identical, and that composition planes always pass
through the center of the crystal (central distance zero). Of course interpenetration twins
may look different after the intercrystal edges are located. To draw twinsin which the
individuals are not identical, use Epitaxial Crystals.

Edgesin faces. When different crystalsin intergrowths have parallel and coincident
faces, the edges lying in this common surface may or may not be realistic or meaningful,
and you can elect to draw them or not. Usually the drawing is simpler and more
satisfactory without them.
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Always show composition-plane edges . Twins by reflection on the composition plane
should always match exactly at the junction, and a certain short-cut in the drawing of
such twinsis often useful. When this box is not checked, if the composition planeis
forward-facing, edges with this composition plane are not drawn. This often allows
simple twins to be drawn without using the Remove Hidden Lines option in the
Display menu. However, if the twin is by reflection, the two individuals often do not
match exactly on the composition plane, and visible edges may be omitted. Generally,
for correct drawing of mismatching rotation twins this box should be checked, and aso
the Edgesin facesbox . If the Always show composition-plane edges box is checked,
the Remove Hidden Lines option in the Display menu must be selected.

Scale successive inter penetration twins, by factor (1-x), X =. Interpenetration twins
often have coincident faces. In 3D Drawing Modes, if the two individuals are assigned
different colors, this usually causes the coincident areas to have a mottled appearance,
which may shift in pattern asthe crystal isrotated. This option rescales each twin
individual by asmall amount, (1 - x) where x is the value entered, so that the faces of the
second individual just underlie those of the first, and so on. Appropriate values are
approximately 0.00001 (107-5), so that the second crystal is 0.99999 times as large as the
first and so on.

This option should be used only for 3D modes - in Standard or 2D mode it will usually
disrupt the drawing of edges when the Remove Hidden Lines option in the

Display menu ischosen. After changing values, you must click Calculate as the corner
locations of twins are changed permanently.

3.2.3.5.1 Twin Operator
Dialog Box: Twin Operator [ TwinsDialog]

<Standard Mode - see also Twin Operator (Cartesian)>.

A twin operator may be either reflection on arational plane or rotation on arational
vector. Normal twins according to the system commonly used for feldspars should be
entered as reflection twins, giving the indices of the composition or twin plane. For
parallel twins enter the indices of the twin axisis the twin operator.

For rotation twins, the rotation angle is normally an integral fraction of 360 degrees. A
rotation angle is not needed for reflections twins - the angle will be set automatically to
180.

Note that composition planes must always be entered separately, even if the twin is by
reflection.

Parent twin. With SHAPE V6.1.2, twins may be derived from other twins, not just the
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main crystal. This should simplify entry of many multiple twins. All twins must still be
identical, and have a common center point at the origin (see the Lamellar Albite Twins
example for methods of doing lamellar twins which do not have a common center).

Note that the number required here is the twin operator number, which is O for the main
crystal, 1 for thefirst twin, and so on. After calculation, the crystals are numbered 1 for
the main crystal, 2 for the first twin, and so on - if you click with the mouse on a crystal,
you will get the crystal number, not the twin operator number.

3.2.3.5.2 Twin Operator (Cartesian)
Dialog Box: Twin Operator (Cartesian) [ Twins Dialoqg]

<Cartesian Mode - see also Twin Operator (standard)>

A twin operator may be either reflection on arational plane or rotation on arational
vector. Normal twins according to the system commonly used for feldspars should be
entered as reflection twins, giving the indices of the composition or twin plane. For
parallel twins enter the indices of the twin axis as the twin operator.

Indices will be normalized to length one.

For rotation twins, the rotation angle is normally an integral fraction of 360 degrees. A
rotation angle is not needed for reflections twins - the angle will be set automatically to
180.

Note that composition planes must always be entered separately, even if the twin is by
reflection.

3.2.3.5.3 Composition Planes
Dialog Box: Composition Planes [ Twins Dialoqg]

Thislists all the composition planes. Note that each composition plane is added to every
twin individual - i.e. the composition planes are added before the main crystal is
reproduced.

Compositions planes aways pass through the center of the crystal - the central distanceis
zero.

Clicking on Add or Revise, or double-clicking on an individual entry takes you to the
Composition Plane dialog (Standard or Cartesian) for entry or revision of datafor
individual composition planes
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3.2.3.5.4 Composition Plane
Dialog Box: Composition Plane [ Composition Planes dialog]

<Standard Mode - see also Composition Plane (Cartesian)>

The composition plane may be an indexed rational plane, or it may be the rhombic
section. Rhombic sections must correspond in sequence number to atwin rotation axis
entered in the Twin Operator dialog. That is, if arhombic section is the second
composition plane, the second twin operator must be atwin axis to which this rhombic
sectionisto be parallel. If the composition planeis not arhombic section, it need not be
parallel to any twin axis.

Y ou should be aware that in rotation twins the two individuals may not match across the
composition plane, even if the composition plane is parallel to the twin axis. If the
composition plane is arhombic section, it will pass through identical sections of the two
crystalsin terms of unit-cell geometry, but the faces may not match if they are not those
of the unit cell.

3.2.3.5.5 Composition Plane (Cartesian)
Dialog Box: Composition Plane (Cartesian) [ Twins Dialog]

<Cartesian Mode - see also Composition Plane (standard).>

The composition plane may be an indexed rational plane, or it may be the rhombic
section. Rhombic sections must correspond in sequence number to atwin rotation axis
entered in the Twin Operator dialog. That is, if arhombic section is the second
composition plane, the second twin operator must be a twin axis to which this rhombic
sectionisto be paralel. If the composition planeis not arhombic section, it need not be
parallel to any twin axis.

Y ou should be aware that in rotation twins the two individuals may not match across the
composition plane, even if the composition planeis parallel to the twin axis. If the
composition plane is arhombic section, it will pass through identical sections of the two
crystalsin terms of unit-cell geometry, but the faces may not match if they are not those
of the unit cell.

3.2.3.6 Epitaxial Crystals
Dialog Box: Epitaxial Crystals [ Inputl Menu]

This option allows many complicated intergrowths of different crystals, aswell as off-
center twins, to be drawn. In epitaxial intergrowths, in principle aface of one crystal lies
on aface of another crystal, either of the same or a different species. The mutual
orientation must be further specified by the vectors within the faces which are parallel.
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Although the mutual orientation is described in terms of the faces, the crystals may after
aperiod of growth be interpenetrating, or one may partially or completely enclose the
other. In practice the "face-on-face" relation may only specify the mutual orientation, not
position, and this option can be used to draw crystals with amost any kind of relation.

There are four ways to generate an epitaxial guest crystal: you can Duplicate the
selected crystal; you can Add anew crystal with manual entry of the symmetry and
forms; you can Read from File (that isfrom a.SHP datafile); or you can Import an
externd file.

If you choose the Read from File option, the file in question must have been saved by
SHAPE for Windows or in the ASCII "exchange" format with SHAPE for DOSV4.2. If
you duplicate or read from afile, you will be transferred immediately to the

Epitaxial Relations dialog.

To Import an epitaxial crystal, go directly to the Import option in the File menu (instead
of thisdialog). When the file has been read, you will be transferred immediately to the
Epitaxial Relations dialog.

The host crystal is aways crystal number 1; thus epitaxial guest crystals are always
numbered from 2 upwards.

Orientation of crystals through epitaxial relationships involves a series of complex
operations and isinherently less precise than orientation with twin operations.
Occasiondly, errorsin drawing may result from thislack of precision. Twin operations
should be used instead of epitaxy whenever possible to generate intergrowths.

Intercrystal edges arelocated only once during the calculation, after al crystals have
been oriented and trandated. If there are any crystal which actually do interpenetrate
with one another, this box should be checked. If all epitaxial crystals are of the contact
variety, it may be unchecked.

3.2.3.6.1 Epitaxial Relations
Dialog Box: Epitaxial Relations [ Epitaxial Crystals Diaog]

<Standard Mode - see also Epitaxial Relations (Cartesian)>

The are basically three groups of information that must be supplied for each epitaxial
crystals. At thetop of the dialog isthe type of contact geometry.

Contact adds a contact plane, with the same indices as the guest alignment face (see
below), similar to the composition plane of atwin, to the guest crystal at a specified
central distance; if you select this option the distance should be entered in the box below
the host and guest indices. When the guest crystal isfirst generated, there may or may
not be a crystal face with theseindices; if thereis, the central distance for the epitaxial
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plane should be less than that of the normal crystal face. That is, the epitaxial contact
plane should truncate the guest crystal, not sit off in space. After the guest crystal is
generated, it is rotated and translated so as to contact the host crystal on the specified
faces. The specified alignment face of the host crystal should be one which is actually
present; otherwise you will get an error message.

Inter penetration does not add a contact plane or try to match faces by trandlation. It
simply establishes the mutual orientation and sets the crystals at a specified center-to-
center distance. Thisdistanceisin central distance units and should be entered in the box
below the host and guest indices. The host crystal remains at the center and the center of
the guest is displaced to the specified distance along the perpendicular to the epitaxial
face.

In the middle of the dialog, you must specify the orientations of the host and guest
crystals, by giving theindices of aface (khl) and avector [uvw] parall€l to this face for
the host and for the guest. The face and the vector of the guest will be brought parallel to
the corresponding elements of the host. If the vector is not parallel to the face, you will
get an error message, and be asked to try again. A vector parallel to aface satisfies the
relationuh +vk + wl =0.

Note that if the host and guest crystals are the same, and you enter the same face and
vector for each, thetwo crystals are not in parallel orientation. Rather they areintwin
orientation, related by rotation of 180 degrees around the alignment vector. Parallel
orientation is attained by giving for the face on the guest crystal, the negatives of the
indices for the face on the host crystal.

Y ou have the option of specifying translations in addition to that parallel to the
intercrystal vector. Movement can be made in either of two mutually perpendicular
directions, specified with respect to the epitaxial plane on the host crystal: 1) parallel to
the vector in this face which was used to orient the crystal; and 2) perpendicular to this
vector, still in the plane of the face. Displacements are specified in central distance units.
A right-handed system isformed by 1) the host-crystal vector; 2) the alignment vector in
the host crystal face; and 3) the vector perpendicular to the alignment vector in the
crystal face.

In the lower part of the dialog, enclosed in two boxes, are the data for the guest crystal.
If the current epitaxial crystal isaduplicate of another crystal or has been read in from a
file, these datamay already be present; if not, you will have to click on the Revise
Title/Axes, Revise Symmetry and Revise Forms buttons to enter these data. The
dialogs called up are the same as those for entry of the main crystal, i.e.

Title/Axes, Symmetry and Forms List. You must always use these buttons to modify
epitaxial crystals - when called from the I nputl menu, the Title/Axes, Symmetry and
Forms List only modify the main or host crystal.
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Clicking on the Rescale button will change all the central distances of the guest crystal
by the factor entered in the Rescale factor box. This does not affect the distance
entered for a contact plane.

3.2.3.6.2 Epitaxial Relations (Cartesian)
Dialog Box: Epitaxial Relations (Cartesian) [ Epitaxial Crystals Dialog]

<Cartesian Mode - see also Epitaxial Relations (standard)>

The are basically three groups of information that must be supplied for each epitaxial
crystals. At thetop of the dialog isthe type of contact geometry.

Contact adds a contact plane, with the same indices as the guest alignment face (see
below), similar to the composition plane of atwin, to the guest crystal at a specified
central distance; if you select this option the distance should be entered in the box below
the host and guest indices. When the guest crystal isfirst generated, there may or may
not be a crystal face with theseindices; if thereis, the central distance for the epitaxial
plane should be less than that of the normal crystal face. That is, the epitaxial contact
plane should truncate the guest crystal, not sit off in space. After the guest crystal is
generated, it isrotated and translated so as to contact the host crystal on the specified
faces. The specified alignment face of the host crystal should be one which is actually
present; otherwise you will get an error message.

Interpenetration does not add a contact plane or try to match faces by trandlation. It
simply establishes the mutual orientation and sets the crystals at a specified center-to-
center distance. Thisdistanceisin central distance units and should be entered in the box
below the host and guest indices. The host crystal remains at the center and the center of
the guest is displaced to the specified distance along the perpendicular to the epitaxial
face.

In the middle of the dialog, you must specify the orientations of the host and guest
crystals, by giving the indices of aface (khl) and avector [uvw] parallel to thisface for
the host and for the guest. The face and the vector of the guest will be brought parallel to
the corresponding elements of the host. If the vector is not parallél to the face, you will
get an error message, and be asked to try again. A vector parallel to aface satisfies the
relationuh + vk + wl = 0.

Note that if the host and guest crystals are the same, and you enter the same face and
vector for each, the two crystals are not in parallel orientation. Rather they areintwin
orientation, related by rotation of 180 degrees around the alignment vector. Paralel
orientation is attained by giving for the face on the guest crystal, the negatives of the
indices for the face on the host crystal.

Y ou have the option of specifying translations in addition to that parallel to the
intercrystal vector. Movement can be madein either of two mutually perpendicular
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directions, specified with respect to the epitaxial plane on the host crystal: 1) parallel to
the vector in this face which was used to orient the crystal; and 2) perpendicular to this
vector, still in the plane of the face. Displacements are specified in central distance units.
A right-handed system isformed by 1) the host-crystal vector; 2) the alignment vector in
the host crystal face; and 3) the vector perpendicular to the alignment vector in the
crystal face.

In the lower part of the dialog, enclosed in two boxes, are the data for the guest crystal.
If the current epitaxial crystal isaduplicate of another crystal or has been read in from a
file, these datamay already be present; if not, you will have to click on the Revise
Title/Axes, Revise Symmetry and Revise Forms buttons to enter these data. The
dialogs called up are the same as those for entry of the main crystal, i.e.

Title/Axes, Symmetry and Forms List. Y ou must always use these buttons to modify
epitaxial crystals - when called from the I nputl menu, the Title/Axes, Symmetry and
Forms List only modify the main or host crystal.

Clicking on the Rescale button will change all the central distances of the guest crystal
by the factor entered in the Rescale factor box. This does not affect the distance
entered for a contact plane.

3.2.3.7 Sections and Growth Zones
Dialog Box: Sectionsand Growth Zones [ Inputl Menu]

In the Section/Zoning mode, a section is drawn through the current crystal or crystals,
parallel to the screen or paper (observer x = constant). Sections and growth zones are
shown only when the Display mode, in the M odes menu, is set to Section/Zoning.
This dialog and the sub-dialogs it controls set the parameters for sections and growth
Zones.

The radio buttons at the top give the choice between the two main modes. Single section
outline, whichisuseful for identifying the orientation of acrystal in a section of rock or
other material; and Growth zones, which plots repeated sections at intervals according
to various growth models. The Growth Zone Settings button brings up another dialog
for additional growth zone settings.

A section, whether single or repeated as growth zones, is taken parallel to they and z
observer axes (see Coordinate Systems), at the x coordinate specified in the Section
height box. This coordinate should not be larger than the dimension of the crystal in the
x direction, or nothing will be shown.

In the non-fixed scaling modes (see Scaling), you can scale the Section only to occupy
the viewing area, or you can include the entire crystal (All corners). Typicaly the latter
modeis used if you are displaying adrawing of the crystal aong with the section.
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The coordinates of section corners can be listed to afile and/or to a Text window.

The colors, b/w patterns and pens can be specified for the different types of edges shown
in a section; these colors are different from the the standard colors for edgesin the
Line Colors and Line Patterns and Pens dialogs in the Input2 menu.

With the Add button you can add edges representing the current section to the drawing
of the crystal asawhole. The crystal can then be rotated to better show the orientation of
the section. These edges disappear the next time the crystal isrecalculated. You must
replot after exercising this option.

Some basic facts and terminology must be understood in order to be able to use the
suboptions for growth zoning.

The lines which appear in a section plot, or section edges, are the intersections of crystal
faces with the section plane. If such aline of intersection isnot also an exterior crystal
edge, the resulting line will be called aone-faceedge. If itisacrystal edge, then the
result is atwo-face edge, since the two faces intersect the section plane along thisline.

A sector isideally apyramidal polyhedron which has one external face at its base, and
the center of the crystal at its apex. If growth rates are not constant with time, faces and
therefore sectors may be created or annihilated, and the geometry may be more complex,
but a sector is aways defined by asingle crystal face. If the growth islinear, a section
through the crystal center will show a sector as atriangular area, and if growth zones are
drawn, there will be lines parallel to the crystal face. However, if atriangular area
passing through the center is bounded on the outside of the crystal by atwo-face edge,
the area observed is not a sector, but the boundary between two sectors - those defined by
the two faces which intersect at the edge.

In idealized drawings such as those made by SHAPE, specia relations are very common
because of symmetry and default setting geometry. In particular, the section often passes
through the exact center, and two-face edges may often be seen. Inrea sections of
crystalsin rocks or synthetic materials, which are usually random with respect to height
of the section and orientation of the crystal, relationships are in general less special and
more complex; two-face edges are less common, and sectors and sector boundaries are
very seldom seenin their entirety.

3.2.3.7.1 Growth Zone Settings
Dialog Box: Growth Zone Settings [ Sections and Growth Zones Dialog]

Growth model radio buttons. There are three basic growth models; linear, exponential
and discontinuous. The last two are considered to be non-linear. For linear growth, the
rates are derived from the central distances, and the valuesin the Total time and Time
interval boxes (below) are not used.
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Linear growth. If the growthislinear (rates constant with time), and a single crystal or
simpletwins are being drawn, the calculation of zonesissimple. The final shape of the
crystal istaken to be specified by the central distances entered in the Forms List dialog
(Inputl menu), and it does not have to be recalculated; it is simply rescaled for each
successive zone, the scale factors being determined from the Number of zones.

If multiple epitaxial crystals are being drawn, the entire cal culation must be repeated for
each zone, asfor non-linear growth below. Each crystal attains the size determined by
the central distance of itsforms. The main crystal doesthisintotal time 1.0 - it always
has start time 0.0 and end time 1.0. The start and end times of the epitaxial crystals (see
Start button below) are given relative to the main crystal. If an epitaxial crystal isgiven
anegative start time, or an end time greater than one, the total growth interval will be
extended appropriately.

Non-linear growth. If the growth is by either the exponential or discontinuous models,
the increment to the central distance for each form is calculated from the Timeinterval ,
using either the Rate Constants in the exponential model or the rates entered for each
interval using the Intervals button. The growth of the main crystal starts at time zero, and
ends at the Total time specified in the edit box. For epitaxial crystals, each epitaxial
crystal starts and ends at the time specified using the Times button at the bottom of the
dialog. Asinthe case of linear growth, the start and end of the growth process will be
extended if epitaxial crystals start before or end after the main crystal. However, the start
and end times for non-linear growth are absol ute (in whatever units you may be using).

The non-linear method, i.e. repetition of the entire calculation for each zone, is aways
used for epitaxial intergrowth, evenif the Linear growth model is selected.

When you click on either the Rate Constants or the Intervals button, you are first
presented with the Forms List for Growth-Rate Constants dialog. Thissimply givesa
list of the current forms, for each of which you must specify or confirm the rate
constants. Selecting aform from that dialog then presents you with the

Exponential Growth-Rate Constants dialog for exponential growth, or the

Growth Intervals dialog for discontinuous growth. See help for these dialogs for further
information on growth-rate parameters

For proper drawing of epitaxial crystals, the box for Intercrystal edges in the Epitaxial
Crystals dialog should usually be checked. Similarly, for interpenetration twins specify
the option with intercrystal edges.

When using scaling options (1) or (2) in the Scaling dialog (Input2 menu), itis
impossible to scale a non-linear growth-zone drawing before it is completed. However,
the overall scale factor for the next calculation is obtained from the last zone. Thusit
may be necessary to repeat the calculation with the Calculate command in the File
menu, or the Calculate button in the Dialog Bar - Left to get proper scaling. If you are
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using scaling option (3)- Fixed in./cm. per central distance unit, it isup to you to insure
that the drawing does not go off scale.

Linear: number of zones. Inlinear growth, the crystal will be divided into zones
representing equal increments of growth time. Strictly speaking, this number of zones
applies only to the host in epitaxia intergrowths; see Times below for the number of
zones for guest crystals.

Non-linear: Total time. Thisisthe end time for the main or host crystal if epitaxial
crystalsare present. Epitaxial guest crystals may actually start before the zero time or
after the end or total time for the host crystal - see Times below. Thetime unitis
arbitrary and may be considered to be seconds, hours or any other appropriate unit.

Non-linear: Timeinterval. An entire calculation will be carried out, and a zone drawn,
for each interval.

Marker zones. If you are using wide linesto fill in the growth sectors (see Filling
Sectors below), you can insert marker zones of a contrasting color at specified intervals,
to show the orientation of growth and the relative rates.

Sector boundaries. If thisbox ischecked, lines are drawn connecting cornersin the
section which are defined by the same combinations of faces. If aface appears or
disappears on a corner between zones, no line is drawn, since this changes the identity of
the sector boundary. If you find that too many sectors are thus undefined, the solution is
to increase the Number of zones for linear growth, or decrease the Timeinterval for
non-linear growth (see Filling Sectors below).

Pause after each zone. If thisbox is checked, the calculation will pause after the
appearance of each zone outline. Pressing any key will cause the next zone to plot.

Colorsfor one-face edges. In section, growth sectors are defined by one-face edges
(see Sections and Growth Zones). All these edges may be given asingle or default color,
or you may specify acolor for each form, so that sectors may be more easily correlated
with external forms. Two-face edges always have the colors specified in the sub-dialogs
called withthe Line Colors and Patter ng/Pens buttonsin the

Sections and Growth Zones dialog.

Epitaxial crystals- start and end times (Start Button). This allows epitaxial guest
crystalsto start or end growth at different times relative to the host crystal. For linear
growth, the times specified are relative to the main crystal; that is values of 0.0 and 1.0
mean that the epitaxial crystal in question (numbered starting with two for the first guest
crystal) starts and ends at the same time asthe host. Vaues of 0.5 and 1.5 mean that the
guest crystal starts at half the Total time and ends at half again the Total time after the
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host crystal has ended.

For linear growth, epitaxial guest crystals reach the full size specified by the central
distances of their formsin the time allotted (end minus start), and thus the number of
zones will be less than that specified in the Number of zones box if the total time (end
minus start) for this crystal islessthan one.

For non-linear growth the times are absol ute, in whatever time units are currently being
used. The ultimate size of each crystal and number of zones is determined by the
growth-rate equations.

Filling Sectors. To minimize the problem of undefined sector boundaries, and to make
it easier to identify sectors, it may be desirable to make the section lines so close together
asto touch or amost touch. This can be done by increasing the Number of zones for
linear growth or decreasing the Timeinterval for non-linear growth; it is made easier by
increasing the width of the lines (Line Attributes dialog in the Input2 menu). If the
sectors are completely filled in, Marker zones may be used to show the orientation of
the growth.

3.2.3.7.2 Colors for Sections and Growth Zones

Dialog Box: Colorsfor Sectionsand Growth Zones |
Sections and Growth Zones Dialog ]

These are colors which only appear when the Display mode (Modes menu) is set to
Section/Zoning. Seethe Sections and Growth Zones dialog for further definitions of
terms.

One-face edges arethe intersections of single crystal faces with the section plane. The
same color isused for front section edges (visible edges) when the section edges are
added to anormal view of the crystal with the Add button in the

Sections and Growth Zones diaog.

Two-face edges arethe intersections of crystal edges with the section plane. That is, the
crystal edgeliesin and is paralle to the section plane.

Sector boundaries. These lines are drawn between section cornersinvolving the same
faces. They may be undefined when the morphology of a section changes.

Back edges are the back section edges (invisible edges) when the section edges are
added to anormal view of the crystal with the Add button in the
Sections and Growth Zones diaog.

Marker zones arelines which may be added (actually, substituted for the section edges)
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at specified intervals to growth zoning, especially when wide lines are being used to fill
in sectors.

3.2.3.7.3 Line Patterns and Pens for Sections

Dialog Box: LinePatternsand Pensfor Sectionsand Growth Zones |
Sections and Growth Zones Dialog ]

These are colors which only appear when the Display mode (Modes menu) is set to
Section/Zoning. See the Sections and Growth Zones dialog for further definitions of
terms.

One-face edges arethe intersections of single crystal faces with the section plane. The
same color isused for front section edges (visible edges) when the section edges are
added to anormal view of the crystal with the Add button in the

Sections and Growth Zones diaog.

Two-face edges arethe intersections of crystal edges with the section plane. That is, the
crystal edgeliesin and is parallé to the section plane.

Sector boundaries. Theselines are draw between section corners involving the same
faces. They may be undefined when the morphology of a section changes.

Back edges are the back section edges (invisible edges) when the section edges are
added to anormal view of the crystal with the Add button in the
Sections and Growth Zones diaog.

Marker zones are lines which may be added (or actually substituted for the section
edges) at specified intervalsto growth zoning, especially when wide lines are being used
to fill in sectors.

3.2.3.7.4 Exponential Growth-Rate Constants

Dialog Box: Exponential Growth-Rate Constants [ FormsList Dialog] |
Forms List for Growth-Rate Constants Dialoq]

If the exponential growth model is specified in the Growth Zone Settings dialog, arate
eguation, in terms of central distance units and any time units desired, must be specified
for each form. The equation is exponential in form:

rate = al + a2 t"b2 + a3 t"b3 + a4 t"\b4

wheret istime. Most continuous functions can be approximated by an equation of this
form with a MacLaurin expansion. The coefficients of the equation must be specified for
each form; the forms are listed in sequential order, ignoring the crystal to which they
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belong in the case of epitaxial intergrowths. Asadefault, the al coefficient is ssimply
taken to be the central distance; that is, the default is alinear rate which gives the same
crystal shape as that specified by the original central distances, when total timeis 1.0.
Other a coefficients are set to zero. The default values for b2 through b4 are one, two
and three respectively (b1 is not used).

Appearance and disappearance of formsin non-linear growth. In either the exponential
or discontinuous models, forms may appear and disappear during growth. If the growth
rate of aformisso large that it does not appear on acrystal after agiven interval, its
central distance is adjusted so that it lies just outside the current corners and edges.
When the current growth rate for aform is sufficiently small relative to the other forms
over agiven growth interval, that form will appear, regardless of how large its rate may
have been in previous growth intervals. Thus the central distance of aform isnot the
integral of the rate equation, if the form does not appear for any time.

3.2.3.7.5 Growth Intervals

Dialog Box: Growth Intervals [ FormsList Dialog] [ FormsList for Growth-
Rate Constants Dialog]

In the discontinuous growth model, the total growth timeis divided into intervals for
each form, with a different constant growth rate for each interval. Zeroisapossible
growth rate. Two constants must be given for each interval, for each form; the Growth
rate andthe End time. Thefirst interval starts at the start time for the crystal (whichis
zero for the main crystal, but may be less than zero for epitaxial crystals), and succeeding
intervals start at the end of the previousinterval. These times are absolute, although the
main crystal always starts at time zero. Sixteen intervals are alowed for each form (but
see the README file for the latest number).

Appearance and disappearance of formsin non-linear growth. In either the exponential
or discontinuous models, forms may appear and disappear during growth. If the growth
rate of aform isso large that it does not appear on a crystal after agiven interval, its
central distance is adjusted so that it lies just outside the current corners and edges.
When the current growth rate for aform is sufficiently small relative to the other forms
over agiven growth interval, that form will appear, regardless of how large its rate may
have been in previous growth intervals. Thus the central distance of aformisnot the
integral of the rate equation, if the form does not appear for any time.

3.2.3.7.6 Forms List for Growth-Rate Constants

Dialog Box: FormsList for Growth-Rate Constants |
Growth Zone Settings Dialog]

Thisdialog gives alist of the current forms, for each of which you must specify or
confirm the rate constants. Selecting aform and clicking on the Revise button then
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presents you with the Exponential Growth-Rate Constants dialog for exponential growth,
or the Growth Intervals dialog for discontinuous growth, depending on the
exponential/discontinuous setting in the Growth Zone Settings dialog. See help for these
dialogs for further information on growth-rate parameters.

3.2.3.7.7 Start and End Times for Epitaxial Crystals

Dialog Box: Start and End Timesfor Epitaxial Crystals
[ Growth Zone Settings Dialog]

This allows epitaxial guest crystalsto start or end growth at different times relative to the
host crystal. For linear growth, the times specified are relative to the main crystal; that
isvaues of 0.0 and 1.0 mean that the epitaxial crystal in question (numbered starting
with two for the first guest crystal) starts and ends at the same time as the host. Values
of 0.5 and 1.5 mean that the guest crystal starts at half the Total time and ends at half
again the Total time after the host crystal has ended.

For linear growth, epitaxial guest crystals reach the full size specified by the central
distances of their formsin the time allotted (end minus start), and thus the number of
zones will be less than that specified in the Number of zones box if the total time (end
minus start) for this crystal islessthan one.

For non-linear growth the times are absol ute, in whatever time units are currently being
used. However, the host crystal of epitaxial intergrowths always starts at time zero, so
timesfor guest crystals may be negative. The ultimate size of each crystal and number of
zones is determined by the growth-rate equations, constants for which are specified in the
Exponential Growth-Rate Constants dialog for exponential growth, or the

Growth Intervals dialog for discontinuous growth.

3.2.3.8 Face or Form Fills
Dialog Box: Faceor Form Fills [ Inputl Menu]

Thisdialog lists the current face and/or form fills.

Clicking onthe Add or Revise buttons calls up the Face or Form Fill Data dialog
(Standard or Cartesian).

Show crystal edges . If thisbox is checked (the default), crystal edges are shown with
the normal colors (Line Colors and Line Patterns and Pens dialogsin the Input2 menu);
if not, edges are not drawn. This checkbox has no effect if there are no fills or shading.
Back edges should be set to None in the Line Attributes dialog (Input2 menu).

The Fill all Forms button will use the current form colors, set in the Face or Form Fill
Data dialog (Standard or Cartesian).
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Note that Shading (Inputl menu) takes precedence over fills. Y ou can turn shading on
or off without affecting fills.

3.2.3.8.1 Face or Form Fill Data
Dialog Box: Faceor Form Fill Data [ Faceor Form Fills Dialog]

<Standard Mode - see also Face or Form Fill Data (Cartesian)>.

Specify the indices, face/form, color and b/w pattern number for each fill in this dialog.

Y ou can specify the crystal number for intergrowths; if this number is zero, all faces or
forms with the given indices will befilled. SHAPE currently has hidden line removal
algorithms (for multiple crystals), but these do not apply to faces, so it is not able to sort
out the overlapping relations among faces of interpenetrating crystals, so fills are not
generally satisfactory in interpenetration intergrowths. They may be successful in
contact intergrowths, but only if part of one crystal is not hidden by another.

3.2.3.8.2 Face or Form Fill Data (Cartesian)
Dialog Box: Faceor Form Fill Data (Cartesian) [ Face or Form Fills Dialog]

<Cartesian Mode - see also Face or Form Fill Data (Standard) >

Specify the indices, face/form, color and b/w pattern number for each fill in this dialog.

Y ou can specify the crystal number for intergrowths; if this number is zero, all faces or
forms with the given indices will befilled. SHAPE currently has hidden line removal
algorithms (for multiple crystals), but these do not apply to faces, so it is nhot able to sort
out the overlapping relations among faces of interpenetrating crystals, so fills are not
generally satisfactory in interpenetration intergrowths. They may be successful in
contact intergrowths, but only if part of one crystal is not hidden by another.

3.2.3.9 Shading
Dialog Box: Shading [ Inputl Menu]

Single crystals can be shaded in color or black and white. Shading isnot likely to be
successful in intergrowthsif one crystal hides the faces of another. Except for the
illumination vector, this dialog does not apply to the 3D mode - the separate settings for
that mode are in the 3D Parameters dialog in the Input2 menu.

[llumination vector . Shading is based on the cosine of the angle between the normal to
the face in question and the illumination vector. This vector points toward the light
source. Any units can be used when entering the vector, but it will always be normalized
to length one.
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Darkest shade (fraction). This option "softens’ the shading by allowing the presumed
illumination of the darkest zone to be other than zero. Small values of this fraction, such
as0.1or 0.2, areusually appropriate. I1tis0.0 by default.

Darkness angle (degrees). For anisolated object in a vacuum, the intensity of
illumination should vary from maximum to minimum as the angle varies from 0 to 90
degrees. However, thiswould be avery "hard" illumination, and SHAPE alowsfor a
"softening” or diffusing of the illumination in two alternative ways, by darkness angle or
by darkest shade. The darkness angle, or the angle at which the illumination becomes
zero or minimal, can vary from 90 to 180 degrees.

Color. If shading isto be shown on a 24-bit or other unrestricted device, you can select
any RGB color. However, for compatibility with arange of devicesit isbest to use
simple colors, starting with the first 8 colors (excepting black) in the standard Palette. 1f
the face color is the same as the back edge color (Line Colors), and if back edges are
enabled (Line Attributes), there may be an illusion of transparency.

Palette settings for 256-color display. SHAPE can set up the palette for 8-bit or 256-
color displaysin either of two ways. The primary palette (see the Palette dialog in the
Settings menu) has 16 colors, which are always available for lines. Each of these,
except black, can be used as the basis for 16 color zones, shading towards black; or
colors 1-7 can each be used as the basis of 32 zones. If you select 16 zones, you can
select any of the 15-non-black colorsin the Palette with the Select Color button. If you
select 32 zones, which generally gives better results for crystals with many faces, the
only colors which can be shown are 0-7. If you select any of colors 8-15, they will be
forced to one of the colors 0-7. Black, number O, will not be shaded.

Multiple crystals . In many cases shading is incorrect for multiple crystals, especially for
interpenetration intergrowths - the standard method of drawing is designed mainly to
draw edges, not surfaces. There are liable to be problems with shading whenever the
Remove Hidden Lines option (Display menu) isused. The 3D display mode avoids all
problem of this sort.

3.2.3.10 Striations
Dialog Box: Striations [ Inputl Menu]

Striations are evenly spaced lines on the faces of the given form. These lines are drawn
parallel to an actual edge.

Striations are often useful in showing crystal symmetry which islower than that of the
form exhibited. For example, pyrite, group mB3, often grows in cubes, which have the
full symmetry of group m3m. However, striations on the cube faces are often present,
which bring out the fact that 4-fold axes are not present.
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A maximum of 20 forms (not faces) may be striated.

The specifications for striations on individual forms are in the Striation Data dialog,
which is accessed with the Revise or Add Striation buttons.

Randomize . This causes the striations to be randomly dashed lines - it does not
randomize the spacing of the striations. The Max. line parameter is the maximum
length of the solid segments, while Max. interval isthe maximum length of the blank
interval between solid segments. Both solid and blank segments are randomized in
length within these intervals. Lengthsarein central distance units (c.d.u.), i.e. the same
arbitrary units as the central distance for the forms.

Striationsin 3D mode are always lines, not cylinders.

3.2.3.10.1 Striation Data
Dialog Box: Striation Data [ Striations dialog]

Striations are defined by giving the indices of aface belonging to the form which isto be
striated, and the indices of a face which makes an actual edge with thefirst face. This
edge is the striation direction.

The spacing of thelinesisin central distance units (c.d.u.), i.e. the same arbitrary units as
the central distance for the forms.

Striations will be applied to all faces of the form. For twins or epitaxial intergrowths, the
number of the individual may be specified, or avalue of zero in the Crystal No.
(number) box will apply the striationsto all individuals. Of coursein epitaxial
intergrowths the two specified faces may not exist on al crystals, which will result in an

error message.
3.2.3.11 Interfacial Angle
Dialog Box: Interfacial Angle [ Inputl Menu]

Thiswill calculate the angle between the normals to any two faces. After entering the
indicesfor face 1 and face 2, the Get Angle button will cause the angle to appear at the
botton of the dialog.

Note that the angle between the last two faces clicked is automatically given when in the
Indexing or Face | dentification cursor mode.

3.2.3.12 Donnay-Harker Morphology
Dialog Box: Donnay-Harker Morphology [ Inputl Menu]
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This option will give alist of formswith central distances as afunction of X-ray d-
spacing or relative reticular area.

According to the Law of Bravais, later extended by Donnay and Harker, the
morphological importance of aformisinversely related to the interplanar spacing, or X-
ray d-spacing. Since the d-spacings depend on the presence of non-primitive Bravais
|attices, screw axes and glide planes, it is necessary to know the space group as well as
the unit-cell parameters.

Thisrelationship is essentially empirical, and the quantitative relationship between d-
spacing and growth rate is difficult to establish. Analysis of the equation for growth rate
by the surface-nucleation mechanism (E. Dowty, "Crystal Growth and Nucleation
Theory", in R.B. Hargraves, Ed. , Physics of Magmatic Processes), suggests a
relationship of the form

R=kldexp(-k2d)

where k2 isinversely proportional to the supersaturation (or supercooling in the case of
growth from the melt). Of course thisis agreat simplification, and ignores the influence
of different surface energy on different faces.

For small values of k2, corresponding to large supersaturation or rapid growth, the rate of
growth may show a maximum as a function of d-spacing. For the mechanism of growth
by the spiral dislocation mechanism, there is apparently no inverse dependence of growth
rate on d-spacing, rather the principal influence seems to be surface energy (included in
k2 in the above equation). Thusthe Bravais/Donnay-Harker law seemsto apply to slow
growth by the surface-nucleation mechanism, and adherence to this law is not expected
in all cases, particularly rapid growth in the laboratory.

SHAPE offers the choice of three functions for the dependence of growth rate or central
distance on d-spacing; a ssmple inverse dependence (R = 1/ d), the above exponential
relation, and the above relation without the d in the pre-exponent.

The function (R = 1/d) has special consequences, in that it necessarily causes some faces
to lie exactly on cornersor edges. For example, in the orthorhombic group mmm , the
first-ranked forms are { 100}, {010}, and { 001} - these are the only forms which appear
as actual faces. However, the faces of forms {110}, {101} and {011} lie exactly on the
edges and those of form {111} lie exactly on the corners. The faces of these forms
appear in the listings for each corner, which may cause confusion. Because of the finite
precision of the calculation, there may sometimes be extra corners or other anomalies
(see Precision, Tolerances, etc. )

Whichever relation is chosen, SHAPE generates a set of hkl form indices consistent with
the symmetry. The forms are sorted according to the growth rate or central distance, and
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normalized to the smallest growth rate. Thislist of formswill replace any forms
currently present.

The space group may be specified by typing in either the H-M (Herman-Maughin or
International ) symbol, the Hall symbol, or the number of the space group in the
International Tables for X-ray Crystallography . However, because of different
possibilities for origin and orientation, the best way to specify the space group is by
selection inthelist box. Thisselection is not entered until the selection is double-clicked
or the Select button is clicked.

SHAPE requires monoclinic crystals to be in the second setting, i.e. unique or symmetry
axis b, rather than c. If you enter asymbol which does not explicitly give the orientation,
such as C2/c, the second setting will be assumed. Do not enter a symbol which does not
conform to this standard (such as P112/m)

It isimportant to realize that an empirical list of formsin order of morphological
importance for agiven crystal usually represents a statistical compilation, not atypical or
ideal morphology. To put it in another way, such compilations or observations are
usually based on frequency of occurrence of forms, rather than measurements of central
distance for any particular case, or averages of such measurements. While such alist
may have dozens of entries, actual crystalstypically show a small number, perhaps only
1 or 2for acubic crystal. Presumably theideal relative growth rates as predicted
theoretically on the basis of crystal structure and geometry alone are modified in each
case by environmental factors, such as composition of the growth fluid and overall
growth rate. The Bravais-Donnay-Harker list as derived by SHAPE should thus be
considered as aranking of formsin order of probability of occurrence.

Note that space groups in some trigonal, tetragonal and hexagonal point groups may have
alternate orientations of the symmetry elements with respect to the crystallographic axes

- for example P321 and P312 are different space groups. These differencesin orientation
are now included in the choices of point group in the Symmetry dialog, and it may be
necessary to change the point group or crystal classto agree with the space group.

Y ou may only make aD-H list of formsfor asingle crystal - if you use thisoption for an
epitaxial intergrowth, all crystals except the main one will be deleted. 1n order to apply
D-H morphology to an epitaxial crystal, you must do that crystal separately and save the
resultsin afile (Save or Saveas inthe File menu). Then that file may beread asa
second or subsequent crystal in the Epitaxy option (Inputl menu). Of courseitis
advisable to remove any forms which do not appear in the actual calculated crystal -
forms are marked as PRESENT or ABSENT in the Listing of calculation results (File
menu).
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3.2.4 Input2 Menu
Line Colors - Controls colors of front and back edges, etc. in color display or output.

L ine Patterns and Pens - Controls gray shades or patterns of front and back edges, etc. in
black-and-white display or output.

Line Attributes - Controls appearance of back edges, dashing and widths of lines.

Perspective - Controls drawing in perspective versus straight projection.

Backaground Color - Controls background color (ignored for b/w display or output).

Crystal Axes - Controlsdisplay of crystal axes.

Initial Orientation - Controls the orientation which isimposed after calculation and
beforefirst viewing.

Scaling - Controls scaling modes and factors.

Centering and Displacements - Controls displacements and automatic centering of the
image.

3D Parameters - Controlsthe 3D display mode, including display of symmetry
operators.

3.2.4.1 Line Colors
Dialog Box: LineColors [ Input2 Meny]

Back edges are those which are not visible if the crystal is opague.
Display of Crystal Axes iscontrolled by the Crystal Axes dialog in the Input2 menu.
Stereonet display is controlled by the Display command in the M odes menu.

Seethe Forms List dialog for the automatic addition of | maginary faces, edges and
cornersif the real faces do not define a closed shape.

3.2.4.2 Line Patterns and Pen Numbers
Dialog Box: LinePatternsand Pen Numbers [ Input2 Menu]

Back edges are those which are not visible if the crystal is opague.

Display of Crystal Axes iscontrolled by the Crystal Axes dialog in the Input2 menu.
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Stereonet display is controlled by the Display command in the M odes menu.

3.2.4.3 Line Attributes
Dialog Box: LineAttributes [ Input2 Menu]

Back edges - those not visible if the crystal isopaque - may be specified as none (not
shown at al), dashed or solid.

Dash length and dash ratio . The dashes are used for back edges of crystals and display
of Crystal Axes. Length or repeat distance isin inches/centimeters, and the length factor
isthe actual length of the solid part divided by the repeat distance. Note that when using
Frames in output the dash length remains the same - it may be desirable to decrease the
length for very small plots.

Widths are specified in inches or centimeters (choice of unitsisin the Preferences dialog
in the Settings menu). Values of 0.0 will give one-dot width. Output pertainsto all
types of non-screen output except pen plot. Widths of pen plots can only be changed by
using different pens.

See also the Line Colors and Line Patterns and Pen Numbers dialogs.

3.2.4.4 Background Color
Dialog Box: Background Color [ Input2 Menu]

The best color for background may be neither white nor black - sometimes gray brings
out shading better. The background for black-and-white display and output is always
white.

3.2.45 Perspective
Dialog Box: Perspective [ Input2 Menu]

If perspectiveisnot in effect, or turned off, the drawing is simply a perpendicular
projection down the observer x axis. If perspective is on, the drawing is projected from a
point (x,0,0), where X is the perspective distance, onto the plane (0,y,2), that isa
horizontal plane passing through the crystal center. Scaling applies to this plane, but
obviously fixed scaling has limited intrinsic meaning in perspective drawing; generally
the scaling mode Each View Maximum (set in the Scaling dialog in the Input2 menu)
should be used when perspective isin effect.

The perspective distance is the distance x of the projection point from the projection
plane, or in other words the distance from which the crystal is viewed (distance from the
center of the crystal to the eye). Smaller distances will accentuate the " perspective”;
larger distances will cause the plot to appear more like a straight-on projection. The
perspective distance should be considerably larger than the distance of the furthest corner
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from the center (or the plane x=0) in the positive x direction.

3.2.4.6 Stereopair Angle
Dialog Box - called from: [nput2 Menu

When either 2D Stereopair, OpenGL Stereopair, OpenGL Quad Stereo or

Direct3D Stereo Drawing mode is selected, two images of the structure will be drawn.
The left or |eft-eye image will be rotated by the stereopair Rotation angle clockwise
from the normal orientation, and the right-eye image will be rotated the same amount
counter-clockwise. If shading is active the illumination vector will be rotated along with
the structure. The stereopair rotation angleistypically about 3 degrees, although the
proper angle may vary depending on the perspective distance, the actual viewing method,
etc.

If the hard copy of stereopairsisto be viewed directly or with asmall viewer, aframe
size in the dot-matrix or pen plot of 4 to 5 inches across will give a distance between the
two images about equal to the normal interocular distance.

Few people can directly view a stereo pair as shown on the full screen because the
images are considerably further apart than the eyes. However, if anegative rotation angle
is used, some people can view the image by crossing their eyes.

The two images are separated in the 2D Stereopair and OpenGL Stereopair but
superimposed by viewing hardwarein OpenGL Quad Stereo or Direct3D Stereo modes.

The rotation angle can also be set in the DialogBar - Right

3.2.4.7 Crystal Axes
Dialog Box: Crystal Axes [ Input2 Menu]

Y ou can superimpose crystal axes onto the drawing. Crystal axes cannot be drawn on
stereopairs.

The crystal axes are scaled initially to be about the same size asthe crystal. Thusthe
Scalefactor isinitialy 1.0. The axes are always shown in front of the crystal(s), except
in 3D mode. For hexagonal and trigonal (non-rhombohedral) crystals, the a3 axisis
plotted, although it is not listed in print-outs.

If the Include in scaling box is checked the displaced axes will be included in any
automatic Scaling or Centering operations (as selected in the Input1l menu).

The Displacements can be used to separate the crystal and axes, for exampleto put a
small axial crossin acorner of the drawing. Note that you can also move the crystal with
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the Centering and Displacements command in the Input2 menu or the Center button in
the Dialog Bar - Right . The Scale Grid can assist in these displacements.

If you click on the L ocate with Mouse button, the next click in the graphics window
will relocate the axes to that point.

Front-back displacement isused only in the 3D mode.

If perspective viewing is on, the axes are projected asif they intersected at the origin,
although they are drawn asif they were in front of the crystal.

If the Dashed box is checked, the c axisis shown solid, the b axisis dashed with the
dash intervals set in Crystal Edges dialog in the Input2 menu, and the aaxisis dashed
with half theseintervals. The crystal and the axes are projected independently, even if
they are separated by displacements - that is, if you are looking directly down the a-axis
direction in the crystal, you will aso be looking directly down the a-axisin the axial
Cross.

Labels can be added to the positive end of each axis. The Font for axislabelsisthe
same as that set in the face Labels dialog (Display menu). However, the size of the
letters may be different from that in face labels - thisis controlled by the Scale factor for
labels .

In the 3D display mode in Perspective, there may be slight errorsin the intersection of
the axes at very short perspective distances (less than 20).

3.2.4.8 Initial Orientation
Dialog Box: Initial Orientation [ Input2 Menu]

Any initial Cartesian rotations specified here will be be applied to the x, y and z crystal
Cartesian axes (see section IV-4) in that order after the faces, corners, etc. are located and
before the crystal isfirst displayed.

If the Clinographic viewing box is checked, the clinographic rotation (see

Coordinate Systems) will be applied at the end of the calculation, after any initial
Cartesian rotations. It may be turned off with the Clinographic Viewing command in the
Rotation menu (or the ClinographicViewing command in the Display menu).

When exiting, SHAPE checks to see if the orientation has changed from the initial
orientation defined in thisdialog. If so, you have the option of saving the current
orientation. This orientation will be converted into initial rotations on x, y and z, plus
initial clinographic viewing if that isin effect. Y ou can aso save the current orientation
with the Save/Recover Orientation dialog in the Rotation menu.
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Summary of orientation operations . SHAPE first setsthe c crystal axis parallel to the z
viewer axis, and thea * crystal axis (perpendicular tob and c) parallel tox. Thisisthe
original orientation. Next, theinitial Cartesian rotations, if any, are applied. Finaly,
the clinographic rotations, if selected, are applied. Thisistheinitial orientation.

Theinitial orientation might also be termed the "preferred” orientation, since thisisthe
one orientation which can be saved, and returned to with the Save/Recover Orientation
command in the Rotate menu.

3.2.4.9 Scaling
Dialog Box: Scaling [ Input2 Menu]

Scaling and displacement operations do not apply to the actual values of corner
coordinates and face coefficients, which are permanently set by axislengths and the
central distances of the faces. Rescaling and displacement apply only to the plotting
coordinates in screen, dot-matrix or pen-plotter displays.

Scalemode . There are three mode of scaling:

Maximize size for each view . In thismode, the crystal is scaled in each orientation so
that it isjust smaller than the viewing area. The actual scale will therefore change
whenever the crystal isrotated. Hard copy is scaled the same way and what you seeis
essentially what you get.

Universal maximum. Inthis mode, the crystal is scaled so that its maximum dimension
isjust smaller than the minimum dimension of the plotting areas; thus, rotations can be
made without changing the scale and without going out of bounds. Again, hard copy is
scaled the same way and what you see is essentially what you get.

Fixed scalefactors. This suboption allows you to set the scale to a fixed number of
inches or centimeters per central distance unit for the dot-matrix and/or pen plot, or
simply to reduce or enlarge the image from the automatic scaling modes.

The Rescale factor applies only to the Maximize... and Universal... modes. Both
these modes scal e the drawing to the dimensions of the screen (window) or the frame,
and then apply this rescale factor. When you click the up- or down-size (or "zoom")
button in the Dialog Bar - Right ), this changes the rescale factor unless you arein the
Fixed... scalingmode. (Thisisachangefrom pre-V6.0 SHAPE - formerly clicking one
of these buttons when in the Maximize... or Universal... modeswould switch to the
Fixed... mode.

Scaling for the screen and normal printer output (Print command in the File menu)
depends on the resol utions (dots per inch or centimeter), which are obtained from the
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software drivers for these devices. The correct scaling for a particular printer may not be
attained until you have used that printer for the first time. Resolution for the printer may
often be reset in the Print Setup dialog in the File menu. The resolution for the Pen
Plotter is set in the Pen Plotter Settings dialog, and that for adirect PostScript printer is
set in the Postscript Settings in the Settings menu.

The Dialog Bar - Right allows"zooming" or incremental adjustment of the scale
factors.

When displaying symmetry operatorsin the 3D mode, scaling in the Maximize size or
Universal maximum modesis based on the presumed maximum extent of symmetry
elements, which in turn are based on the maximum distance for corners - the ratios
governing therelative sizes of crystal and symmetry elements are set in the

3D Parameters dialog (Input2 menu). Thus the scaling for in the Maximize size mode
ispractically identical to that in the Univer sal maximum mode.

3.2.4.10 Centering/Displacement
Dialog Box: Centering/Displacement [ Input2 Menu]

Automatic centering will center the crystal in the current viewing area. Thisis done for
each view, and any displacements entered under Constant Displacements areignored.

In most cases, the easiest way to scale and position a drawing onto a printed or typed
page is to use the frame optionsin the Print command or other optionsin the File .
However, the displacementsin this section can be used to position the drawing within
the frame defined in those suboptions.

The displacements are used only in plotting and are not actually part of the corner
coordinates. Note that the center of rotation is not changed by these displacements - that
is, the crystal is always rotated about its own zero of coordinates. Thus any desired
rotations should always be made before using displacements.

The Dialog Bar - Right ( Display menu) allows incremental displacements, and
centering of the viewing area on a particular projection point in the crystal.
Displacements made there will affect the displacementsin this dialog
(Centering/Displacement ), and may be removed here.

The Scale Grid command in the Display menu is useful for showing the actual scaled
location of the crystal and in estimating displacements.

3.2.4.11 Reset Scaling/Centering
Dialog Box: Reset Scaling and Centering [ Input2 Menu ]

This dialog allows reversion to the Scaling and Centering/Displacement modes and settings in
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effect before various interactive changes, or selection of the default settings (Universal Maximum
scaling and Automatic centering).

Current makes the current settings permanent - after this these settings will be the "Last"
settings.

Last returns to the values set in the last calculation, or the last reset with this dialog. Current
settings are erased.

Default selects Universal Maximum scaling and Automatic centering, so the structure should
remain the same size and completely in view at all times.

Cancel will exit the dialog without any change - the current and last settings will be preserved.

You can always adjust the settings in the Scaling and Centering/Displacement dialogs in the
Input2 menu.

This dialog can be called from the DialogBar-Leftwith the Reset Scaling button.

3.2.4.12 3D Parameters

These parameters apply to VRML and POV-Ray filesaswell as 3D Drawing Modes
mode.

3.2.4.12.1 3D Display Modes

These drawing modes can be selected in the Display M ode submenu of the Display
menu , or the Dialog Bar - Left .

Although a shaded SHAPE drawing in the Standar d display mode using Shading
(Inputl Menu) has agood 3-dimensional appearance, the term "3D drawing" is used to
denote a method of drawing which is different in severa respects. SHAPE uses the
OpenGL system software package for Windows, Macintosh and Linux and the Direct3D
package for Windows (only).

In this type of drawing, the surfaces of three dimensional objects such as spheres and
cylinders are converted to an assemblage of planar polygons. Then each polygon is
drawn essentially independently. The critical difference from non-3D modesisthat a
depth buffer isusedin 3D imaging. Thisisan array of integers, one for each pixel in the
display or output (or that portion which is currently being drawn). Each element,
representing a pixel, holdsthe relative x coordinate (in the SHAPE observer coordinate
system) of the foremost object or polygon. The color for this object is retained in the
color buffer , which isasimilar array representing pixels; thisarray is actually the image
itself. Whenever a polygon is drawn, each pixel which it contains is compared against
the depth buffer; if the x coordinate of the pixel is greater, or closer to the observer than
what isin that element of the depth buffer, the color for this pixel in the new polygon
replaces the value in the color buffer. That is, the depth buffer keeps track of the front
surface of the drawing, and ensures that only this front surface (not any hidden surfaces)
are kept in the color buffer or image itself. It isalso possible to have transparent or
translucent objects, through which hidden surfaces may show partially.

© 2011 Shape Software



Menus and Dialogs 85

Actualy, the "double buffer" method is normally used, the color buffer being kept in an
area of memory and then copied to the screen memory when the drawing is completed.
Thisisusually faster than drawing directly to the screen.

The non-3D display modes of SHAPE do not use a depth buffer: the back edges are
drawn and then the front edges and faces (except for the Anaglyph mode). When
necessary, the intersections of objects are solved analytically and only the required
portions of each are drawn.

There are two main advantages to using the 3D display mode in SHAPE. First, display
of symmetry elements (rotation axes and mirror planes) is supported only in the 3D
modes, because the intersections of these objects with each other and with crystal faces
and edges is too complex for the methods used in standard modes. Second, correct
shading of multiple crystals (twins and epitaxial intergrowths) can only be guaranteed in
3D modes, for similar reasons.

The 3D modes also allows for more elaborate lighting effects (see Lighting Equation and
Material Parameters), although these are not of as much use for simple polyhedra as for
other objects. The shading of curved surfaces (which in SHAPE means only cylindrical
edges and crystal or symmetry axes, and some symmetry symbols) is more satisfactory in
that the color (shading) at each point in apolygonislinear interpolated from the values
calculated from "normals" supplied for each corner. Since thismay call for very fine
gradations in color, the greater the color resolution of the device (the more color bits per
pixel) the better the result will be. 3D drawing will work with an 8-bit (256-color)
display driver, but is usually much better with 16-, 24- or 32-bit display. The color
resolution may be set in the Display control panel of Windows 95/98/NT.

The 3D modes usually draw only surfaces , not edges or intersections of surfaces. To
show edgesit is necessary to specify them independently and draw them as cylinders or
lines.

Note that OpenGL does not support shadows, refraction and many other effects which
make for atruly realistic drawing of atransparent object like acrystal. The freeware ray-
tracing program POV -Ray can do much of this, and SHAPE can optionally write data
filesreadable by POV-Ray (see List Results).

3D drawing is araster method, and therefore is not supported in pen plots or metafiles -
it is supported for the screen, dot-matrix, laser or ink-jet printing, and Raster Files.

3.2.4.12.2 Crystal Colors
Dialog Box: Crystal Colors [ 3D Display Parameters dialog]

This allows specification of separate colors for each individual in twins and epitaxial
intergrowths.
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Thelist box gives the RGB components for each crystal. Crystal number 1 isthe main
crystal. TheR, G and B components for the selected crystal may be modified in the edit
boxes at the bottom of the dialog, or you can modify the color graphically by clicking on
the Select Color button.

In some twin and epitaxial intergrowths, the faces of two or more individual crystals may
be coincident, i.e. may overlap in places. If the crystals are given different colors, the
color of the overlap areasis not predictable; parts of this areamay be one color and parts
another.

3.2.4.12.3 3D Display Parameters
Dialog Box: 3D Display Parameters [ Input2 Menu]

This dialog controls parameters for the 3D Display mode, which is selected with the
combo box in the Dialog Bar - L eft, or with the Modes/Display Menu.

Y ou can Show Edges and/or Show Faces, but of course you must check one or the
other of these boxes unless you want to show symmetry elements only.

Edgesmay be simpleLines or Cylinders of the specified Radius . Lines have the
thickness (in inches or centimeters) currently set in the Line Attributes dialog (Input2
menu). Keepin mind that lines are three-dimensional objects (with aribbon shape), and
they may interpenetrate with and be partially obscured by other objects such as crystal
faces. If edges areto be wider than afew pixelsit isusually better to use cylinders (note
that cylinder radiusisin central distance units, not cm/in). If lines are used it may be
best to use asimilar color for edges and faces. The edge colors are set in the Line Colors
dialog in the Input2 menu. Striations in 3D mode are aways lines, not cylinders.

Faces may be completely opaque (opacity = 1.0), or translucent/transparent. If the
opacity valueis greater than 0.98, faces will be assumed to be completely opague -
drawing opague surfacesis faster.

If the Show Symmetry box is checked, all rotation axes and mirror planes will be
shown. Attributes of this display may be changed with the Symmetry button
(Symmetry Element Display dialog)

TheMaterials button (3D Materials dialog) allows changing the reflective/emissive
properties of the objects.

If the Use Face/Form Fills radio button is checked, the selected faces or forms

(Face or Form Fills dialog, Inputl menu) will have the particular color specified. Any
faces or forms not specified will have the overall crystal color. If the Use Crystal Color
radio button is checked, the given color will be applied to all faces. All faces, whether
using fills or not, will be shaded according to the current illumination direction and
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materials parameters.

If there is more than one crystal (twin individuals or epitaxial crystals), and the Use color
for each crystal box ischecked, a separate color for each one will be used. The colors
for the second and subsequent crystals must be set with the More Colors button

(Crystal Colors dialog).

The lllumination direction isthe direction in observer Cartesian coordinates (see
Coordinate Systems) from which the light is coming. Thisisthe same vector asin the
Shading dialog (Inputl menu).

Thereisonly onelight, of the Directional type (not Positional) - that is, all rays are
parallel.

3.2.4.12.4 3D Material Parameters
Dialog Box: 3D Material Properties [ 3D Display Parameters dialog]

In the 3D Display mode the material properties of objects determine the way the objects
interact with the light sources.

The color observed at agiven point is aresultant of the light source and the material
properties; that is, the RGB coefficients of the Ambient , Diffuse and Specular
components of the light source(s) are multiplied by the specified colors of the objects,
and by the material coefficientsin this dialog, then the results are limited to the range
0.0-1.0. See Lighting Equation for details. In SHAPE, thereisonly one light source,
color white, which has rays coming from a constant direction (parallel rays), rather than
from asingle point.

Ambient light has no direction or origin and is considered to bathe all objects
uniformly. Having a significant ambient component causes non-illuminated parts of
objects to be other than black. It thus "softens® the illumination in a somewhat similar
way to the Darkest Shade and Darkness Angle parameters (Shading dialog) in the
Standard display mode.

Diffuse color isusualy the main component of the appearance of objects. The intensity
of the color is dependent on the angle between the light ray and the normal to the surface
in question.

Specular reflection only occurs when the normal to the surface in question is close to
bisecting the angle between the incident light and the vector from the point on the
surface to the eye. It produces bright highlights on a curved surface. The larger the
Shininess coefficient, the smaller will be the bright specular highlight on a curved
surface. The shininess coefficient has a maximum of 128 because of computational
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restrictions, but values on the order of 5-30 are usually redlistic.

In SHAPE, specular reflection is always white, that isit does not depend on the color of
the object, only the color of the light source (which iswhite). Specular reflection does
not currently work well for crystal faces and mirror planes because faces at the reflection
angle will give an essentially solid white appearance, rather than abright spot. Thisis
because the angle is calculated for the corners of the face, and interpolated for each point
in the interior of the face. In order to produce bright-spot highlights on flat surfaces, it
would be necessary to subdivide the surface on afine grid, and use point light sources
rather than paralel illumination.

Emission issimilar to ambient, except that there is no dependence on the color of any
light source. A high value of emission can make an object look like isis glowing.

These material properties are specified separately for cylindrical edges and symmetry
axes, and for crystal faces and mirror planes.

3.2.4.12.5 Symmetry Element Display
Dialog Box: Symmetry Element Display [ 3D Display Parameters dialog]

In the 3D Display Mode, rotation axes and mirror planes may optionally be shown.

Rotation axes can be shown as simple lines, or cylinders of the specified radius. The
standard symbol for each axis, in a 3-dimensional, "extruded" form, will be shown on
each end of the axis.

All rotation axes will be the same Color.
Mirror planes are actually shown as plates of the specified Thickness .

If the Opacity isgreater than 0.99, they are drawn astotally opague, which isfaster.
The planes may be circular or disk shape, or square. Note that the circular outline of
disks always consists of line segments, and the number of such segmentsin VRML files
is determined by the viewer, not SHAPE. Thus disks may have an unacceptably
polygonal appearancein some VRML fileviewers.

Transparency of mirror planesis something of an approximation. Some color
combinations for background, crystal edges, faces and mirror planes may work better
than others.

Scalefactors. Thesefactors determine the relative sizes of the symmetry elements and
the crystal. Inthe Maximize sizefor each view and Universal maximum scaling
modes (Scaling dialog, Input2 menu), the drawing is scaled to the minimum dimension
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of the screen or the frame for printed or file output. When symmetry elements are
shown, it is generally best to reduce the scale of the crystal relative to them. The rotation
axes should usually be largest, so that the symbols at the ends are not obscured. If they
are given scale factor 1.0, they will be scaled so that they occupy the space which would
be occupied by the crystal in the absence of symmetry elements. Similarly, the scaling
for the mirror planes and crystal should be reduced with respect to this original scaling -
factors of about 0.7 and 0.6 respectively are reasonable. Inthe Fixed scaling mode the
scale factors specified in the Scaling dialog apply to the crystal, and the factors for
symmetry axes and planes are scaled relative to the crystal.

The Symbol size determines the maximum dimension of the symbols drawn on both
ends of each symmetry axis. The thicknessistwice the cylinder radius for the axes
(above).

There is asample of each crystallographic symmetry group or crystal classin the
\GROUPS subfolder or directory.

When in the Cartesian or QSHA PE mode (not supported in the Standard Edition),
information on the symmetry operators must be present in the .SYM file

(Cartesian Symmetry). Thisinformation follows the actual symmetry matricesin the
form of lines beginning with the keyword SYMOP. Thisisfollowed by three floating-
point values giving the orientation of the symmety element in Cartesian coordinates, and
an integer giving the order of the symmetry element. Aninversion axisisdenoted by a
negative sign. A mirror planeis denoted by order -2, and the coordinates are for the
perpendicular to the plane.

Only one symmetry operator of each independent set should be given - therest are
generated by the symmetry matrices. In many cases these operators are just those which
are required to generate the symmetry group in the program SY MGRP, and SY MGRP
will now write out the generating operators as SY MOP lines. However, in some cases
additional sets of operators are generated. SYMGRP will add amirror plane
perpendicular to any rotation axis of even order if a center of inversion is present, but
there are still some cases in which operators may have to be added manually. For
example, the non-centric icosahedral group | can be generated with only one three-fold
axis and one five-fold axis (actually, only one operation of each), but a set of 2-fold axes
isimplicit in the group and must be added.

Seethe .SYM filesin the \SYM subfolder for examples, which include the icosahedral
and pentagonal groups.

Note that some trigonal, tetragonal and hexagonal point groups may have aternate
orientations of the symmetry elements with respect to the crystallographic axes - see

Symmetry.
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3.2.5 Display Menu
Replot - Replotsthe image (does not recalculate).

Color - Switches the screen between black-and-white and color.

Remove Hidden Lines - For intergrowths, removes segments of lines of one crystal that
are hidden by another.

Scale Grid - Superimposes a scale grid for location of the crystal or parts thereof.

Clinographic Viewing - Switches clinographic viewing on and off.

Anaglyph - Settings for the two-color Anaglyph Drawing mode.

Labels - Settingsfor face indices labeling.

Dialog Bar - Left - Thisisavertical toolbar which resides along the left edge of the Main
window. It combines the functions of the former Rotate and Quick Commands dialog
Dialog Bar - Right - Thisisavertical toolbar which resides along the right edge of the
Main window. It contains alist of form and some common commands.

Dialog Bar - Epitaxial - This allows movement of epitaxial crystals.

3.25.1 Replot Command
Replot Command [ Display menu]

This command redraws the image without recalculation. Changesin most itemsin the

I nput2 menu can be put into effect with this command (although these dialogs all have
an automatic replot check box). It can also be used after some changesin theitemsin
the Inputl menu, such as colors. For changes which affect the number of faces, corners
and edges and their relative locations, use the Calculate command in the File menu or
the Calculate button in Dialog Bar - Left.

3.2.5.2 Color Command
Color Command [ Display menu]

This switches between full-color and black-and-white screen display (all types of output
have independent color switches). Displays with more than 16 colors may show true
gray-scale rather than the dithering which is used in actual black-and-white output. Y ou
can set the default or start-up status of this switch in the Preferences dialog in the
Settings menu.

Evenif your display is color it may be useful to view the image in black-and-white to
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see what it will look like in black-and-white files or printing.

3.2.5.3 Scale Grid
Dialog Box: Scale Grid [ Display Menu]

This option allows you to locate and size the crystal, so that it can be rescaled or
displaced. It will draw a square grid at the given absolute intervals. The center of
coordinates is shown by a star at the center of the screen, and the current location of the
center of the crystal by another star. These two center points differ only if you have
entered displacements or turned on automatic centering with the
Centering/Displacements dialog in the Input2 menu or with the Dialog Bar - Right .
The grid isremoved only by replotting with the Grid plotting on box unchecked.

See | nput Colors/Patterns/Pens for general aspects of input

3.2.5.4 Clinographic Viewing Command
Clinographic Viewing Command [ Display menu]

This turns clinographic viewing on and off, with automatic replot. See also
Clinographic Viewing in the Rotation menu, which does the same thing without
automatic replot. Set the inital state of clinographic viewing in the [nitial Orientation
dialog in the Input2 menu.

See also Coordinate Systems.

3.2.5.5 Anaglyph Settings
Dialog Box: Anaglyph Settings [ Display Menu]

Rotation angle. Thisisthe angle by which each of the views s rotated away from the
non-stereo position. Thisangle isthe same asthe angle for separate stereopair views,
which isalso set in the Preferences dialog (Settings menu).

View colorsand Background . The colors of the two images are completely different
depending on the background. For screen viewing, the background is normally black,
and the left-eye imageisred, while the right-eye image is blue, green or cyan. Which of
the latter three colors works best depends on the particular glasses you are using. The
color of the combined, 3-D image is white, violet, or yellow. In most cases, images on
the screen work best with red-cyan rather than red-blue.

For printed images, the background is normally white, and the right-eye image isred,
while the left-eye image is green, cyan or blue, again depending on the glasses. The
color of the combined, 3-D image is normally black.
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Anaglyph drawings can be shaded, but the color will beignored and the crystal will be
shown as white. On the screen, if the color where the two images overlap is not white,
try changing from red/blue to red/cyan or vice versa.

It is certainly possible to use a white background on the screen, but a black background
for printing is not usually very satisfactory, because of bleed (widening) of the black
background pixels onto the colored lines. Lines must be many pixels wide to avoid this
problem.

The success of the 3-D image relies on proper combination of colors during drawing.
When part of the right-eye image is superimposed on part of the |eft-eye image, the
colors must be added, instead of the right-eye image just replacing the left-eye image.
That is, where ared image and a blue or cyan image coincide on a black background the
color should be white (or violet), instead of blue (or red). For Windows, this appearsto
be done incorrectly for 8-bit (256-color) screen modes and correctly for 16- and 24-bit
screen modes.  Color combination for index Labels does not seem to be done correctly
even in the 16- and 24-bit screen modes. However, these aspects may also depend on the
particular graphics card installed in your machine. For printing, the rules for combining
colors are completely different, and the results you get may depend on the printer driver
and printing mechanism.

In summary, you may need to experiment with the View color s and Background
settings to get the best results.

3.25.6 Labels
Dialog Box: Labels [ Display Menu]

This option can cause either form letters or the numeric indices of each face to be
written. The label iswritten at the center of the face, which islocated by averaging the
corners. Labels are not written in the Cartesian mode. Face indices may be shown with
or without the standard parentheses or brackets. The form letters are entered for each
form in the Add/Revise Form dialog in the Inputl menu.

You can Label back faces, but only if back edges are shown (Line Attributes dialog,
Input2 menu). Y ou can select the Colors for the labels for front and back faces: usually
these should be the same as the colors for the front and back edges set in the Line Colors
dialog, Input2 menu.

The labels can be offset by uniform amounts across and up, or the observer y and z
directions.

If you select Opaque , rather than Transparent , there will be awhite block behind each
label. However, thisisnot recommended for indices because the small bars over the
numbers, denoting negative signs for the index, are actually formed by writing
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underscores on another line above the numbers.

It is best to select afixed-width Font such as Courier, because the correct |ocation of the
bars above the numbers depends on letters having a constant width. The font in
PostScript output will always be Courier.

In the 3D display mode, the position in space of the labels depends on whether actual
planar faces are shown (3D Parameters dialog, Input2 menu). If faces are not shown, the
labels are written at the center of each face. If faces are shown, the labelsareall ina
plane which isin front of the entire crystal.

3.2.5.7 Dialog Bar - Left
Dialog Bar - Left

Thisisactually a special type of Control Bar, residing on the left or right side of the
Main window. It can be turned on or off with the Dialog Bar - Left command in the
Display menu. The Left-hand dialog bar combines the functions of the former Rotation
and Quick Commands modelessdialogs. The Dialog Bar - Right contains the list of
forms, and another set of common controls.

Only those controls are visible which can have an effect on the current state of the
problem. For example, when SHAPE isfirst started up, only the Open button is shown.

The upper part controlsrotation of the structure in simple ways (for more ways to rotate
or align the structure, see the commands in the Rotation menu). The current orientation
isshown at thetop. The a, b and ¢ axis labels are attached to the positive ends of the
axes, and the part of the axes extending forward (positive x) are drawn with heavier
lines. In normal or standard view, the rotation buttons below this are for rotation on x, y
and z, respectively; positive angle (clockwise looking outward on the axis) is on the | eft,
and negative rotation on the right. In stereonet view you are looking down on the c-axis,
so the pairs of buttons are for z, y and x going downward. The angle of rotation isin the
box below the buttons. The initial value of thisangleis set in the Preferences dialog in
the Settings menu.

If the Auto box is checked, the rotation occurs as soon as each rotation button is clicked.
If this box is not checked, the rotations are accumulated into a matrix, and the drawing i<
not replotted until you click on the Replot button lower in the dialog (or select Replot
from the Display menu).

The buttons beneath Auto duplicate some common commands, all from the File menu
except Replot , which isaso found in the Display menu. Y ou can use Open to start up
SHAPE by reading in afile.

Replot - Replotsthe image (does not recalculate).
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Calculate - Reproduce faces and locate corners and edges, etc..
Open - Open anold SHAPE datafile.

Save - Save aSHAPE datafile.

Saveas - SaveaSHAPE datafile with anew name

Print - Prints using the standard printer.

The Model Mode drop-down or box controls the Model Mode - this duplicates a
submenu in the M odes menu.

The Drawing Mode drop-down or box controls the Drawing Mode - this also duplicates
a submenu in the M odes menu.

The Fullscreen button switches from normal windows to display using the entire screen.
From SHAPE V7.3 this can be done with any combination of Model and Drawing
Modes and on Macintosh, Windows or Linux.

3.2.5.8 Dialog Bar - Right
Dialog Bar - Right

Thisisactually a special type of Control Bar which resides on the right side of the Main
window. It can be turned on or off with the Dialog Bar- Right command in the Display
menu. The Right-hand bar contains alist of forms, and some common commands. The
Dialog Bar - Left contains another set of common controls.

The current forms are given in the list box at the top of the dialog bar. To modify a
current form, double-click on an entry in the list. This brings up the Add/Revise Form
dialog. To Add or Delete forms, use the buttons below the list box. If epitaxial crystals
are present, the Add button will add aform to the crystal whose form is currently
selected in the list box.

The Cursor M ode radio buttons control the operation of the mouse cursor.

In the I dentify Faces cursor mode, clicking the left mouse button on aface brings up the
Face at Cursor dialog, which provides information about the face and form. Clicking the
right mouse button on an edge or corner allows insertion of a new form truncating this
edge or corner and its symmetry equivalents. Only visible or front edges may be
selected. Theindices of the new form will be the sum of al the facesinvolved in the
edge/corner. The aert box which asks your permission to add this form gives the indices
asaraw sum (e.g. 202), but before the form is actually added the indices will be reduced
by any common factor (e.g. to 101). In the case of twins, the new form will be added to
al twinindividuals, but in the case of epitaxial intergrowths, only the crystal whichis
selected will be affected. The cursor shape for thismode is asimple cross.
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The Resize cursor mode allows automatic adjustment of central distances and therefore
face sizes. In this mode, clicking the left button on aface will increase the central
distance of the form, and cause recal culation (the current orientation will be retained).
Of course, increasing the central distance generally decreases the size of the facesin the
form. Clicking the right button decreases the central distance. The amount of the
increase or decrease is set in the Preferences dialog in the Settings menu. Clicking on a
face of atwin will cause achange in all the twin individuals. The cursor shape for this
mode is a cross with arrowheads on all arms. When this mode is in effect thereis a
white block in the upper left corner of the graphics window saying "Resize mode off".
This block isareminder that clicking on any face will actually change the shape of the
crystal, and clicking in the block will cause reversion to the I dentify Faces cursor mode.

The Rotate cursor mode allows rotation of the drawing, by clicking and dragging.
Clicking and dragging near the center of the plotting area causes rotation on they and z
Cartesian reference axes (see Coordinate Systems) - the effect isasif the cursor "grabs” a
point on the front of the crystal. Clicking and dragging near the left or upper edges of the
plotting area causes rotation on the z Cartesian reference axis, which is perpendicular to
the screen. The cursor shape for this mode is a quasi-circular rotation arrow.

The Remove Symmetry button allows for distortion from ideal symmetry, by complete
removal of all symmetry. Each current generated face is converted to aform, whose
central distance may then be adjusted (e.g. with the Resize cursor) independently of the
other faces related to this one by the original symmetry.

The Show Symmetry check box controls the display of symmetry elements (rotation
axes and mirror planes), which is possible only in the 3D display mode.
See 3D Parameters.

Clinographic Viewing . Thisturnson and off the rotations which give the standard

The Set Center button defines a new center point - use thisto "focus' or "zeroin" on a
specific area or point in the plot. After clicking on this button, an aert box informs you
that the next mouse click in the graphics window will define a new center point. After
clicking on a point, the drawing will then be displaced so that that point will be at the
center of the viewing area. It may be more useful to think of the result as the viewing
area being centered on the point selected.

With the Rescale buttons, you can "zoom" in or out. When inthe Maximize... or
Universal... scaling modes, this changes the rescale factor (see Scaling). Inthe Fixed...
mode, clicking on these buttons simply changes the fixed scale factors. The actual rescale
factor applied is 1/(1+x) for down scaling, and (1+x) for up scaling, where x is the
amount in the edit box converted from percent to a fraction.

The Reset Scale button calls the Reset Scaling and Centering dialog. This alows
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reversion to the last setttings, before interactive changes with the Set Center or Rescale
buttons (above), or in the Fullscreen 3D mode.

Summary of mouse cursor operationsin graphicswindow. For Macintosh, "Right
button" is obtained with the option key plus the mouse button.

Index (Identification) mode:
L eft button - identifies face and form; successive clicks give interfacial angle.

Right button - identifies edges and corners; allow addition of new form truncating
face or corner.

Resizing mode:
L eft button - increases central distance of form selected - usually decreases area.
Right button - decreases central distance of form selected - usually increases area.
Rotate mode:

Left button - click and drag in main part of window rotates around axes in screen;
click and drag near left or upper edge rotates around axis perpendicular to screen.
3.2.5.9 Dialog Bar - Epitaxial
Dialog Bar - Epitaxial
Thisisactually a special type of Control Bar, residing on the right side of the Graphics

window, but just to the left of the Dialog Bar - Right. It can be turned on or off with the
Dialog Bar - Epitaxial command in the Display menu.

Thisdialog bar isonly for positioning the epitaxial crystal(s) with respect to the main
crystal. To change the orientation (i.e. host plane and vector and guest plane and vector)
go to the Epitaxy dialog in the Inputl menu. The Crystal which is being positioned is set
with the choice box at the top. The main crystal is number 1, so thefirst epitaxial crystal
is number 2.

The Distance is measured between the center of the epitaxial crystal and the the center of
the main crystal, perpendicular to the Host Plane.

The Displacement Parallel to vector isin the direction of the Host vector listed above
inthe dialog bar. The displacement Perpendicular to this vector isin the epitaxial plane.
To show the new position, click the Calculate button.
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3.2.6 Rotation Menu
Cartesian Axes - Rotate on the viewer or reference axes.

Crystal Vector - Rotate on arational crystal vector [uvw].

Clinographic Viewing - Thisturns clinographic viewing on and off, with optional replot.

Align Face or Vector - Align the crystal with aface in the screen or avector
perpendicular toit.

Save/Recover Orientation - Remove al rotations made since the calculation or the
Initial Orientation, or save the current orientation as the Initial Orientation.

Current Orientation - Givesthe exact current orientation of the crystal(s).

Continuous Rotation - Initiates continuous rotation of the crystals(s) about a specified
axis.

Rotation Movie - Writesavideo filein .SWF - Flash platform-independent format or
Windows- or Macintosh-specific format.

3.2.6.1 Rotate on Cartesian Axes
Dialog Box: Rotate on Cartesian Axes [ Rotation meny]

Thisrotates the crystal on one of two sets of Cartesian axes. If clinographic viewingis
off, the crystal is always rotated about one of the axes belonging to the observer system:
X coming straight out towards the observer, y in the plane of the screen or paper pointing
to theright and z upwards. If clinographic viewing is on, you can choose to rotate about
the clinographic axes, which have been rotated in a certain way from the observer axes
(see Coordinate Systems).

Each time you click the Rotate button, arotation is added to a master rotation matrix;
the number of such rotationsislisted at the bottom of the dialog box. When you have
finished rotating, click the Done button and the master rotation matrix is applied to the
crystal. If you click Cancel , no rotations are applied.

In Standard mode, the clinographic and observer axes are roughly similar. However, in
Stereonet mode (sel ected in the Modes menu), they are distinctly different. I1n this mode,
you are considered to be viewing the crystal down the ¢ axis, instead of down the & axis
(or approximately so, if clinographic viewing ison). Thus the clinographic z axis comes
directly out of the screen or paper, the x axisis downward and they axisisto theright -
in other words the clinographic axes are rotated by 90 degrees with respect to the
observer axes. Asnoted in Coordinate Systems, when rotating about the clinographic
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axes, the crystal can be considered to be rotating in its own coordinate system, while the
user may have different points of view: in Standard mode with clinographic viewing off,
looking directly down the x axis; in Standard mode with clinographic viewing on,
looking down a direction which is up and to the right from the x axis; and in Stereonet
mode, looking directly down the z axis.

3.2.6.2 Rotate on Structure Vector
Dialog Box: Rotate on Crystal Vector [ Rotation Menu]

Thiswill rotate about arational crystal direction [uvw], regardiess of the current display
mode or orientation of the crystal. If you are drawing a molecule and have used Cartesian
reference axes, the rotation direction is simply a vector with the coefficients u, v and w in
the original molecule axis directions a, b and c. The indices or coefficients refer to a
coordinate system fixed with respect to the crystal (always rotating with it). In Crystal
(not Cartesian) SHAPE the indices must be integers, but thisis not abar in practice to
rotation about irrational vectors, since the indices may take very large values.

Each timeyou click the Rotate button, arotation is added to a master rotation matrix;
the number of such rotationsis listed at the bottom of the dialog box. When you have
finished rotating, click the Done button and the master rotation matrix is applied to the
crystal. If you click Cancel , no rotations are applied.

3.2.6.3 Clinographic Viewing
Dialog Box: Clinographic Viewing [ Rotation Menu]

Thiswill switch on and off the rotations of -18.4 degrees on z and 9.5 degreeson y,
applied in clinographic display mode. Thisin effect changes the viewpoint of the
observer between the clinographic position, down the vector [621] referred to the
observer Cartesian axial system, and a straight-on position, down the x axis. This
command isincluded in the menu for convenience; the same operation is performed by
the Clinographic Viewing command in the Display menu, although choosing that
command always causes areplot.

See also Coordinate Systems.

3.2.6.4 Align Face or Vector
Dialog Box: Align Faceor Vector [ Rotation Menu]

<Standard Mode - see also Align Face or Vector (Cartesian)>

Thiswill rotate a specified face (hkl) to lieflat in the screen or paper (face-normal
parallel to x observer), or avector (uvw) to be perpendicular to the screen or paper. To
align aface, it is also necessary to specify avector lying in the face which will be vertical
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in the screen or paper (z direction). Conversely, to align avector, it is necessary to

specify aface, containing the vector, whose normal will be vertical. If avector [uvw] lies
in aface (hkl), the indices satisfy the condition hu + kv + lw = 0. If clinographic viewing
isin effect, it isturned off when the face is aligned, to simplify any subsequent rotations.

Y ou can elect to use adefault alignment vector or face. The default vector will be the
intersection of the face (hkl) with the face (100), whose indices are given by the cross
product (hkl)x(100). If the face (hkl) is (100), the default alignment vector will be the
vector [001]. For aligning avector the algebraisjust the same, with interchange of face
and vector.

3.2.6.5 Align Face or Vector (Cartesian)
Dialog Box: Align Faceor Vector (Cartesian) [ Rotation Menu]

<Cartesian mode - see also Align Face or Vector (standard)>

Thiswill rotate a specified face (hkl) to lieflat in the screen or paper (face-normal
parallel to x observer), or avector (uvw) to be perpendicular to the screen or paper. To
align aface, it is also necessary to specify avector lying in the face which will be vertical
in the screen or paper (z direction). Conversely, to align avector, it is necessary to
specify aface, containing the vector, whose normal will be vertical. If avector [uvw] lies
in aface (hkl), the indices satisfy the condition hu + kv + lw = 0. If clinographic viewing
isin effect, it isturned off when the face is aligned, to simplify any subsequent rotations.

In the Cartesian mode, faces and vectors are equivalent - that is, to align afaceisaso to
align avector with the same indices.

Y ou can elect to use the default alignment vector or face, instead of specifying it. The
default vector will be the intersection of the face (hkl) with the face (100), whose indices
are given by the cross product (hkl)x(100). If the face (hkl) is (100), the default
alignment vector will be the vector [001].

3.2.6.6 Save/Recover Orientation
Dialog Box: Save/Recover Orientation [ Rotation Menu]

Thefirst two options will counteract all rotations made by the dialogs in the Rotation
menu as well as any made on-screen with dialogsin the Display menu, and take you
back to one of two settings. The original orientation means the orientation before any
rotations, including the rotations of the Initial Orientation dialog in the Input2 menu,
have been made. Theinitial orientation isthat attained after the rotations of the

Initial Orientation dialog - that isinitital Cartesian rotations and initial clinographic
rotations - have been made, if any of them were actually used. See also
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Coordinate Systems.

The third option will save the current orientation asinitial Cartesian rotations, plus
initial clinographic rotation if clinographic viewing is currently in effect. These settings
can be viewed and changed in the | nitial Orientation dialog in the Input2 menu.

Summary of orientation operations . After calculation, SHAPE first setsthe c crysta
axis parallel to the z viewer axis, and thea * crystal axis (perpendicular tob and c)
parallel tox . Thisistheoriginal orientation. Next, theinitial Cartesian rotations, if
any, are applied. Finaly, the clinographic rotations, if selected, are applied. Thisisthe
initial orientation.

3.2.6.7 Current Orientation
Dialog Box: Current Orientation [ Rotate Menu]

This gives the current orientation in terms of the face normals and crystal vectors which
are a) in x observer direction (see Coordinate Systems), perpendicular to the screen or
paper; and b) in the z observer direction, vertical in the screen.

Note that the List Results command in the File menu gives the directions of the crystal
axesin the observer Cartesian system.

3.2.6.8 Continuous Rotation

Dialog Box: Continuous Rotation [ Rotate Menu]

This dialog initiates a continuous rotation about any of the three Cartesian observer axes
(x out of the screen or paper, y to the right and z vertical).

The Delay (inintegral seconds) isthe time after finishing one view and beginning the
next; it does not include the time required to draw the view.

To stop the rotation, press any key. You will then see adialog allowing you to abort the
rotation or to continueit.

Sounds are turned off during this rotation, the cursor isinvisible, and the double-buffer
drawing method is used (Preferences dialog, Settings menu). When you finish
continuous rotation, the previous settings are restored.

3.2.6.9 Rotation Movie

Dialog Box - Rotation Movie [ Rotation Menu]

Thiswill writeamovie or video filein .AVI (Windows), .MOV (Macintosh) or .SWF -
Flash (all platforms) format. These files consist of a series of bitmap (raster) images. The
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structure will be rotated from its current attitude about the selected Axis , with the
selected Rotation increment, until the sum of rotations exceeds the M aximum
rotation.

A normal motion picture uses 30 Frames per second , but typical computer videos use
less than this. In fact, some computers may not be able to handle 30 frames/sec for large
images.

For .SWF - Flash files (only) you can add a sound track from a.mp3 file.

Note that movie files may be very large (many megabytes) even if compressed. For
Macintosh, the compression mode is automatically selected by the System software, and
is supposedly optimal for the resolution (Pixel size ) selected. In Windows, you are
presented with a dialog showing the available codecs (COmpression-DECompression
algorithms), and you must select one. Finding the optimal codec may be a matter of trial
and error - performance usually varies with the Pixel size and the actual number of
colors used. Some codecs compress very effectively, but cause degradation of the image -
SHAPE images should usually be compressed with alossless compression method.
Some codecs which have been found to be good for typical SHAPE images are the
CorePNG and Lagarath codecs.

See Frames for details of the frame and frame units.

3.2.7 Settings Menu (Graphics Window)

The Settings Menu in the Graphics Window isidentical to the Settings Menu in the
Startup Window.

3.2.8 Windows Menu

The Windows menu lists al the possible windows in SHAPE - those which do not
actually exist are greyed out.

Select awindow to make it active, or bring it to front.

When a Text window is active, the first item in the menu is a Font selector, which acts
on the entire text in the window.

3.2.9 Help Menu
This gives access to the online Help system, and to the About dialog with copyright and
other information.

On the Macintosh, the About dialog will appear in the Apple menu (OS 8/9) or in the
Application menu.
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3.2.9.1 About
About command [ Help menu |

Use this command to display the copyright notice and version number of your copy of
SHAPE.

3.3 Text Window Menu Bar

These windows are used for the List Results command in the File menu of the Graphics
window and for listing of corner information in Sections and Growth Zones - see

Types of Windows. They are standard Windows text or edit windows. To switch to the
SHAPE graphics window, which has the menus and commands for altering and
displaying crystal data, use the Window menu, or click on the Graphics window if it is
visible.

File menu - Thisisastandard File menu which pertains only to the special files with
extension .SHP used in the Text windows.

Edit menu - This menu has the normal text editing commands, which again pertain only
to the speciadl files with extension .SHP used in the Text windows.

Window menu - Use this menu to switch to the SHAPE graphic window for most
operations on SHAPE data sets, and to set the font for the Text windows.

Help menu - Accessto general help for SHAPE.

3.3.1 File menu (Text windows)
FileMenu (Text Window)
The commandsin this menu apply only to Text windows, which are opened by the

List Results or Section Data (see Sections and Growth Zones) commands in the
File menu of the Graphics window. See Types of Windows for further explanation.

Close - Closes the Text window, and the file associated with it.
Save - Savesthe file associated with the window.

Save As - Saves the contents of the window to a specified file name.
Print - Prints the contents of the Text window.

Print Setup - Selects a printer and printer connection.
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Exit - Exits SHAPE.

3.3.1.1 Save As (Text Windows)
Save Ascommand [ File menu, Text windows|

When called from Text windows, this saves the (text) contents of the current window in
thefile of your choice.

The standard SHAPE files RESULTS.SHP and SECTOUT.SHP arein the same
directory asthe SHAPE program (.EXE) file; if you want to save these files, you should
probably give them new names and put them in the same directory asthe crystal data
(.SHP) file, if the datafile is not in the SHAPE program directory. See

Types of Windows.

To save atext file with its existing name and directory, use the Save command.

3.3.1.2 Save (Text Windows)
Save command [ File menu, Text windows|

When called from Text windows, this saves the (text) contents of the current window in
the filewhose nameisin thetitle bar. The standard RESULTS.SHP and
SECTOUT.SHP arein the same directory as the SHAPE program (.EXE) file. They are
overwritten each time you request alist of the corresponding type. Thusif you want to
save these files, you should probably use the Save As command instead of Save, give
the files new names and put them in the same directory asthe crystal data (.SHP) file, if
the datafileis not in the SHAPE program directory. See Types of Windows.

3.3.1.3 Close (Text Windows)
Close command [ File menu, Text windows]

Use this command to close the currently active Text window. SHAPE inquiresif you
want to save changes to your datafile before you closeit. If you close a data set without
saving, you lose all changes made since the last time you saved it.

The standard SHAPE files RESULTS.SHP and SECTOUT.SHP are in the same
directory as the SHAPE program (CPSHAPE.EXE file). They are overwritten each time
you request alist of the corresponding type. Thusif you want to save thesefiles, you
should probably use the Save As command, give the files new names and put them in
the same directory as the crystal data (.SHP) file, if the datafileis not in the SHAPE
program directory. See Types of Windows.
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3.3.1.4 Page Setup
Page Setup command [ File menu]

This allows setting of the paper type or size, the standard orientation (portrait or
landscape) and the paper margins (except Macintosh). Marginswill only be used in
Text Windows.

---Macintosh only ------

Use the Page Marqgins dialog to set margins.

3.3.1.5 Page Margins
————— Macintosh only----

This dialog sets the margins for Text Windows. Use the Page Setup dialog to choose page
size and orientation.

3.3.2 Edit Menu
Edit menu (Text Windows)

The Edit menu for Text windows offers the usual commands.

Undo Reverse previous editing operation.

Cut Deletes data from the document and movesiit to the clipboard.
Copy Copies data from the document to the clipboard.

Paste Pastes data from the clipboard into the document.

3.3.2.1 Undo
Undo/Can't Undo command [ Edit menu]

Use this command to reverse the last editing action, if possible. The name of the
command changes, depending on what the last action was. The Undo command changes
to Can't Undo on the menu if you cannot reverse your last action.

3.3.2.2 Cut

Cut command [ Edit menu]

Use this command to remove the currently selected data from the document and put it on
the clipboard. Thiscommand isunavailableif there isno data currently selected.
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Cutting data to the clipboard replaces the contents previously stored there.

3.3.2.3 Copy
Copy command [ Edit menu]

Use this command to copy selected data onto the clipboard. This command is
unavailableif thereis no data currently selected.

Copying datato the clipboard replaces the contents previously stored there.

3.3.2.4 Paste
Pastecommand [ Edit menu]

Use this command to insert a copy of the clipboard contents at the insertion point. This
command is unavailableif the clipboard is empty.

3.4 Non-Menu Dialogs
The Face at Cursor dialog is called up when you click on aface in the Identification

cursor mode.

The colorsdialog is used for selecting colorsin severa places.

3.4.1 Face at Cursor
Dialog box: Faceat Cursor

This dialog comes up when you click the mouse pointer on aface, if the Cursor Mode
(Cursor menu) is set on indexing rather thanresizing or rotation. It liststhe face
indices, the form indices and the crystal number, if there is more than one crystal. It also
givestheinterfacial angle (angle between face poles or normal) between the current faces
and the one last identified.

Y ou can change the Central distance for the form - to put thisinto effect, you must
Recalculate.

Y ou can also use this dialog to set up a color or pattern fill of aface or form, or to delete
one. See Face/Form Fillsin the Inputl menu for more details on fills.

In Direct3D Drawing Mode, fullscreen, there is no atom identification - the only function
of the mouse cursor isto rotate the structure, or to stop rotation or vibration by a click
anywhere.
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3.4.2 Select Color
Dialog Box: Select Color [variousdialogs].

This dialog allows color selection from the current 16-color palette, and also allows
selection of acustom color. The Custom button calls up a system standard color-
picking dialog.

Thered, green and blue values are given below each color box, to the right of the radio
button. These values are on a scale of 0-255, as used by Windows.

It isusually best to use one of the 16 colorsin the palette, because 1) the 256-color or 8-
bit display palette is derived from these colors, and faces of shaded crystalswill be
forced to one of these colors anyway at plot time; and 2) display and output are usually
more satisfactory when simple colors, such as those in the default palette, are used.

The default colors selectable in this dialog may be changed in the Pal ette dialog (Settings
menu).

4 Reference

Reference - General Topics

4.1 Cartesian (QSHAPE) Operating Mode

The normal operating mode, called SHAPE mode, is restricted to the symmetry of the 32
crystallographic point groups. The QSHAPE mode avoids this restriction by using
Cartesian reference axes and Cartesian symmetry matrices. The choiceismadein the

M odes menu.

Solids which show external morphology, X-ray and/or electron diffraction patterns of
apparent symmetry not belonging to one of the 32 crystal classes have been termed
guasi-crystals; hence the name Quasi-SHAPE or QSHAPE. Crystals cannot have
symmetry axes of order five, or higher than six, so that quasi-crystals cannot truly have
this symmetry (or else they cannot be true crystals). Neverthelesstheir external form
often shows apparent icosahedral or other non-crystallographic symmetry. Polyhedra
with non-crystallographic symmetry are also of interest from a purely geometric
standpoint; the icosahedron and pentagonal dodecadron are among the five Platonic
solids.

Since reference axes based on lattice trandlations are not applicable to quasi-crystals (this
term will be used here for all solids with faceslike crystals, but which have non-
crystallographic symmetry), the QSHAPE mode always uses a Cartesian axis System.
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Whereas the SHAPE operating mode, in order to find all the symmetry equivalents of a
face, uses asimplified system of transformation of theindicesin integral form, the
QSHAPE mode must multiply the indices by Cartesian symmetry matrices, one for each
symmetry operation in the point group. The sets of symmetry matrices are in separate
files, which must be generated beforehand with the auxiliary program SY MGRP,
described in the next section. The symmetry files for the pentagonal and icosahedral
groups have aready been generated and are provided on the SHAPE disk(s).

In calculating the locations of corners, the SHAPE mode makes use of sectors defined by
mirror planes (see 1-3). Since the orientations of mirror planes cannot be fixed
beforehand in the general case of non-crystallographic symmetry, this method cannot be
used in the QSHAPE mode, and calculations may be much slower. Because of the
necessity of generating the symmetry files beforehand, and the usually slower execution
for crystals with mirror planes, the QSHAPE mode is not recommended for use with true
crystals, although it is perfectly capable of drawing any crystal.

Operation in the QSHAPE mode differs from that in the SHAPE mode in only afew
respects. otherwise, everything in the instructions pertains to both modes.

1) Inentering acrystal using the Title/Axes and Symmetry dialogs (I nput1l menu) you
do not supply the axis lengths and angles and crystal class. Rather, the axes are always
Cartesian and in the Symmetry dialog you must give the name of afile containing the
symmetry matrices. Normally such afile will have been generated by the auxiliary
program SY MGRP (next section), and will have the extension .SYM.

2) Theindicesfor forms, faces and vectors are decimals, rather than integers (whole
numbers). Y ou do not need to enter adecimal point, and you can enter integral indices
of any size, but once entered the indices will be normalized to alength of one (h2 + k2 +
12 = 1.0). QSHAPE uses athreshold value of 0.0001 to test whether numbers are the
same; thusfive significant figures are usually sufficient.

3) Because of the necessity of storing all the symmetry matrices, the number of epitaxial
crystals allowed in the QSHAPE mode is smaller than that in the SHAPE mode: seethe
README filefor current limits.

4) If you arein norma mode and you read a datafile written with QSHAPE mode, you
will be switched automatically (with your approval) to the QSHAPE mode, and vice
versa. However, fileswritten by V4.1 or earlier SHAPE for DOS must be converted to
the current format with the DOS program FILEUP.

4.2 Central distance

central distance. The central distance for aface or form (set of symmetry-equivalent
faces) isthe perpendicular distance in arbitrary unit of the user's choice (often referred to
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as central distance units) from the center of the crystal coordinates to the facein
guestion. Generally, the larger the central distance the less prominent (smaller) the face
is.

SHAPE uses finite tolerances in many parts of the calculations, for example to test
whether corners formed by the intersection of three faces are coincident with existing
corners, whether faces are parallel, etc. Usually these tests work best when the central
distances are approximately 1.0 or smaller. However, if the results are obviously
incorrect, changing al the central distances by afactor of 10 up or down with the Factor
button in the Forms List Dialog may improve things.

4.3 Colors and Palettes

This section appliesto true colors - see Dot Patterns for the nature of "colors" or shades
in black-and-white display and output.

In principle, Macintosh and Windows allow full freedom to specify colorsfor lines and
fillsin color display or output. In practice, it isadvisable to select colors carefully to
take best advantage of awide range of display and output devices. For 8-bit or 256 color
screen displays, it is also necessary to supply a palette of the desired colors to the system
to avoid unnecessary color mixing or dithering.

SHAPE uses a primary palette of 16 colorsto assist in color selection, and from which a
256-color palette is derived.

Display or screen devicesin the past were most easily or directly able to produce colors
which have the simplest combinations of components red, green and blue. The binary
combinations of red, green and blue are cyan(green+blue), magenta or violet (red+blue)
and yellow (red+green). On the other hand, the primary colorsfor printing are cyan,
magenta and yellow. Screen devices such as VGA and super-VGA can now produce any
color, but it is still best to select the six colors red, green, blue, cyan, magenta and
yellow, plus black and white, asfirst choices for colors of lines and fillsin SHAPE.
These are the first 8 colorsin the SHAPE palette. Actually, black isnot agood color for
fills, since it cannot be shaded. The next-best group of full-intensity colors consists of
the six colors which are binary combinations of the six mentioned above. These 6, plus
two shades of gray, are the second 8 colorsin the SHAPE palette.

At thistime, 8-bit color, allowing atotal of 256 separate colors, is still sometimes used
for screen display and is often convenient for raster files. SHAPE generates a color
palette for 8-bit display and output as follows. If the number of shading zones selected
in the Shading dialog in the Input2 menu is 16 or less, 15 colors are derived from each
of the colorsin the primary 16-color palette, except for black, ranging from the pure or
full-intensity color to near black. There are thus 15 gradations of red, for example, with
rgb values of (255,0,0), (238,0,0), downto (17,0,0). Including black (0,0,0), this allows
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adifferent shade for each of the 16 zones.

If the number of shading zones selected in the Shading dialog in the Input2 menuis 32,
only thefirst eight colorsin the palette, excluding black, are used to derive the shaded
colors, and there are 31 gradations of each. (Note that thisis different from the DOS
versions of SHAPE, in which the second 8 colors were used for the 32-zone palette;
however, the colors used, namely red, green, blue, cyan, magenta, yellow and white are
the same, and there should be no problem with SHAPE-DOS files).

To summarize, colors used in SHAPE should be as simple as possible for best success on
awide range of display and output devices. Choose colorsfirst from the first eight
colorsin the standard SHAPE palette, then from the second eight.

Y ou do have the freedom to define any color as desired, specifying the RGB
components. Y ou can also redefine or rearrange the SHAPE 16-color palette with the
Palette dialog in the Settings menu, and this will give correct results for 8-bit (256-
color) screen display. However, it is probable that more complex colors will not be
rendered very satisfactorily on color hard-copy devices (depending, of course, on the
sophistication of the device).

4.4 Colors/Patterns/Pens for Input

In color display or output, lines may be drawn with different colors, and faces or forms
may be filled or shaded with different colors (except in pen plots). In black-and-white
display or output, various dot-patterns, simulating shades of gray, are normally used for
fills, and for linesif they are wide enough.

This section discusses the common aspects of color/shade input for lines and fills, as
occursin many input dialogs in SHAPE. Depending on the type of display and output
involved, any of three different sets of colors or patterns/shades may be used.

(a) For color screen displays, printer, raster or Metafile output, actual colors are used.
The RGB components, which are numbers ranging from zero to 255 can be directly
entered in the edit boxes, but the color is most easily and reliably selected with the
Select...Color buttons. These bring up the Choose

Color dialog, presenting the colors of the current 16-color palette. If the color is being
selected for shading (Shading dialog in the Inputl menu), the color chosen hereis that
at maximum (perpendicular) illumination.

For 16-, 24-, and 32-hit color screen displays you have complete freedom to choose
colors. For 8- or 4-bitcolor the colorsfor fills and shading may be forced at plot timeto
one of alimited number of allowed colors. For 8-bit color the number of colors allowed
depends on the number of shading zones selected in the Shading dialog in the I nput2
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menu. See the general section Colors and Palettes for further information on palettes for
the 8-bit color mode.

For best results on awide range of display and output devices, chose the simplest colors,
which arefirstly colors 0-7 in the default 16-color palette, and secondly colors 8-15

(b) For black-and-white screen displays and dot-matrix output, either true grays or dot
patterns of various densities are used. The codes for these shades or patterns range from
0 for whiteto 15 for solid black. See Dot Patterns for details on the nature of these
patterns.

The selected pattern is used for linesonly if the width of the line is greater than one dot.
The width of various types of linesis set in the Line Attributes dialog in the | nput2
menu. Note that rendering of gray-scale for linesin black-and-white printed output is
determined by the printer driver, not SHAPE. Many printer drivers do not support gray
lines, and pattern numbers other than 15 may give either white or black lines.

(c) For pen-plotters the number requested refers to the pen number used in drawing the
lines. There are no fills or shading in pen plots. These numbers are not used if the
single-pen mode is selected in the Pen Plotter Settings dialog in the Settings menu.

When changing the red, green and blue values directly in the edit boxes which appear in
many dialogs in SHAPE, the rectangle showing the actual color does not change until the
focus shifts from the current edit field, that is until the mouseis clicked in another place
inthe dialog.

4.5 Coordinate Systems

Three types of coordinate system are used frequently in SHAPE: the observer Cartesian
system; the natural crystal system; and a clinographic system.

The observer system isfixed with respect to the display screen or paper of dot-matrix or
pen-plotter copy. The origin is at the center of the screen or paper, and the x axis points
directly toward the observer. They axis points to the observer'sright and the z axis
vertically, both in the plane of the screen or paper.

The parameters of crystal faces are given in terms of the natural crystal axis system,
although in the QSHAPE or Cartesian mode thisisitself a Cartesian system. Once al the
faces have been generated by symmetry, their coefficients are converted to Cartesian
coefficients. Except for crystals using rhombohedral axes, the natural ¢ axisisoriginally
placed parallel to the observer z axis, and the natural b axisisaligned in they-z plane
(or in crystallographic terminology the a * axisis parallel to x). If rhombohedral crystal
axes are chosen, the three-fold symmetry axisis parallel to z, and the the vertical plane
containing the first rhombohedral axisisaligned in the x-z plane.
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This conversion defines the "original" orientation of the crystal. After the location of
corners etc., and before the initial display, the orientation may optionally be modified by
the rotations in the | nitial Orientation dialog in the Input2 menu, and by clinographic
rotation, defined in the next paragraph.

Clinographic Viewing . One of the standard methods of drawing crystalsis clinographic
projection, in which the crystal isin effect viewed from above and slightly to the right of
the aaxis, or to be more precise, in towards the center along the vector [621]. If the
option for clinographic viewing is chosen, after the faces, corners etc. are found, the
crystal and its associated Cartesian system are rotated -18.4 degreeson the z axis, then
9.5 degreesonthey axis. Thisisnot true clinographic projection, but the results are
almost the same.

After the drawing appears, additional rotations may be made either on (1) specified
vectors in the natural crystal system; (2) the observer Cartesian axes; or (3) if
clinographic viewing is on, the rotated Cartesian axes, or clinographic system. The
clinographic system does not rotate with the crystal; it is always related to the observer
system by the two rotations given above.

If clinographic viewing is not on, the clinographic and observer systems have the same
orientation, and if the natural crystal system is Cartesian or cubic all three systems have
the same orientation.

Sereonet Viewing. When this display mode is selected (M odes menu) the crystal is
viewed directly down the c axis, if in standard or original orientation. The a* axisis
downward. Rotations made in standard mode are carried into this mode, but the
clinographic rotations are not used.

Summary of axial systems:

1) Observer Cartesian system . Reference system, fixed with respect to the display screen
or paper.

2) Natural or crystal system. The axes are the unit-cell edges. Axes may have unequal
lengths and may be at angles of other than 90 degrees.

3) Clinographic system. Only applies when clinographic projection or viewing ison.
Axes are those of the observer Cartesian system, but rotated in a certain manner to avoid
astraight-on view of the crystal.

If Perspective viewing is not selected, the drawing isadirect projection in the x axis
direction (observer system). If perspective viewing is selected, the corners are projected
onto they-z plane from a point on the x- axis at the specified distance in the positive
direction (toward the observer).

In SHAPE, a,b andc (or A, B and C) refer to the natural crystal axes. The three axes
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will always have these names or al, a2 and a3 if the axes are equal by symmetry. The
lettersx, y and z usualy refer to the observer Cartesian axes. If it isnecessary to refer to
the clinographic system, thisis mentioned explicitly.

Coordinate Systems for Rotations

x 2=

X ¥

Chserver Clinographic

4.6 Direct Modification of Files

Data Files. The .shp fileswritten for each structure are of the standard ASCI| type.
Direct modification of these filesis no longer recommended. However, occasion may
arisefor repairing a damaged file, which can be done with any word- or text-processor or
other program which handles ASCI| files.

SCRPTR Setup File. Thereis now only one type of datain the SCRPTR file which
should be modified; the dot-patterns. The SCRPTR file will be replaced after the first
startup by a user- and platform-specific file.

There are two sets of 32 dot-patterns (fine and coarse), each consisting of 32 lines of 8
numbers each. Each number can range from O to 255, with abinary 1 bit representing a
black dot and O representing white (or color in the case of 4-bit raster files). Note that
earlier versions of SHAPE may have had either 14 (V1.0) or 16 patternsin each series.
The fine series, which isfirst, contains duplicate lines so that there are only 16 patterns
for shading, even if the number of shading zonesis greater than 16. These patterns could
be modified to give 32 distinct shades, although it is doubtful if this would greatly
improve the quality of the image.

Patterns can also be modified to give striations, hachures or other patterns for use in face
fills. For example, thesequence”111111 11" will give vertical striations, and the
sequence "2550000 00 0" will give horizontal striations. Such patterns should not be
used when shading is in effect.
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The patterns in the SCRPTR file or user- and platform-specific file are only used for raster-
file output, and for standard printer output when SHAPE patterns are selected; they are
not used for the screen.

Although the data for the 16-color palette are also in the SCRPTR file or user-
and platform-specific file, it is easiest to modify the palette with the Palette dialog in the
Settings menu, or to prepare files to be read in with these dialogs.

4.7 Directories and Files

SHAPE looksfor filesin two folders or directories: (1) the home directory, which isthe
one containing the SHAPE program or application, CPSHAPE.EXE; and (2) the data
directory, containing datafiles.

The home directory should contain, in addition to the SHAPE application itself, the setup
files (SCRPTR and DEFAULTS), the pen-plotter information file (PPLOT) the help file
(CPSHAPE.HLP), the space-group symmetry file (HALL.DAT) and palette (.pal) files.
The SCRPTR and DEFAULTSfileswill be replaced after the first startup by a user-

and platform-specific file.

The data directory should contain the crystal datafiles (.shp) and cartesian symmmetry
files (.sym), and will contain any output files (raster, metafiles, EPS and pen-plotter
files). Output files can be quite large.

The files RESULTS.SHD, containing the output from the List Results command in the
File menu, and SECTOUT.SHD, containing data on sections and growth zones (Sections
and Growth Zones dialog in the I nput1 menu), are written to the home directory.

The data directory isinitially the same as the home directory - it isreset whenever a data
file (.shp) isread in with the Open option or afileiswritten with Save as.

4.8 Dot Patterns

The dot-patterns which are the "colors" for facefills, for shading, and for wide linesin
black-and-white printer and raster output (if SHAPE patterns are selected in preference
to those supplied by the printer driver), are shown below. The patterns comprise two
series of dot-patterns of increasing density with shade numbers 0-15; the choice between
them ismade in the Print or Raster File dialogs (File menu).

The fine series is recommended for 9-pin or other low resolution dot-matrix plotting, for
very small drawings done at high resolution, or for raster files which will be shown on a
low-resolution screen. The coarse series contains patterns more like the half-tone
screening used in printing. It is appropriate for gray tones and shading in high-resolution
dot-matrix plotting. Actually, for shading with 32 zones, there are 32 patternsin the
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coarse series, only half of which are shown in Figure IV-1. Thefine serieshasonly 16
unique patterns even if the number of shading zonesis 32, although this could be
changed in the SCRPTR file (see Direct Modification of Files).
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4.9 File Types

SHAPE uses several different types of auxiliary files, with different extensions. When
reading files, the extensions are not mandatory, and you can usually choose a different
extension when saving afile, or specify "all files" when browsing or searching for afile.

Crystal data files (.shp). These hold the information on individual crystals and
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intergrowths. The Open, Save and Save As commands in the File menu of the
Graphics window pertain to these files.

Internal files. These are for SHAPE internal use and should not normally be modified by
the user (but see section I'V-8 of instructions for special cases) . SCRPTR isthe main
start-up file which saves current settings. DEFAULTS saves default display variables for
use with the New command. PPLOT contains data on pen plotters. CPSHAPE.HLP s
the help file, which isin condensed format and not modifiable by the user. SCRPTR and
DEFAULTS are replaced after the first startup with a user- and platform-specific file.

Cartesian symmetry files (.sym). These contain Cartesian point-symmetry matrices
generated by the auxiliary program SYMGRP. They arefor input only.

Palette files (.pal). These contain RGB values for the 16-color palette which forms the
basis for 8-bit (256-color) palettes, and which is used to ssimplify color selection. They
can be modified, read and written with the Palette commands in the Settings menu.

Text output files (.shd). Theseare (1) RESULTS.SHD, containing the output from the
List Results command in the File menu, which gives most of the input data and results
for normal views of crystals and intergrowths; and (2) SECTOUT.SHD, containing
corner coordinates and other information on sectors and growth zonesiif thistype of
output is selected in the Sections and Growth Zones dialog (Inputl menu).

Graphics output files. SHAPE can write graphics output files of various types: raster
files (.bmp, .pcx, .tif); encapsulated PostScript files (.eps); HPGL vector files (.pgl) and
Windows metafiles (.wmf).

Import files. SHAPE can obtain crystallographic information from a number of database
and structure-refinement file types - see Import Files for further information.

File Locations

SHAPE expectsto find certain filesin the "home" directory, which is the directory
containing the SHAPE program file (wxShape.exe). These files are SCRPTR,
DEFAULTS, PPLOT, HALL.DAT and palette (.pal) files.

The"data"' directory isthe directory containing the crystal data (.SHP) file. The data
directory isreset whenever you read or write acrystal datafile. If you are using Cartesian
symmetry files (.sym), they should be in the data directory. Most output files, including
EPS, raster, HPGL and metafiles, will be written to the data directory. However, the data
output files (.shd) are written to the home directory, to avoid cluttering the disks. To save
these files permanently, use Save As to give them new names in the directory of your
choice.
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4.10 Frames

With most types of hard-copy output, you have a choice of using the full page, or
confining the output to aframe . For Raster Files and Metéfiles (both in the Output
menu) output always goes to aframe.

If you are using the Universal or Maximize Each View scale modes (Scaling dialog in
the Input2 menu), theimageis scaled to fit in the frame. Note that starting with V6.0,
there isarescale factor which is applied to thisscaling. If you are using the Fixed scale
mode, the image is clipped to the frame.

In hard-copy output, the frame can be positioned on the page; the offset gives the
displacement of the upper left corner of the frame from the upper left corner of the page.

In some cases, you can choose the units for the size and offset of the window; either
inches, centimeters or dots (pixels), and you may also be able to specify the nominal dots
per inch or centimeter. The units setting is independent of the overall choice of inches or
centimetersin the Preferences dialog in the Settings menu.

4.11 Free-Form Input Files

Files of thistype are read and written by ATOMS and CRY SCON (Shape Software).
Such files have atomic-coordinate information, but thisisignored by SHAPE.

All information needed for a SHAPE calculation can be entered with these files, and they
should be easy to write with other software. The SPGP , HALL , SYMM AND LATT
lines are used only in the Donnay-Harker Morphology option.

The required information is entered in lines which begin with one of the 4-letter
keywords shown in boldface type below. Information follows the keywords in numeric
or character fields - fields do not contain spaces (may contain underscores), and are
separated from each other by spaces.

TITL line. Upto 76 characters (may contain spaces).

CELL line. Theunit-cell lengthsin Angstroms and the interaxial anglesin degrees (6
floating-point values).

SPGP line. The Hermann-Maughin or standard International symbol for the space
group. There should be no spacesin the symbol, although there may be underscores
(which areignored when the symbol is interpreted).

HALL line. TheHall symbol for the space group. There should be no spaces in the
symbol, although there may be underscores (which are ignored when the symbol i<
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interpreted. If thisline comes after the SPGP line (or that line is absent), the Hall symbol
will be used.

SYMM lines. These give symmetry operatorsin "xyz" form, that isin theformin
which the coordinates of the general position are listed in the International Tables for X-
Ray Crystallography . Fractions must be given as integers separated by aslash ("1/2",
"2/3"), rather than decimals ("0.5", "0.333"). Thex, y and z positions must be separated
by commas and there should be no spaces in the operator. There should be one line for
each operator. If the space group is centrosymmetric, only half the operators need be
given, if the origin ison a center of inversion. If the originisnot on a center, all
operators must be given and the space group should be denoted non-centric inthe LATT
line.

LATT line. Thisgivesthe Bravais lattice type (single capital character), followed by a
space and O if the space group is centrosymmetric or 1 if it is non-centric.

Generadly, the SYMM/LATT combination supercedes SPGP or HALL lines- if
SYMM lines are present, SHAPE will attempt to determine the space group from them,
and if successful will replace any H-M or Hall symbols which have been read in.

FORM lines. These lines contain the three indices and the central distance for each
form. Theindices may be floating point for entry in the Cartesian (QSHAPE) operating
mode - be sure to set this mode before reading the file.

4.12 Lighting Equation (3D)

In the 3D display mode the material properties of objects determine the way the objects
interact with the light sources.

The color observed at agiven point is aresultant of the light source(s) and

the Material Properties; that is, the RGB coefficients of the Ambient , Diffuse and
Specular components of the light source(s) are multiplied by the specified colors of the
objects, and by the material coefficientsin this dialog, then the results are limited to the
range 0.0-1.0.

Itotal = KeC ;emissive
+ laKaC ;ambient
+Sum(i) [ (NdotVi) li KdC] ;diffuse
+ Sum(i) [ ( NdotSi )*nsli Ks] ;Specular

Where Itotal isthetotal intensity asan RGB triplet at any point on an object;

laistheintensity (RGB triplet) of the ambient light source (1.0 for the ssimple light
model used in SHAPE);
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li istheincident intensity (RGB triplet) at the object of directional or positional light
sourcei (1.0 for the simple light model used in SHAPE);

Cisthe assigned color (RGB triplet) of the object (crystal edge, crystal face, symmetry
axis or mirror plane color);

Keisthe emissive material coefficient of the object (Material Parameters dialog);

Kaisthe ambient material coefficient of the object (Material Parameters dialog);

Ksisthe specular material coefficient of the object (Material Parameters dial og);

nsis the specular exponent or shininess coefficient of the object (Material Parameters
dialog);

N (avector) isthe normal to the surface at the point in question;
Vi (avector) isthe direction of the incident directiona or positional light i at the point;

S (avector) isthe bisector of the angle between the light-surface vector (or Vi) and the
eye-surface vector;

"dot" signifies the vector dot product.

Ambient light has no direction or origin and is considered to bathe all objects
uniformly. Having a significant ambient component causes non-illuminated parts of
objects to be other than black. It thus "softens’ the illumination in a somewhat similar
way to the Darkest Shade and Darkness Angle parameters (Shading dialog) in the
Standard display mode.

Diffuse color isusually the main component of the appearance of objects. Theintensity
of the color is dependent on the angle between the light ray and the normal to the surface
in question.

Specular reflection only occurs when the normal to the surface in question is close to
bisecting the angle between the incident light and the vector from the point on the
surface to the eye. It produces bright highlights on a curved surface. The larger the
Specular material coefficient, the smaller will be the bright specular highlight on a
curved surface. The shininess coefficient has a maximum of 128 because of
computational restrictions, but values on the order of 5-30 are usually realistic. In
SHAPE, specular reflection is always white, that is it does not depend on the color of the
object, only the color of the light source(s). For directional lights, specular reflection
may not work well for polyhedra because faces at certain angles will give asolid white
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appearance.

Emission issimilar to ambient, except that there is no dependence on the color of any
light source. A high value of emission makes an object look likeisis glowing.

This equation ignores translucency, which causes colors objects lying at different depths
to be blended.

4.13 Precision, Tolerances and Errors in Corner, Edge and Face

SH; %5 glﬁ gtpdns in SHAPE depend on finite absol ute tolerances to decide whether
corners are outside of any face, whether a corner derived from one triplet of facesis
coincident with another, etc. Sometimes there are errors, for example extra corners,
missing edges, or missing faces (in the Shading or Face Fill options, or in 3D mode).
Errors may occur either in the calculation of corners and edges, or during actual plotting
Stuations which can cause problems:

1) Multiple edge/face inter sections . When more than three edges (or more than three
faces) intersect or nearly intersect at a point, the identification of the number of corners
involved may be arbitrary. In some cases more than three faces intersect at a point and
form asingle true corner by symmetry - for example 3, 4, 6 or more facesin apyramid in
trigonal, tetragonal or hexagonal crystals. Tolerances must be large enough to identify
these intersections correctly. In other cases the intersection of edgesis fortuitous.

2) Low-angle face intersections. When faces are nearly parallel, the precision of
|ocating intersections decreases.

3) Junctions of twin or epitaxial intergrowths. Specia situations may arisein
multiple crystals which do not occur for single crystals. There may be problems either
during the calculation of corners and edges or during drawing.

Possible remedies:

1) The Remove Hidden Lines option in the Display menu controls the plotting of edges
on one crystal which are hidden by another crystal.

2) Rotation . Missing lines of type 3) above can sometimes be restored by rotating a
small amount, on the order of adegreeor less.

3) Change of individual central distances. Problems of type 1) may often be cleared
up by dlightly changing the central distance of one of the formsinvolved, rather than all
forms.
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4) Change of all central distances. Since most of the tolerances are absolute (not
relative), increasing al central distances by acommon factor has the effect of reducing
all tolerances by the inverse of thisfactor. Thereisan option for thisin the Forms List
diaog.

5) Change of criteria for showing edgesin twinsand epitaxial intergrowths.
Certain types of edge may or may not be desirable to draw in intergrowths. The Edges
in faces and Always show composition-plane edges optionsin the Preferences dialog
control some such cases. Trial-and-error change of these parameters may give amore
correct or more pleasing appearance.

6) Change of perspective distance . Increasing the Perspective distance sometimes
clears up problems.

Note on units . Most distances used in SHAPE are in arbitrary units called central
distance units (abbreviated cdu). These may be considered to correspond to any desired
unitson areal crystal, such as millimeters, centimeters, inches, etc. When fixed scale
factors are used (Scaling dialog), it is necessary to specify the ratio of these unitsto the
units (inches, centimeters or pixels) which are used to describe the screen or paper.
Growth rate equations must be given in the appropriate units per time unit (also an
arbitrary unit). Otherwise the absolute values of central distances have no effect - it isthe
relative values which determine crystal shape.

414 Palettes

Although Windows programs can specify colors made up of any admixture of red, green
and blue components, it is generally a good ideato use simple colors whenever possible,
to increase the chances of faithful reproduction on a variety of display and output
devices.

16-Color Palette. SHAPE uses a primary pal ette composed of 16 colors for two reasons:
to aid in the consistent selection of simple colors; and to form a basis for the 256-color
palette used for 8-bit displays or other devices. Thefirst eight colorsin the default 16-
color palette are black, white, red, green and blue, and then the binary combinations of
red, green and blue which are cyan, magenta (violet) and yellow. The second eight
colors are two shades of gray, then the binary combinations of red, green, blue, cyan,
magenta and yellow (these six have no universally-recognized names). The colorsin this
palette are the same as those in the Alternate pal ette which is used in the DOS versions
of SHAPE, but in adifferent order.

The RGB valuesin the 16-color palette can be changed with the Palette dialog in the
Settings menu. You can also save and re-read palette (.pal) files.

256-Color Palettes. The palettes which are used in 256-color screen-display modes are

© 2011 Shape Software



Reference 121

primarily designed for shading. There are two distinct palettes; the first has 15 principal
colors, each with 16 gradations from full intensity to amost black, and is used when the
number of shading zones (Shading dialog in the Inputl menu) is 16 or fewer; the
second has only 7 principal colors, each with 32 gradations from full intensity to almost
black, and is used when the number of shading zonesis 32.

Thefirst or "16-zone" palette is made up asfollows. Thefirst 15 colors (0-14) start with
full-intensity color number 1 (white), and grade with decreasing intensity to near black;
the second 15 colors (15-29) start with full intensity color number 2, grading to near
black, and so on. When shading isin effect, SHAPE finds the nearest color in the 16-
color palette to the crystal color selected in the Shading dialog (I nput1 menu). Any face
receiving full illumination is given this full-intensity color and faces at anglesto the
illumination vector are given colorsin the series of 15 colors derived from that principal
color. The palette defined in thisway actually contains only 225 colors. Windows
reserves 20 colorsfor its own use, including black which therefore does not have to be
defined in the SHAPE palette.

In the second or "32-zone" palette, the first 31 colors (0-30) grade from full-intensity
color 1 to near black, the next 31 from full-intensity color 2 to near black and so on,
through color number 7 and its derivatives. When shading isin effect, SHAPE again
"forces" the color to one of those in the 16-color palette, but the choices thistime are
only colors 0-7. Asthe colors are arranged in the default palette, this results in changing
colors 8-15 to 0-7 respectively. Actually, colors 0-7 can be regarded as"simplified" or
more basic versions of colors 8-15. The above shaded colors add up to only 217, so
colors 8-15 are also added to the pal ette to be usable for lines and unshaded fills.

Again, if shading isin effect and you are using more than 16 shading zones (Shading
dialog in the Input2 menu), any fill colors or shading colorsin the range 8-15 will be
automatically "downgraded" to colors 0-7.

All these complexities and restrictions pertain only to 8-bit or 256-color display or raster
files. For standard VGA (4-hit) display, the RGB values are sent to the display driver,
which determinesin its own way what combination of pixelsto mix to represent agiven
color. Thisislikewisetruefor printer and PostScript output. The RGB values are aso
sent directly to 24-bit screen displays, which can presumably render any color without
dithering.

4.15 Settings, Preferences or Configuration Files

SHAPE hasin the past saved various settings in two files, SCRPTR and DEFAULTS,
both of which are in the same folder or directory as the wxSHAPE program or
executablefile. SCRPTR saves general settings which may be used for all data, such as
frame sizes for printing and graphics file output and is always saved before exiting the
program. DEFAULTS saves settings which are more particular for each data set - these
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may be used asthe initial or default values for anew dataset. The DEFAULTSfile
could be read or written through optionsin the Settings Menu, and at other times when
starting a new data set or importing afile.

Starting with V6.3, thisinformation is saved in a standard type of file which is specific to
the platform (Windows, Mac or Linux), and thisfileisin alocation specific to each user.
Thus each user will have his or her settings preserved, even if only one copy of the
SHAPE folder/directory and executable file is present. Further, these settings will be
carried on as new versions of SHAPE are installed.

Specifically the new settings files will bein the following locations:
Windows: \Documents and Settings\username\SHAPE.ini

Macintosh: :Users:username:Library:Preferences.SHAPE Preferences
Linux: /home/username/.SHAPE (note the period - thisis a hidden file)
where username is the name of the current user logged in.

The..ini, Preferences or config file has separate sections containing the SCRPTR
information and the DEFAULTS information.

The SCRPTR and DEFAULTSfiles still exist. On startup, SHAPE looks first for the
user-specific file, and if thisis not present it reads the values from the SCRPTR and
DEFAULTSfilesin the folder or directory containing the SHAPE executable file.
Thereafter the user-specific file iswritten and used.

The Windows and Linux versions have separate Help server programs, and these write
their own user-specific preferencesfiles. Thesefileswill be in the above locations, and
the program nameis"wxHTMLHelpController" instead of "SHAPE". Inthe Macintosh
version, thereis no separate Help server program and the data for the Help windows
(window sizes and location and fonts) isin the SHAPE Preferencesfile.

In the Settings menu, there are now options to read and write the "archive" SCRPTR and
DEFAULTSfiles - thiswrites the values currently used by SHAPE. If there are multiple
users of SHAPE, these files should probably be written only the the system
administrator. All users may read the files to get the "standard" or archive values.
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4.16 Shortcut Keys

Since several viewing or drawing modes have been added for V6.4, and since stereo
images may require full-screen viewing in which menus are not available, the keyboard
shortcuts for modifying or animating the images have been revised and extended.

In the full-screen modes accessed with the Fullscreen button in the Dialog Bar - Left or
the menu option, the left mouse button always performs the identification function,
identifying either atoms or crystal faces, and the right button performs the rotation
function. Clicking outside the crystal faces or structure (not on an atom) brings up a
dialog giving most of the options, which can be selected with buttons. If the structureis
in motion, clicking with either mouse button will stop it. Exit from Fullscreen mode
either with this dialog, or with the Esc(ape) key.

The displacement function with the right mouse button which was available in earlier
fullscreen viewing has been discontinued.

In the Direct3D fullscreen mode, the mouse buttons only cause rotation (click and drag),
not crystal-face identification and no dialog is called up by clicking. When the crystal is
in automatic rotation clicking anywhere will stop the motion. The same keyboard
shortcuts are available, and exit from fullscreen is with the Esc(ape) key.

The shortcut key combinations:

SHIFT-X Rotate on the x axis (horizontal in screen). Stop rotation on x, y or z with a
mouse click or SHIFT-Q, and change the speed with the SHIFT-F (faster) and SHIFT-G
(slower) keys.

SHIFT-Y Rotateonthey axis (up in screen)

SHIFT-Z Rotate on the z axis (out of screen)

SHIFT-O Thisrestoresthe original or standard orientation.

SHIFT-l Thisrestorestheinitia orientation

SHIFT-P This decreases the perspective distance, increasing the 3-D effect.

SHIFT-[ Thisincreases the perspective distance (the [ key isthe one to the right of the
P key on U.S. keyboards, but it may be elsewhere on other keyboards).

SHIFT-plus Thiswill change the rescale factor upwards. This factor can be set in the
Scaling dialog (Input2 menu SHAPE). The plus and minus keys are those in the regular
aphanumeric part of the keyboard, not the number pad.
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SHIFT-minus Thiswill change the rescale factor downwards.

SHIFT-A Increase the stereo rotation angle between the two images, or increase the
effective interocular distance. This does not apply to the Direct3D stereo mode - for that
mode, the rotation or "depth" setting is controlled by the video card, usually with a
separate set of keys. Thisrotation does apply to the quad-buffered OpenGL stereo mode
aswell asthe stereopair modes and Anaglyph mode in SHAPE

SHIFT-S Decrease the stereo rotation angle between the two images.

SHIFT-F Speed up motion. The SHIFT-F and SHIFT-G keys only apply when there is
continuous rotation. They permanently affect the angular rotation increment in the
Continuous Rotation dialog (Rotation menu).

SHIFT-G Slow down motion.

4.17 Stereoscopic Display

Improved technology has made stereoscopic viewing, that is viewing stills and movies
with separate left- and right-eye images to give apparent depth, better quality and and
more common on computers and televisions. Asfar as SHAPE is concerned, there are
two separate kinds of stereo-enabled video cards of the most recent types. At present,
software stereoscopic drivers for these cards appear to be available only for Windows.

Direct3D sterea in Windows (only) is supported by the nVidia GeForce series of
graphics cards,with their 3D Vision package, and perhaps some others. The GeForce
series only supports Direct3D in stereo (not any kind of OpenGL).

The 3D Quad Stereo Drawing Mode is available only for graphics cards supporting
OpenGL quad-buffered stereo. It is potentially supported for Macintosh and Linux as
well as Windows, though driver software does not seem to be available yet for them. The
Quadro series of cards from nVidia actually supports either Direct3D or quad-buffered
OpenGL stereo.

With either type of video card there are basically two types of viewing hardware.

1) Shutter glasses. Theimages are drawn independently and flashed alternately on the
screen at a high rate - 120 times per second in the latest computer implementations, for
exampl e those supported by both the nVidia Quadro and GeForce series of display cards.
A 120 Hz monitor or projector isrequired, and it must be viewed with special shutter
glasses which blank out the left and right eyes alternately in synch with the images on the
screen. Projectors and projection TVsare aso available.
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2) Polarizing monitorsor projectors. The monitor or projector simultaneously or
aternately (very rapidly) generates two images which are view with glasses with the two
lenses polarized at 90 degrees to each other, or with different circular polarizations.
Movie theater 3D (stereo) systems use a more elaborate variant of this method. It does
not require expensive shutter glasses, only relatively inexpensive polarizing glasses for
each viewer.

These types of hardware stereo viewing are full-color and should not be confused with
the old two-color (red-green) anaglyph technology which really only shows monochrome
or bi-chrome images. SHAPE has always supported stereo viewing using two spatially
separated images combined with the naked eye or an optical viewer - this type of
technology goes back to the 19th century.

The terminology for stereo viewing can be somewhat confusing. 1n movie theaters and
television, the term 3D means stereoscopic viewing, that is separate images for left and
right eyes. In computer and video-game graphics, the term 3D has been applied to
several kinds of software techniques, at present primarily OpenGL and Direct3D, which
keep track, pixel-by-pixel, of the third dimension in drawings and thus typically produce
more realistic images than 2D line and space-fill drawings, though they are not
necessarily stereoscopic (no separate images for left and right eyes). Thisisthe way the
term 3D isused in al SHAPE literature. OpenGL and Direct3D may be used in SHAPE
for single non-stereo images as well as stereo (2D images may also be shown as
stereopairs with SHAPE, although thisis usually inferior to using a 3D method).

SHAPE in the past has used only OpenGL, which is available for Windows, Macintosh
and Linux . A special, full-screen Direct3D mode has been added to SHAPE for
Windows to support stereo viewing with GeForce cards and any others which require
Direct3D. Thisis selected only in the Display menu, or with a button in the Dialog Bar -
_Left, not in the Drawing Mode drop-down. SHAPE also supports stereo viewing using
the quad-buffered OpenGL method, which is currently available on the Quadro series of
video cards from nVidia and some other video cards.

Older Shutter-Glasses Systems

Older stereo display drivers from nVidia, which worked only on Cathode-Ray-Tube
monitors, not flat-screen LCD monitors, supported Direct3D and OpenGL without quad-
buffering. This system works with inexpensive shutter glasses, but if the refresh rate of
the monitor is less than 100 Hz or so the flicker tends to be excessive. Such systems are
basically outmoded and may not be supported by manufacturers.

Changesin operation of SHAPE

In order to keep the total number of options to a minimum, what were formerly Display
Modes have now been separated into Model Modes and Drawing Modes. The Model
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Mode specifies the type of model which represents the crystal, and includes Standard,
Ellipsoid, Cavities and Protein. The Drawing Mode specifies which computer technique
and viewing mode is used, and includes 2D single, 2D stereopair, 3D single, 3D
stereopair and 3D quad stereo. The 2D modes use essentially line and fill drawing, which
is suitable for schematic drawings for publication, for example, though shading is
availablein SHAPE. The 3D modes use generally more realistic lighting and superior
interpenetration relations, and usually ook better on screen or in full-color high-
resolution printed images. The OpenGL 3D system software is available on Windows,
Macintosh and Linux.

An additional 3D mode, Direct3D, which is available only on Windows, is selected with
a separate button or menu option. Thisis the Drawing Mode which isrequired for stereo
viewing with nVidia GeForce display cards or any others which support Direct3D only.
It isfull-screen only (not windowed)

Selection of Stereo Viewing Methods

Simple stereo methods. These alow stereo viewing using no aids or inexpensive glasses
or optical viewers. The stereopair modes allow stereo viewing with or without optical
aids, but these modes have limitations; the stereopair modes halve the size of the image
and the other image is aways visible, giving three images (unless some special type of
viewer is used).

Hardwar e stereo methods. In these methods a single image drawn by SHAPE is split
into left- and right-eye images by the display hardware, or actually its resident software.
Then the two images are displayed on screen, either aternating rapidly in synchrony with
shutter glass, or astwo differently polarized images. Any of several SHAPE Drawing
Modes may need to be used, depending on your video card and monitor.

1) nVidia GeForce cards which support their 3D Vision system, and any other display
cards which support only Microsoft Direct3D. Click on the Direct3D button in the
Dialog Bar - Left or the Direct3D option in the Display menu. These cards will also
display in anaglyph (red-green glasses) mode without shutter glasses or a special
monitor. In this stereo mode, or any other except quad-buffered OpenGL, the program
sends only asingle drawing (or really, a 3D object) to the video card, which then rotates
the image one way for the |eft-eye image and the other way for the right-eye image.
nVidiadrivers and most others have their own control for this rotation, which may be
referred to as the depth or stereo separation adjustment. Thereisusually a"hot key" or
combination for this, and there may be another which controls the actual physical
separation of the images on the screen. The perspective distance, which controls the
degree of nearness and also influences the stereo effect, is set by SHAPE and can be
changed even in fullscreen mode with the SHIFT-P and SHIFT-[ keys (see below).

Setting up nVidia 3D Vision for Direct3D (DirectX). Some setup in the nVidia control
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panel may be required to enable adjustment of the convergence, which can be critical for
satisfactory viewing. In the Control Panel, select Set up stereoscopic 3D in Stereoscopic
3D. Click on the button " Set Keyboard Shortcuts'. If necessary click on " Show
advanced in-game settings’ and then check the box for "Enable advanced in-game
settings'. Instead of using the Increase and Decrease convergence hot keys, you can also
change convergence by holding down the green-lit on-off button on the front of the
nVidialR emitter while rotating the adjustment wheel on the back of the emitter, but this
is not enable unless the hot keys are enable here.

Adjusting per spective distance, convergence and depth. The nVidia parameter
"convergence”, adjusted with hot keys asin the previous paragraph, can have the effect
of moving the object viewed forward or backward so that isin front of or behind the
plane of the screen. However, for SHAPE it is usualy best to have the center of the
image roughly in the plane of the screen - this minimizes eye-strain and the prominence
of "ghost" images. Thus the convergence hot keys should be used to cause the two
images to coincide at the approximate center of the object. Thisis best done without
wearing the glasses. Once thisis done the convergence can be saved with a hot key
(CTRL-F7). A convergence valueis appropriate for a given value of perspective
distance, so if you aways use the same perspective distance (say 100 Angstrom), it
should not be necessary to adjust convergence again. Once convergence is adjusted, the
depth, which corresponds to the SHAPE parameter stereopair rotation angle, can be
adjusted with hot keys to change the stereo effect. However, the perspective distance
and convergence settings probably have more effect on the perceived depth. The SHAPE
stereopair rotation angleisignored in Direct3D.

2) Cards which support OpenGL quad-buffering, such as the nVidia Quadro series:
Select the 3D quad stereo option in the Drawing Mode drop-down box in the

Dialog Bar - Left or in the Display menu. Stereo can be shown either in awindow or
full-screen. The program itself sends the two completed images or objectsto two
separate buffers, so both the perspective distance and the stereo rotation angle ( = depth
or stereo separation) are controlled by SHAPE; perspective distance is changed onscreen
with the SHIFT-P and SHIFT-[ keys and the rotation angle with the SHIFT-A and
SHIFT-Skeys.

Setting up nVidia 3D Vision for quad-buffered OpenGL. Inthe nVidiacontrol panel,
select Manage 3D Settingsin 3D Settings. In the Global Settings tabe, the Global presets
option can be set to "3D OpenGL Stereo”. It may then be necessary to select the
particular setting Stereo - Display Mode and set it to " Generic active stereo (with
NVIDIA 3D Vision)".

For full-color operation these options will also require either the nVidia 3D Vision
shutter-glass kit and a compatible 120 Hz monitor, or a stereo polarizing monitor and
polarizing glasses. Other hardware combinations may also be available.
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3) Older nVidia cards or some other card with stereo driver software, a CRT monitor and
shutter glasses. These may work with the Direct3D option asin 1) and/or with the 3D
single option in the Drawing Mode drop-down box in the Dialog Bar - Left or the
Display menu. Thiswill only work in full-screen. Like Direct3D in 1) above, SHAPE
sets the perspective distance but the stereo rotation is controlled by the video driver.

Shortcut keys for controlling SHAPE images. Since stereo images may require full-
screen viewing in which menus are not available, the keyboard shortcuts for modifying
or animating the images have been revised and extended.

Additional Details

The stereoscopic option for the video card may use additional shortcut keysto turn stereo
on or off; to increase the counter-rotation of the left- and right-eye images; to change the
separation of the two images; or to change other settings

It seemsthat nVidiacards, at least, produce a stereo effect only by rotation of the two
images, rather than by themselves changing the perspective distance. SHAPE has a
stereopair rotation angle settings, but these are used only in the quad-buffered OpenGL
stereo mode, not the Direct3D mode (these angles are also used in the separate stereopair
Drawing Modes, 2D stereopair and 3D stereopair). The physical separation of the two
images may also be adjusted independently or in combination with the rotation. Thusin
practice it may be necessary to adjust the rotation (which may be called depth or
separation) with the video-card control, and the perspective distance with the SHAPE
controls, by trial and error to get the optimum amount of stereo effect. The physical
separation of the two images on screen, if that is an independent control, primarily
affects comfort - if the separation istoo large, the eyes may not be able to merge the two
images. The controls supplied by the video card may have different names; depth,
separation and/or convergence and the action of each may involve both translation of the
image on screen and rotation. Considerable adjustment of these controls may be required
to get the desired stereo effect and an acceptable level of comfort.

The major market for stereo viewing isfor video games and movies, and the scenes
viewed may extend to infinite distance and do not really have a center, as do the objects
viewed in SHAPE. Thus the approach used for adjustment of the stereo parametersis
somewhat different from what would ideally be used for SHAPE, and the settings for
video games and movies may be considerably different from the ideal onesfor SHAPE.

If the perspective distance is small in SHAPE, the projection of spherical atomswill be
elliptical on the screen, and while this may actually be what the eye would see at a short
distance, such a projected image is usually unsatisfactory in practice. Thusthe
perspective distance should usually not be decreased beyond the point at which atoms
begin to look non-spherical.

Although the nVidia cards do not themselves change the perspective distance, thereis no
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stereo rotation or stereo effect at all in Direct3D if the projection is orthographic rather
than perspective - that is if Perspectiveis not selected in the Input 2 menu. Therefore,
SHAPE always uses perspective projection in the Direct3D mode, with the perspective
distance entered in the Perspective dialog (Input2 menu). If that distanceis zero, a
plausible value is entered based on the dimensions of the crystal.

Inreal life, viewing real objects with the two naked eyes, the stereo rotation angle is
fixed by the perspective distance because the distance between the two eyesisfixed
(approximately). Although the macroscopic crystals drawn by SHAPE may be viewed in
thereal world, the scaling is arbitrary, and it is generally easier to change the stereo
parameter(s) than al the central distances. Changing the stereo rotation angleis
equivalent to changing the interocular distance. Thusit is necessary to adjust the two
parameters stereo rotation angle and perspective distance independently. SHAPE rotates
structures about their own centers (at least if you choose automatic centering), so the
physical separation of the images should not need to be adjusted in the quad-buffered
OpenGL mode.

In real life when attention is directed to a near object, not only is each eye directed
towards that object, but the focus is adjusted; viewing a near object causes distant objects
to go out of focus or become blurred and vice versa. This enhances perception of depth.
On a computer or movie screen the focus cannot be changed, and this may interfere with
depth perception for some people. Of course everything drawn by SHAPE isawaysin
focus, unlike a non-animated movie which is recorded by cameras which change focus
likethe eye. In SHAPE, you may select fog, which only fades out the colors from front
to back and does not change the focus.

Toreview:

In Direct3D stereo viewing, you may need to make three adjustments; the perspective
distance, in SHAPE; and the stereo rotation angle and image separation, with controls
supplied by the video card. The terms used for the latter two may differ, and there may
be interdependence of all three controls. With nVIDIA systems the convergence setting
isclosely related to the SHAPE perspective distance; keeping the perspective distance
constant may make it unnecessary to readjust the convergence for every problem.

In quad-buffered OpenGL stereo, as well as the stereopair modes of SHAPE, both the
perspective distance and stereo rotation angle are set in SHAPE. |f Automatic Centering
is selected (Input2 menu), the objects will be rotated about their own centers and it is not
necessary to change the separation (separation of the two images in stereopair modesis
determined by the size of the window or the screen).
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5 Examples

This section givesinstructions for entering data for the examples in the Sampl e sub-
directory

Note on form/face/vector notation: for typographical reasons, negative signsin front of
the indices are used instead of bars over the indices.

5.1 Calcite Scalenohedron - Simple Contact Twin

(TUTORIAL).

Double click on the SHAPE icon. From the File menu, select New. A dialog asksif you
want to read default display variables. Thisisnot necessary, asthey areread in at start-
up, so click on No. Thisbrings up the Title/Axes dialog first. For atitle "Calcite
scalenohedron” will be sufficient, since other information will be supplied in the
printout. From the Crystal System pull-down, select trigonal hexagonal. Intheaand
c boxes, enter 1.0 and 0.8543 respectively. Thisisfor the morphological axes, which
are most often used in designating faces (the true or X-ray axes are different).

Click on OK, and the next dialog, Symmetry, will come up. Click on the radio button
to the left of B3m, and then on OK.

The FormsList dialogisnext. Click on Add Forms, which will bring up the
Add/Revise Forms dialog.

The indices of the common scalenohedron are { 21-31}. Thethird index, -3, is
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superfluous, and you should enter only 2, 1 and 1 in the boxes under h, k and|. Since
thereis only one form, the Central distance can be 1.0. The remainder of theitemsin
the dialog do not need to be changed or filled in. Click on OK in thisdiaog, and on OK
again inthe FormsList dialog to complete data entry.

In the message box "New input completed - calculate now?', click on Yes. In ashort
time the computation will be complete, and the drawing will appear in the Graphics
window.

Now select Twins from the Inputl menu. From the set of radio buttons labelled
"Type..." select Contact with composition planes. Now click on the Add button, which
brings up the Twin Operator dialog. For the choice of reflection or rotation, select
Reflection. Next enter the indices of the twin plane, (001). Click on OK to return to the
Twins dialog.

Now click on the Composition Planes button, bringing up the Composition Planeslist,
then on the Add button in that dialog. Select Indexed plane, with indices (001).

This completes data entry for the twin. Click on OK in each dialog to remove them all.
In order to put the changes into effect, you must select Calculate from the File menu.

To calculate exactly the same thing using rhombohedral axes, select trigonal
rhombohedral for the Crystal system in the Title/Axes dialog, and enter 1.0 for a and
101.9 for alpha - thisis again for morphological indices. The rhombohedral indices of
the scalenohedron are { 20-1}, and the indices of the basal twin plane are (111) -
otherwise the input is the same.

5.2 Orthoclase - Carlsbad Twin

_—

N,

Data entry in this example follows almost exactly the same sequence as the last example,
except that multiple forms are entered in the Add/Revise Form dialog. Usethe
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Next/New button when finished with each form.

The Crystal system is monoclinic, and you can use the true axes, which are A=8.56,
B=12.96, C=7.21 and BETA=115.83. Thistype of twinisusualy drawnin adistorted
habit, so it is not possible to use the full point group symmetry, whichis"2/M" - instead
enter "2". The forms present (indices followed by central distance) are:

1) {110} 1.0
2) {110} 1.0
3) {001} 16
4) {20-1} 1.3
5 {010} 058
6) {0-10} 04

Thetwin istype Inter penetration with intertwin edges: the operation isrotation by 180
degrees on axis[001]. Select Remove Hidden Lines from the Display menu to remove
extralines. It doesno harm to leave this option on - it isignored for single crystals.

5.3 Chrysoberyl and Aragonite/Cerussite Sixlings

s

In reality these twins are interpenetration twins by reflection, with three individuals per
twin. They can be computed in thisway, but it is slower in terms of computer time, and
in both cases gives a number of small extrafaces which appear rather messy. Therefore
these twins are most satisfactorily done with a pseudo-twin operation, which is actually
the pseudo-symmetry of the twin aggregate.

Both crystals have point group MMM, orthorhombic.

For chrysoberyl, the axial lengths or ratiosare 0.58 : 1 : 0.47 and the forms are:
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1) {111} 10
2) {001} 1.0
3) {121} 097
4) {010} 05

Thetwin typeis Contact with composition planes and there are five twins, each by
rotation on axis [001], by angles of 60, 120, 180, -60 and -120 degrees. The two
composition planes are (130) and (1-30) which are the true twin operators.

When compl eted, the twin will be lying on its back, so to speak. Select Cartesian Axes
from the Rotation Menu. The axisisy and the rotation angle is 90 degrees. Y ou must
click on the Rotate button before you click on Done.

For aragonite/cerussite the axesare 0.62 : 1 : 0.72 and the forms are:

1) {111} 10
2) {010} 02
3) {1100 1.2

There are again five twins by successive rotation of 60 degrees about the axis [001];
however, only three of these are visible (60, 120 and -60 degrees), and no subsequent
rotation is required. Although the true twin operator is reflection on 110, in the sixlings
the contact plane is quite different, approximating to (-130) - for the drawing use
composition planes (-8,23,0) and (-8,-23,0). These indices were chosen so that the twin
individuals ailmost touch, and do not overlap; if they overlap, the intertwin edges will not
be drawn if Remove Hidden Lines (Display menu) is selected (although removal of
hidden linesis actually not necessary for thisview). An aternative would be to use
composition planes (-130) and (-1-30) and adjust the axia ratios. This sort of problem
does not arisein real contact or interpenetration twins, only in those constructed with
pseudo-operators.
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5.4 Rutile Doughnut Sixling

This"crystal" makes use of several tricks. Use point group "2", monoclinic, and axes 1 :
1:0.577, with BETA=90. Thisis not the true axial ratio of rutile, but is chosen so that
the individuals just touch and do not overlap. The real forms which will be shown are
{100} and {110}, but you must enter:

1) {100} 10
2) {010} -10
3) {0-10} 3.0

4) {1-10}  2.4749
5 {110}  -0.3536
6) {001} 25

Note that the distances for forms 2) and 5) are negative - this causes the crystal to be
drawn to the left of the center. The twins are type Contact, five successive rotations by
60 degrees about axis [100], with composition planes (011) and (01-1).
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5.5 Phillipsite Twenty-fourling Pseudo-dodecahedron

Phillipsite is really monoclinic and the true forms shown in thistwin are { 001}, { 010}
and {110}. It would take twenty-four individuals if it were done as contact twins - in this
caseit iseasier to do it as penetration twins, and things are greatly simplified by using
the cell dimensions and indices of the cubic twin pseudo-symmetry. Use crystal class B1,
triclinic, with axes of length 1.0 and angles of 90 degrees, and input the following forms:

1) {110} 20
2) {1-10} 1.0
3) {101} 43
4) {-101} 4.3
5) {011} 4.3
6) {0-11} 43

Use twin suboption I nter penetration - intercrystal edges. There are 5 twins, by
rotations of 120 and 240 degrees about axes[111] and [11-1], and 90 degrees about
[001].

Try reducing the central distance of the forms 3) through 6) gradually, to see the
transition to a pseudo-dodecahedron with compl ete faces.
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5.6 Hematite on Magnetite (Contact Epitaxial Intergrowth)

First, generate the host magnetite crystal, in group M3M, cubic. The forms used on this
crystal were:

1) {111} 10
2) {110} 1.7
3) {211} 13

Now select Epitaxial crystals (Inputl menu). Click onthe Add button. Now enter the
data for the guest hematite crystal.

For the Type, enter Contact.

Next enter the orientation. Fill in the indices in the boxesin the center of the Epitaxial
Relations dialog; the epitaxia face of the host, (1 1 1); the alignment vector in that
plane, [-1 -1 2] (this vector points directly toward the apex): the epitaxial face of the
guest hematite crystal, (0 0 -1); and the alignment vector in that face, [1 1 0] (this may
not be correct, but it looks good).

For the Distance, which in the case of contact intergrowthsis the central distance of the
epitaxial face on the epitaxial crystal, enter 0.06 (actually, anything less than the central
distance of the normal (001) face, 0.1, would do). The Trandations should be zero,
although you can later move the epitaxial crystal around with these items.

The data on the epitaxial crystal itself are entered with the Revise Title/Axes, Revise
Symmetry and Revise For ms buttons towards the bottom of the Epitaxial Relations
dialog, which bring up the same dialogs as for the main crystal. These buttons are the
only way to enter or revise datafor epitaxial crystals, and you must enter appropriate
valuesin each dialog.
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The crystal classis B3M, trigonal hexagonal, and the axes are 1.0 and 1.3. The forms
are:

1) {223} 031
2) {101}  0.33
3) {001} 01

Note that these central distancesfix the relative sizes of the two crystals, although you
can change the size of the epitaxial crystal with the Rescale button.

5.7 Augite Enclosed by Hornblende (Epitaxial Interpenetration)

Generate the augite crystal first, although the order actually doesn't matter in this case.
Crystal classis 2/M, monoclinic, and the axes are A=9.8, B=9.0, C=5.25, BETA=105.
Formsare:

1) {110} 10
2) {100} 1.2
3) {010} 1.1
4) {001} 40
5 {11-1} 37

Go to the Epitaxial Crystals dialog in the Input1 menu and enter the datafor
hornblende: the crystal classisalso 2/M, axes are A=9.9, B=18.0, C=5.3 and
BETA=105.5. Forms are:

1) {110} 20
2) {010} 24
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3) {011} 20
4) {120} 2.3

Specify (100) and [001] as the face and vector of the host, and (-100) and [001] asthe
face and vector of the guest hornblende. Specify the type as I nter penetration, and
center-center Distance of zero. Intercrystal edges should be checked, and you will need
to Remove Hidden Lines (Display menu).

5.8 Lamellar Albite Twins

This intergrowth consists of two different orientations of albite crystals, but the input for
the crystals themselves is exactly the same. The crystal classis B1 and the axes are
a=0.63 b=1.0, c=0.56, ALPHA=94, BETA=116 and GAMMA=88. Theforms are:

1) {110} 10
2) {001} 14
3) {-101} 14
4) {010} 0.1

After entering the first or main crystal, select Epitaxial Crystals, and in this case you
can ssimply click on the Duplicate button. After the new entry appearsin thelist, select
that entry and click on Revise. For orientation, specify face (010), vector [001] for the
host and face (0-10), vector [00-1] for the guest. Choose type I nter penetration, and give
0.2 for the center-center Distance. Note that the vector for the guest is the negative of
that for the host; this results in a 180 degree rotation about the normal to the common
face, which isthe definition of a"normal™ twin, and exactly equivalent to reflection in
theface. Itisnot necessary to revise any of the datafor the epitaxial crystal itself
(Revise... buttons).
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Returning to the dialog with the list of epitaxial crystals you can again just duplicate the
last crystal and Revise the new crystal. Thistime, use face (0-10) for the host and (010)
for the guest (the vectors remain the same), so that the new crystal will be on the back
side of the host. The center-center distance is the same, 0.2.

Next, add another pair of epitaxial crystals on front and back - (010) and (0-10) of the
host - at distance 0.4. However, for this pair, use the same vector, [001], for the guest and
the host; this pair isthus in parallel, not twin, orientation with the original crystal. This
could go on forever, but the intergrowth shown has just one more crystal, with the twin
orientation, at distance 0.6.

I nter crystal edges may be left unchecked, but you must Remove Hidden Lines
(Display menu).

5.9 Growth Zones in Carlbad Twin
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Thisillustrates modelling of growth sectorsin an intergrowth.

After generating the Carlsbad twin in example 2, select Save/Recover Orientation in
the Rotation menu, and select the Recover original orientation button. Then select
Cartesian Axes in the Rotation menu to rotate 90 degrees on z. This should give aview
down the b axis.
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Now select Sections/Growth Zones from the Inputl menu. Click on the Growth Zones
radio button, and then on the Zone Settings button. In the Growth-Zone Settings
dialog, click on the Linear button, and enter 10 in the number of zones box. Check the
Sector boundaries box.

Remove the dialogs by clicking on OK, then select Display from the M odes menu, and
set the display mode to Sections/Zones. The drawing will be replotted automatically.

Most of the growth sectors can be assigned to one face or two faces belonging to one or
the other of the two individualsin the twin. The exception is the middle sector of the
three bounded by 110 faces - actually, what is shown in this plot is the boundary
between the (110) and (1-10) sectors of oneindividual and the (-110) and (-1-10) sectors
of the other. There are thus four "combined" sectors, in which (110) of oneindividual is
coincident with (-110) of the other, etc. These combined sectors may beillustrated more
clearly in the normal three-dimensional view of the twin by switching Edgesin facesin
the Prefer ences dialog (Settings menu) on. Although the two coincident facesin each
sector belong to the same form, they are not in the same orientation, so these "combined"
sectors can not exist in reality. Presumably in areal twin the non-combined sectors
above and below are extended to squeeze out the combined sectors, forming an
irrational line of junction across the 110 faces.

5.10 Hourglass Zoning

Thisillustrates exponential growth ratesin section. Enter asimple crystal with MMM
symmetry, orthorhombic, A, B and C axes of length one, and forms 100, 010 and 001, all
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with central distance one. Remove the orthographic rotation, if present.

Now select Sections/Growth Zones from the Inputl menu. Click on the Growth Zones
radio button, and then on the Zone Settings button. In the Growth-Zone Settings
dialog, click on the Exponential button. Inthe Non-linear group, the Total time should
be 1.0 and the Interval 0.1.

Now click on the Rate Constants button. This brings up the FormsList... dialog - you
must set or reset the rate constants for each of the forms listed.

The equations for all three forms by default have non-zero a coefficients only for the first
term, giving constant rates. Leave thefirst two forms alone, and select the third form,
001. Setaqto0.75and asto 2.0. Thisgives a dependence on time to the power one,
since by is one by default.

Remove the dialogs by clicking on OK, then select Display from the M odes menu, and
set the display mode to Sections/Zones. The drawing will be replotted automatically.

On the first calculation, the plot will probably go off-scale; ssmply select Replot from the
Display menu and the results of the first plot will be used to scale the second.

5.11 Hematite on Magnetite - True Epitaxy

Thisillustrates a crystal nucleating on another, with the two continuing to grow together
for aperiod of time.

Enter the hematite on magnetite example number 6, with the following changes: 1) for
simplicity, use only the form { 111} for magnetite; 2) for the hematite epitaxial crystal,
select interpenetration, at a distance 0.85, instead of a contact relation; 3) use the central
distance 0.36, instead of 0.1 for the {001} form of hematite.

After the crystal has generated, select Align Face/Vector from the Rotation menu and
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rotate the face (111) parallel to the screen, using alignment vector [11-2]. Then select
Cartesian Axes and rotate 90 degreeson z. This gives aview down the epitaxia plane,
showing the hematite to be partially buried in the magnetite.

Now select Sections/Growth Zones from the Inputl menu. Click on the Growth Zones
radio button, and then on the Zone Settings button. In the Growth-Zone Settings
dialog, click onthe Linear button, and enter 20 in the number of zones box. At the
bottom of the dialog, click on the Times button, which brings up the Start and End
Times... dialog. Set the start and end timesfor crystal 2, the first epitaxial crystal to 0.8
and 1.15 respectively. Exit the dialogs and reset the display mode, if necessary, asfor
the previous examples.

The start time of 0.85 causes the hematite to start to grow just as the host magnetite
reaches its center, simulating epitaxial nucleation. The two crystals grow together in the
timeinterval 0.85 to 1.0 (host growth time), forming the small "root”, and the epitaxial
hematite grows alonein the interval 1.0 to 1.15.

5.12 Icosahedron - Quasi-Crystal

Y ou must switch to the QSHAPE mode of operation with the Operate command in the
M odes menu - see section V-6 for principles and details of operation in this mode.

In the Symmetry dialog, you must supply the name of a Cartesian symmetry file - thisis
"Ih_example.sym™, which isthefile for icosahedral symmetry, as derived in the
Cartesian (QSHAPE) Operating Mode section. 'Y ou may need to Browse to the Samples
folder to get the full pathname of thisfile. Astheonly form, enter {00 1} or {0.0, 0.0,
1.0} at adistance of one.

To get a pentagonal dodecahedron, enter {5.23607,0,1} asthe only form. You can also
try {010}, arhombic triacontahedron.
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As given above this example uses the orientation for the icosahedral groups from the
trial-and-error example for SYMGR (see Help for SYMGRP). The symmetry file
Ih_std.sym has the standard orientation for the groups, which is similar to that of cubic
crystals, with the 3-fold axes (some of them) in the [111] position. Some simple forms
for this orientation:

icosahedron: {1,1,1}
pentagonal dodecahedron: {0.525727, 0.850653, 0}
rhombic triacontahedron: {100}

5.13 General Comments on Twins and Epitaxial Crystals

As may be seen from these examples, agreat variety of twins may be drawn. The only
serious restrictions on twins drawn with Twins are that they must al be derived from a
single original individual, composition planes must pass through the center, and contact
and interpenetration twins may not be intermingled. One may draw multiple
interpenetration twins in which the individuals turn out to be different, but in contact
twins, the composition planes are applied to al individuals, and al the individuals are
exactly the same or enantiomorphic.

In the Twins option, composition planes must go through the center of the crystal, but it
is certainly possible to simulate off-center contact twins with the Epitaxial Crystals
option.

For moderately complicated twins, such as fivelings, sixlings, etc. in which the
individuals are all identical it usually saves computer time to treat them as contact twins
and use for atwin operator the pseudo-symmetry operator of the twin. On the other hand
using interpenetration twins usually requires fewer twin individuals and less operator
time. For very complex cases like the phillipsite twenty-fourling (example 5) it may be
necessary to use interpenetration twins. In all casesit may be easier, and the results
simpler and aesthetically more satisfactory (if not strictly correct), if the pseudo-
symmetry of the twin aggregate is used as twin operator instead of the true twin
operators.

Interpenetration twinsin high-symmetry systems, especially the cubic system, can give
some complex and interesting shapes, based on fairly simple forms and twin operations.
Try for example the spinel law - reflection on (111) or rotation by 180 or 60 degrees on
[111] - on variousisometric shapes such as cubes, tetrahedra, dodecahedra, distorted
octahedra (unequal tetrahedra), and general and special forms of the lower-symmetry
groups of the cubic system.
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Index _C-
Calcite Scalenohedron - example 130
-2 - calculate command 26
2D (2-dimensional) Drawing modes 43 calcul.ap(.)ns- description 10
capabilitiesof SHAPE 8
-3 - Cartesian axes - rotate 97

3D (2-dimensional) Drawing modes 44
3D display mode 84

3D Display Parameters 86

3D Material Parameters 87

3D parameters 84

3D Quad-Buffered Stereo Drawing mode
46

_A -

About dialog 102
Add/Revise Form 57
Add/Revise Form (Cartesian) 57
add/reviseforms - Cartesian 57
Align Faceor Vector 98

Align Face or Vector (Cartesian) 99
Align Face or Vector (Cartesian) 99
Anaglyph Drawing mode 48
Anaglyph Settings 91
angle - interfacial 75
areas 30

Augite Enclosed by Hornblende (Epitaxial
Interpenetration) - example 137, 138

axes- display 80
axes-entry 53

_B -

Background Color 79
bitmap (screen dump) 37
blank border (penplot) 21

Cartesanmode 39

Cartesian operating mode 106
Cartesian symmetry 54

centering 83
centering/displacements 83

central distance 107

Chrysoberyl and Aragonite/Cerussite
Sixlings - example 132
circleincrement 19

clinographic axes 110

Clinographic Viewing 98
clinographic viewing - initial 81
clinographic viewing (Display Menu)
91

close command (Graphicswindow) 26
Close command (Text windows) 103
coincident faces 58

color - background 79

Color command 90

color or b/w - startup 19

colored glassesfor stereo viewing 48
colors - converting from DOSfiles 23
colors-input 109

colors- line 78

colors - sectionsand zoning 69
Colorsand Palettes 108

Colorsfor Sections and Growth Zones
69

colorg/patterng/pens 109
composition plane 61
composition plane - Cartesian 61
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composition planes 60
Configuration files 121
Continuousrotation 100
coordinate systems 110
Copy command 105
corners- extra 119
Crystal Axes- display 80
Crystal Colors 85
crystal edges 79
Current orientation 100
cursor modes 39

Cut command 104

D -

dashes 79

default display parameters- saving 23
DEFAULTS 121

descriptions of calculations 10
Dialog Bar - Epitaxial 96
Dialog Bar - Left 93

Dialog Bar - Right 94

direct modification of files 112
directories- home- data 113
displacement increment 19
displacements 83

Display menu 90

Display Mode Sub-Menu 42
display modes 39

display parameters- saving 23
Donnay-Harker Morphology 75
dot patterns 113

d-spacing 75

_E -

edges- crystal 79
edges- one-face 65
edges - two-face 65

edgesinfaces 19

Edit menu (Text windows) 104
Encapsulated PostScript (EPS) files 31
Epitaxial Crystals 61

epitaxial crystals - general comments
143

epitaxial crystals- zoning 66

Epitaxial Relations (Cartesian) 64
Epitaxial Relations 62

EPSfiles 31

examples 130

Exit command 39

exponential growth-rate constants 70

extracorners 119

_F -

face- aignon 98
Face or Form Fill Data (Cartesian) 73
Faceor Form Fills 72
faces 105

Faceat Cursor 105
faces- identifying 105
faces- missing 119
filelocations 114
file menu (graphicswindow) 24
file menu (mainframe window) 13
File Menu (Startup Window) 13
File menu (Text Windows) 102
filetypes 114
files- direct modification 112
fills-data 73
fills- Faceat Cursor 105
fills- Faceor Form 72

fills- Face or Form Fill Data (Cartesian)
73

Flash moviefile 100
folders- home-data 113
forms - add/revise - Cartesan 57
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forms - adding or revising 57
forms- Faceat Cursor 105
forms- identifying 105
FormsListdidlog 56

Frames 116

Free-Form Input Files 116
Full-screen 3D mode 50

-G -

glasses - stereo (shutter) 50
GraphicsWindow 12
graphicswindow menus 23
grid 91

growth intervals 71
growth zone settings 66
growth zones 65

Growth Zones in Carlbad Twin - example
139

growth-rate constants - exponential 70
growth-rate constants - formslist 71

_H -

Help Menu 101

Hematite on Magnetite - True Epitaxy -
example 141

Hematite on Magnetite (Contact Epitaxial
Intergrowth) - example 136

Hourglass Zoning - example 140

-] -

| cosahedron - Quasi-Crystal - example
142

identifying faces or forms 105
illumination vector 73

Imaginary faces - edges - corners 56
Import (Graphics Window) 25
Import File (Startup) 14

indicesfor faces 92

initial orientation 81

initial orientation - setting 99
initial rotations 81

input data - listing 30

Inputl menu 52

Input2 menu 78

interfacial angle 75
Introduction 8

L -

Labels 92

Lighting Equation (3D)
linecolors 78

line patternsand pens 78
linewidths 79

List Input Data 30

List Results 30

list sectiondata 31

M -

margins - Macintosh 104
marker zones 66

marker zones: color 69
Material Parameters (3D) 87
menus and dialogs 13
Metafiles 35

missing faces 119

Model Mode Sub-Menu 42
Modesmenu 39
movie - rotation

_N -

New (Graphics Window) 25
New Command (Startup) 14
non-menu dialogs 105

117

100
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Perspective 79
-0 - Phillipsite Twenty-fourling
Pseudo-dodecahedron - example 135

one-face edges: color 69
Open (GraphicsWindow) 25
Open command (Startup) 14
operating modes 39
orientation - current 100
orientation - saving 99
orientation recovering 99
orientation: initial 81
Orthoclase - Carlsbad Twin - example
131

overlapping faces 58

_P-

Page Setup 18, 30, 104
palette - shading zones 73
Palettes 23

palettes- general 108
palettes - reference 120
parameters - pen-plotter 21
Pastecommand 105
patterns - coarse/fine 32
patterns - input 109
patterns - sections and growth zones 70
patterns for b/w images 113
patternsfor lines 78

pause - growth zoning 66
pen numbers - input 109

pen numbers - sections and growth zones
70

PenPlot 32
Pen Plotter Settings 21
pen-change mode 21

Pen-Plotter Commands and Parameters
21

pen-plotter settings 21
pens numbersfor lines 78

PICT Files 37

point-group symmetry 53
port - pen-plotter 21
PostScript screen preview 20
PostScript transfer function 20
POV-Ray Files 38
precision 119

preferences 19
Preferencesfiles 121
preview - PostScript 20
Print GraphicsImage 27

QSHAPE mode 39

QSHAPE operating mode 106
Quit command 39

‘R -

Raster (Bitmap) Files 32
raster files 32

Read/Save Defaults 23
Reference section 106
removing rotations 99
replot command 90
rescaletwins 58
rescaling factor 19

Reset Scaling/Centering 83
results- listing 30
Rotate - Cartesian Axes 97
rotation increment 19
Rotationmenu 97
Rotation Movie 100
rotation on structure vector 98
rotations - initial 81
rotations - removing 99
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Rutile Doughnut Sixling - example 134

_S-

Save As command (Graphics window)
26

Save As command (Text windows)
Save command (Graphics Window)
Save command (Text windows) 103
saving default display parameters 23
scaegrid 91

scaletwins 58

Scaling 82

screendump 37

screen preview - PostScript
SCRPTR 121
section/zoning mode 39
sections 65

sections - color 69
Sections/Zoning Model mode 42
sector boundaries 66
sector boundaries - color
sectors- filling 66
Select Color Dialog 106
Settingsfiles 121

103
26

20

69

Settingsmenu 18

Settings Menu (Graphics Window) 101
shades- input 109

shading 73

sounds 19

speed number (pen plot) 21

Standard Model mode 42

Start and End Times for Epitaxial Crystals
72

gtartingup 9
Startup Window 12
Startup Window Menu Bar 13

stereo drawing with quadl-buffered
OpenGL 46

stereo pairsin 2D Drawing mode 43
stereo pairsin 3D Drawing mode 44
stereo viewing 48

anaglyph 48
stereo viewing with shutter glasses
stereonet mode 39
Stereonet Model mode 42
stereonet symbols - radius 19
stereopair mode 39
Stereopairs 80
Striation Data 75
Striations 74
structure vector - rotation
symbols - stereonet - radius
symmetry - Cartesian 54

Symmetry - Point Group or Crystal Class
53

Symmetry Element Display 88

“T-

Text Window Menu Bar 102
Text Windows 12

titte 53

Title/Axes 53

tolerances 119

transfer function (PostScript)
tutorials 130

twin operator 59

Twin Operator (Cartesian) 60
twins - composition plane 61
twins - general comments 143
twins- type 58
two-face edges - color

50

98
19

20

69

typesof windows 11
-U -
Undo command 104

units- scaling 19
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_V -

vector - align 99

vector - Align Faceor Vector 98
vector - alignon 98

vector - illumination 73

vector (structure) - rotation 98
VRML Files 38

W -

widths- lines 79
windows - types 11
Windows Menu 101

_7-

zoning - color 69
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